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BonusPack 
FlashBoot. What is faster than a 
speeding disk drive? A RAM disk. 
FlashBoot lets you automatically set u 
a super-fast, super-convenient RAM 
disk. 

The Apple II Enhancement 
Guide. This handy little be"', 9 packed with information to 
you upgrade your Apple II. It 
covers RAM, hard drives, accel- 
erators, the Finder, and more. 

Clip Art. We're throwing in over 
100 beautiful clip art images, per- 
feet for desktop publishing or hy- 
permedia applications. 

Clip Sounds. Because the IIGSs 
sound capacity is so great, we're als 
including over 50 digitized sound 
files. Some are classics while some 
are the newest on the market. They go 
great in Hyperstudio and other sound 
programs, or you can have music play- 

Icons. Over 50 fun, useful icons. 
Get Signature for only 

(Reg. $29.95) 
when you b y  the System6 Bonus 



- El' IN ON TH. 

BEST-KEPT SECRE1- 
\ SOFTWARE! 

n's not a magazine! It's not a book ( 

on, return oor biU marked 
software subscriptions for yo**'" Mn*Ã§P" -"canceln and youll owe 
Apple IP, or Hop. And you I . zither way, the first i 

i&&i~.eaehnancLe~e'ry, moxxth for less 
tha?r$@~'prdgmm!~~- 

->:t-7--* YpVMget'fan games,..p.u.tzles and 
&~,o-@8:programs to make: the a p s t  
of your time off. . .functional utilities to 
help you get the moat from your cam- 
puter. . .practical programs to help you 
manage your money. . .useful programs 
to manage your time. . .and graphics 
put more oomph into your ideas! 

Each issue of DISKWORLD* 
and SOFTDISK- contain 5 to 7 orig- 
inal programs, 3 to 4 programs for 

We're-.s~ sure that you'll love B u r  
new soft$g@psubscription that wÃ§fl 
send youLa Sge.cia1 Bonus Disk with 
your paid subscription. It's your6 
W E  just for subscribing. 

So get in on the secret! Try 
D~SKWORLD, BOFTDISK or 
SOFTDISK G-S now RISK-FREE! 

"3B 

SOFTDISK for the Apple 11.. . 

^AIL IN THE COUPON BELOW 

is FREE with our 1-800 hotlin 

GET IN ON THE SECRET- 
STTDISK 

IRY A RISK-FREE ISSUE1 P u - 0 L I S H I N G  

Don't take our word for it-why R0. Box 30008 
it trv an issue RISK-FREE and see 

Sh LA 71130-0008 SOFTDISK G-S for the An& 1 1 ~ ~ .  

"r yourself! 
Call 1-800-831-2684 now or send 

in the coupon below to try an issue n Apple IIos, a 3 5" dirt tove & I 
D T W  dam tfB me---. --- ---immendedl 

I want in on the secret! And I want thp FREE Bonn* Dbk, too! 
1 Send my RISK-FREE issue of the subscription I've checked 

the amount shown for my 3-month trial 
subscription, which includes my first issue, and then I'll receive my Special 
Bonus Disk-FREE, just for subscribing. 
GI DI8SWO- for the Macintosh 

3 months $29.95-about $1.50 a program! 
0 SQFTDXBK* for the Apple I1 

3 months $19.95-about $1 a program! 
U 80FTM8K 6.8* for the Apple lies 

3 months $29.95-about $2.50 a program! 

Please check disk format: 
0 3.5" 0 5.25" 

Name 

Address 

City State - 
Phone # ( -) IN033 
*A ole 11- owners can try both SOFI'DISK & SOFTDISK G-S RISK-FREE. They're entirely 
derent,  and with our mmbo rate, you wn then get both for only $89.9-bout $1 a program! 

MAIL TO: Softdisk Publishing P.O. Box 30008 Shreveport, LA 71130-0008 1-800-831-2694 



Look what's new with 
Platinum Paint 
Create and print 

masterpieces of any size 

^ 
Multiple fatbits magnification 

"Oovs!" ^/ Full-size Undo 

Junior User Option 

1 

Platinm Paint is the pow- Platinum Paint has always been the premier llos 
erful, award-winning paint paint program. NOW it's even better. 
program that has given 
Apple IIGS users the ability QC'S Price ( ~ e t a i l p r i c e ~ )  ................ .W' .......... to turn imagination into bril- upgrade for - . $ 3 ~  

... . New Platinum Paint 2.0 Alphabet Coloring Disk "............Â¥19 
ven more power 

Create and print masterpieces of any size. dm 
Create and play animations. PI mum Pr'f D 2.0 
Add sounds. 

Add sounds 

Hierarchical menus-easier to work with! 

Full-size Undo for fixing any size booboo. 

Fatbits magnification-up to 8x! 

Work in inches, as well as pixels. 

Junior Version-makes Platinum Paint easier for 
kids. 20200 Nine Mile Rd. St. Clair Shores, MI 48080 

31 3-774-7200 Fax 31 3-774-2698 

1-800-777-3642 

Circle 136 on Ruder Service Card. 
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SEPARATE BUT EQUAL 
s promised, for this month and henceforth we're sepa- 
rating Apple I1 and Macintosh editorial. Our design 
team has put those sometimes-competing voices into 

discrete sections of inCzder/A+. You should no longer 
be confused about whether we're an Apple I1 or a Mac magazine: 
We're both, and have been for more than two years. But now you 
choose which; we think you'll find both sections invaluable. 

We also welcome 1 surprising: Word- 
Cynthia Field to 
our staff. Yes, she I By WILLIAM KENNEDY, Ph.D. ::: 1 

EDITOR IN CHIEF 

has contributed significantly to this maga- 
zine for several years. But this is different: 
This is the first issue in which she's clearly 
inCider/A+'s Apple I1 guru. She'll continue 
to search high and low for exciting Apple 
I1 news and new products to report on; 
she's now our main editor for Apple I1 
product reviews, as well. 

Our design team has also made subtle 
but effective changes in the magazine that 
let us editors pack more information into 
what has become a "tighter" book. You've 
noticed? Space for ink is at a premium 
these days; we agonize each month over 
how to give you the most information 
about Apple 11s and Macs in an ever- 
more-limited number of pages. 

WHERE DOES 
YOUR APPLE BELONG? 

From the moment we first begin to 
understand simple commands like "pick 
up your toys," we're reminded constantly 
to put "things" away "where they belong." 
Trained from birth, we put our posses- 
sions in a place some supreme authority 
(Mom or Dad) deems appropriate. That 
proper place is often where that item gets 
the most use - the refrigerator and 
microwave in the kitchen, power tools in 
the garage or basement, TV in the den. 

So why do we put our Apple I1 or Mac 
on a desk or table in the far corner of 
some back room? Or in the back of the 
classroom? Probably because we still don't 
quite understand just what that computer 
is, so we can't decide where best to put it. 

Many of us cling to the archaic view 
that a computer is a glorified typewriter, 
calculator, or filing cabinet. That's not 

processing, spread- 
sheet, and data- 

base applications give us an easily under- 
stood and practical reason to purchase a 
computer. Since the inception of the 
personal-computer revolution, those appli- 
cations have been the most common ones. 

'Fess up, though. You don't just com- 
pose family letters, keep gradebooks, or 
figure your annual contribution to Caesar 
on your Mac or Apple 11, do you? You 
probably have a game or three, a graphics 
program, an education title or two. And 
the group of children (and adults - don't 
kid yourself) that regularly crowd around 
the computer screen to play Carmen 
Sandiego or Stickybearjust can't get close 
enough to the keyboard and mouse. 

Your Super Nintendo game machine or 
VCR isn't in a back room connected to 
some tiny old black-and-white TV, is it? 
Nor is your stereo tucked away in a hidden 
corner. An Apple I1 or Mac is all those 
things combined. You paid good money 
for it - get it out where you can use it. 

For instance, where do most children 
congregate before dinner? Maybe there's 
a TV in the kitchen to keep them occu- 
pied so they aren't underfoot? Why not 
put a computer there instead to capture 
the kids' attention and keep their minds 
active, not dulled by the "vast wasteland? 
You'll all sleep better at night. 

Better yet, bring that Apple I1 or Mac 
out into the leisure room where everyone 
can get their hands on it. By simply 
moving your Apple I1 or Macintosh to the 
places your family tends to congregate, 
you'll find that it will get a lot more use. 
And that means enhanced productivity 
from an expensive machine without 
spending another dime. Q 
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F E A T U R E S  
r Peripheral bv Philio Chien.. .................................. .42 
What's the ultimate Apple I1 add-on? HOW about a Macintosh? That's right -Apple's 
'ocher" computer can be your 11's portable in the field, a telecommunications unit, a 
quality desktop-publishing center, a number cruncher, a file server. inCider/A+ shows 
you how to link up for maximum productivity. 

Tax Form Reform: Par t  2 by the staff of inCider/A+ ............... 50 
Organizing a preliminary return on your Apple I1 or Mac can help you snag the I 

biggest refund you're entitled to. Our Form 1040 "Works" template crunches your 
numbers and gives you the box score. 

D E P A R T M E N T S  
Letters ..................................................... 
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A+ Extracts ................................................................................................. 26 
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The View from Inside * William P. Kennedy, Ph.D. .................................................. 3 
"Separate but Equal": Don't hide your Apple I1 or Mac away. Put it in the kitchen 
or leisure room where everyone can get their hands on it - it'll get a lot more use. 

Shareware Solutions *Joe Kohn .......................................................................................... 1 
"Space Wars": Your Apple I1 can conjure up whole new galaxies to conquer. 

Grapevine *Joe Kohn ................................................................................................................ 19 
On-line hints, tips, argument, chat, and gossip. 

C A G E  6 0  

The Apple II Report * Carol S. Holsberg, Ph.D ................................................................... 24 
Hot off the press: quick reviews of recently released software. 

Stattus Report * Paul Statt ................................................................................................ 64 
"Video Bites": Face facts: A Mac looks like a TV, but the show's as dull as a test pattern. 
There's gotta be a better way -and it's called VideoBeep. 

News 6 New Products ............................................................................ 30 
'In with the New": Apple announces the Mac Color Classic, the LC 111, and more. 

Reviews 
KidDesk vs. At Ease * Arthur's Teacher Trouble 
* TimesTwo * Conflict Catcher ................................................................................ 34 
Mac Extracts ............................................................................................ 39 
The Holzber~ Report * Carol S.  Holzbere, Ph.D. ............................................. 40 - - .., 
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2- 
Since we introduced Enhance over 6 years 
ago, it has grown from a simple-yet-won- 
derful newsletter into one of the most 
respected and widely-read educational , technology publications in America. 
Every issue of Enhance contains the 

d of information the computer-using edu- 
cator needs to make an impact in the classroom-like 

how to write winning grants, multimedia applications, telecom- 
munications, and product reviews and announcements for Apple Il, 

Macintosh, and IBM. It is written by a nationwide network of educators, like yourself, 
who want to reach their students through computer technology. 

Enhance also includes our catalog - full o l  all the hardware and software you need 
for your Apple II, Macintosh, or IBM. 

Quality Computers has been publishing Enhance for over 6 years. It's free to all QC cus- 
tomers, or you can call for your free subscription today! 

"We enjoy reading Enhance and look forward to receiving it. It is well written, under- 
standable, pertinent, and a great source or information." -Everett Foust 

Thank you for providing the opportunity for schools like ours to have a chance at getting 
some of the technology that can bring our computer program into the 90's." 
-Sandy Kowalczuk, Key School, Annapolis, MD 

E free! 
Join the hundreds of thousands who have enjoyed Enhance for over 5 years. Get your 1 

free subscription today! (Foreign subscribers add $20 U.S. funds) 

Name I 

Address 
I 
I 
I 

City State ____ Zip i 

8 Phone ( ____ 1 1 

P O W E R  

SOUND & DISK DRIVES 
ADDIF -.- 
3.5" FDHD (IleIIIGS) 349.95 Wftt 
Controller 149.95 Video Overlay Card 
APWED EMIMERIM OMmUMSni 
AE 3.5" 229.95 Computeriyes lie 
AE 5.25" 179.95 ComputerEyes IIGS 

- 
199.95 Bank Street Writer Plus 49.95 

169.95 
3.0 Upgrade 79.95 

W o r k s  GS 1.1 199.95 
1.1 Upgrade 99.95 

449.95 - 
KttMJI 

PRINTERS Koala Drawing Pad 99.95 

APM 
M 
MIDI Tianstate 49.96 

Imagewriter II 459.95 
maHz 
mmr 

PAIUSOWC Echo II 1- L. 44.95 
Panasonic 11 801 199.95 
Panasonic 1123 tatassWofte Bundle 199.95 

24995 BusinessWwte Payroll 99.95 

INTERFACES 
W H O I t  
Parallel Pro 79% 
Serial Pro a935 
m # m F n  
Grappter Plus me36 -- 
Q:T& LTO (US 
JHEC 
SupetWritef a24 64% 

d i u r r c  
0-Modem 2400 was 
Q-FaxModonGS 20036 
A P H f I S  
Q-Modem 2400. CaMt. 
and Point-to-PM* 133.96 
nw- 
Q-Modem 2400. Cabk. 
and Microphone 149.95 
SWM 
SupraFAXModem v^Z HS 

14,400 bd. (Mac) 379.95 
SupraModem v.32 9600 279.95 

MOHOCHIttUE 
1 2  Amber 129.95 
nuamnx 
Magnavox RGB 299.95 

Custom Cable (GS) 19.95 

NPlfT DEVICES 
APmE 
AppleMouse lie 119.95 
enpmuiicis 
Roller Mouse 89.95 
Mach Ill Joystick 29.95 
NEUSmerOÃ SPECIAL! 
Turbo Mouse 3.0 79.95 
KEMimas 

m 
He-u 5935 
M- 

79.95 - 
- 6 s  29.95 
-W 14.95 
01- 9.95 
I r n S t a n d  4.95 - 
m lrom14.95 
A 80 Col. Card 19.95 - from 19.95 
Knboani Skins 19.95 
as- Diskettes (10) 7.95 
5.25' Diskettes (1 0) 5.95 
Mouse Pad 4.95 
Phone Net Connectors 19.95 
Q-Butf 59.95 
mom 
IIGS Battery Kit 14.95 - 
Imagewriter Black 
Imagewriter 4-C 
Imagewriter Color 
Heat Transfer Black 
Heat Transfer 4-C 
Panasonic 11 8011090 
sun 
No Slot Clock 
ZIPIECHMIWY 
Zip GS 8/16 
Zip lie 8MHz 

Mea WASHER 
HyperStudio 3.1 99.95 

X-Commands 35.95 
WUincoHimBS 
Clip Art GS Vol. 1,2 or 3 19.95 
Clip Sounds GS 19.95 
How a Bill Becomes 

a Law 19.95 
Story of Creation 19.95 

IHUS 
Shoe Box 39.95 
SanVMtsaiimais 
Your Money Matters GS 79.95 

TELECOMM 
msrue 
ProTERM 3.0 I 

School Pack 279.95 
SEAasSROS 
Point to Point 

EDUCATIONAL 
SOFTWARE 
ORUffifGMEmr- 
ramUSSEWUMMWS 
Talking Numbers GS 39.95 
TalkingAlpha Chimp GS 39.95 
Talking Animals 39.95 
Talking ABC's GS 39.95 
Talking USA Map GS 39.95 
Talking Speller GS 39.95 
Talking Money GS 39.95 
Talking Reading Railroad 39.95 
l7E WMfM COMPANY 
Reader Rabbit 24.95 
Talking Reader Rabbit GS 34.95 
Math Rabbit 24.95 
Children's Writing & 

Publishing Center 34.95 - 
CsnnenWorid 25.95 

IIGS version 29.95 
Gannen US*. Europe, 

Tii.orWorid GS 29.95 
Camm America's Past 29.95 
The Playroom 24.95 
Kale's Fan) or McGee 24.95 
DieTicdnuse 29.95 
E r a  
SUy Bear Numbers 24.95 
T* Sticky Bear ABC's 29.95 
SUy Bear Typing 29.95 
-*Math 24.95 
E m  Haiti Tutor 29.95 
SidwteReadiiM 24.95 

IBM-Style Keyboard 79.95 m. 
Apple ADB Keyboard 

E 
Beaglewrite 48% -Crater GS 29.95 

Regular 129.95 Beaglewrite DA's 9% W N m d m s  24.95 
Extended 199.95 BeanleWrite Pint Mor 9% WmdMdms 24.95 

icemen 
fl-~seMan 

~ e i i l e ~ n t e  Font Pate 9% ~regonlrail 24 95 
84 95 BeagleWnte GS 59.95 USAGNGrapti GS 



The Q Drive eliminates disk swapping 
and helps you work twice as fast! - 

Thousands of drives later, experts still are praising the Q Drive for - 
its performance and value. inCider/At gave it a four-and 
half-star rating. Our customers are using words like 
"amazing" and "fantastic" to describe the way 

the Q Drive has changed their computing. 

The Q Drive features a fast, reliable 

1 
Quantum mechanism using the latest 
technology, including auto-parking 
heads, a voice-coil actuator, and a track buffer. And since the Q 
Drive uses the industry-standard SCSI interface, you get complete compatibility with your cur- 
rent computer system-and your next, whether it's an Apple II, Macintosh, or IBM. 

The Q-RAM GS is an economical 
way to add up to 4 MEG of memoty 
to your Apple lies. It's fully compati- 
ble with all Apple lies hardware and 7- ( 

The Q Drive's plain-English manual covers more than instal- 
lation and setup. It even tells you how to manage your 
mass storage effectively. From GS/OS and ProDOS to 
backups and maintenance, it's all there, including a glos- 
sary of hard drive jargon. And no hard drive is easier to 
set up and use-install a card, connect two cables, 
and turn on the power. The Q Drive automatically con- 
figures itself to match your computer, and the latest 
system software is already installed. 

An you interested In upgrading to 

software- including the lies RAM 
Disk and DMA peripherals like the 
Apple II High Speed SCSI Card. And it's so small 
fits in your shirt pocket. 

When you install the Q-RAM GS life becomes just 
little easier. Programs load completely into mein 
ory at startup, eliminating disk swapping. Out-of- 
memory error messages disappear. You'll have 
memory to spare-memory to load desk 
accessories, or to set up a RAM disk. 

System 6 but afraid of compatibility prob- 
lems? Switch Hitter is your solution, allowing you to 

keep System 5 on your hard drive when you add System 6! A sim- 
pie keyboard command selects the desired System version at boot 
time. Additionally, Switch Hitter lets Installation is simple. You can expand a Q-RAM 

Q DRIVE standard SIMMs-we even include the necessary diagnostic software for your 
peace of mind. And since the Q-RAM GS uses SIMMs, your memory investment won't go to 
waste. 

you change your IIGS's System 
Speed and Startup Slot at boot time 
and start up a 3.5" or 5.25" disk, all 
without having to watt for your hard 
drive to boot into the Finder. 

And remember, you're dealing with 
Quality Computers, the hard drive 
leader. The Q Drive comes with a 30- 
day money-back guarantee and a one- 
year limited warranty. A great drive 
and great support, at a great price- 
that's the Q Drive. Find out why it's 
the best Apple hard drive value-test 
drive one today! 

42 Meg ...... Of course, since you're dealing with Quality Computers, you get an unconditional 30-day 
monev-back auarantee and a five-vear warranty. And the   rice is the best news of all-a 2 . - 

MEG Q-RAM GS costs about the 
same or even less than other HGS 85 Meg ............................. .3W 

127 Meg ............................. 49ff5 
170 Meg ............................ .5W 
44 Meg. Removable .............. 49995 

.......... 

memory cards in a 1 MEG configu- 
ration! 

Plus, with the 4 MEG (HUM QS, 

.............................. 
1 Meg. 8 . 8 8 . 8 8 8  MU 
2 Meg.. 

................................ 
l3Y5 

4 Meg 2lY 
Q-RAM II (4 mg. surface moutltetlf ... -1 Yes 

you get FiashBoot FREE! Fiash- 
Boot lets you quickly save and 
load a super-fast, super-come- 
ntont RAM disk. 

k 
Snap the Q-RAM lie into your Apple lie, and you'll 

i create a whole new computing experience. Pro- 
grams load faster-and completely. A lot less disk 
swapping. A lot more productivity. All of Apple- 
Works, plus your TimeOut applications will 
completely load into RAM. That means you can 

concentrate on working~not waiting for disk drives. Plus 
with a huge 1 MEG. treasuer trove of RAM, you can create huge doc- 

uments, and not encounter a single "Out of Memory" message. 

I SIMMs 1 . . 
256K x4(2) .......................... 19% 
1 Meg. (8) ............................ 4995 

1 Meg. ............... W 
2 Meg. ................ 9gK 
4 Meg. .......... 17gE 

The 0-RAM lie fits snuggly into your lie's auxilliary slot, and comes with diagnostic software, 
a5+varwarranty, a 30-day money back guarantee, and is 100% software compatible. 

ASK ABOUT 
QUANTITY 

DISCOUNTS ON I 
JWewiMmetorbeatanynationallyadvertisedpriw* 

/School P.O.'s accepted by phone, fax or mail 
/SchoolEditions*LabIteks@NBhmite@SteLicenses 
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PROLINE UPDATE 

I WAS THRILLED BY THE FIVE- 
star review ProLine received in your 
December 1992 issue (p. 27). It may 

seem ungrateful to critique such as 
glowing evaluation, but your readers 
should be aware of a few inaccuracies: 

ProLine doesn't work with the IIc; 
it runs only on a He or IIGs. 

ProLine can work with high-speed 
modems (19,200 bps or faster). It isn't 
limited to 9600 baud. 

You need an accelerated He only with 
a 19,200-baud or faster modem, not if 
you use a 9600-baud or slower modem. 

Once installed, ProLine uses only 1.5 
megabytes of hard-disk space. 

We'd also like to note that ProLine 
owners can receive professional cus- 
tomer assistance and on-line support 
through the major information services 
- essential backup, particularly for BBS 
system operators. 

Morgan Davis, President 
Morgan Davis Group 
Rancho San Diego, CA 

FALLOUT 

P LEASE TELL ME IT ISN'T TRUE. 
I read in [SoftDisk, Appleworks  
Forum, on line . . .] that inCider/A+ 

is going completely Mac beginning with 
the February 1993 issue. 

I've been a faithful reader since 
[I982 - . . .I. I love my Apple I1 [GS, e, c, 
Plus . . .I, and I'm not ready to give it 
up. inCider/A+ has been a vital source of 
[information, good stuff, great reviews . . .] 
for me. If you go Mac, I'm going to 
[cancel my subscription, I don't know 
what, kill . . .I. 
Randall R. Evans 
Des Moines. IA 

Johhny Lum 
Norwalk, CT 

Matthew J. Ghio 
San Pedro, CA 

and a score of others . . . 
Tales of our demise are just rumors and 

lies - the proofs right here before your eyes. 
- eds. 

STITCH IN TIME 

I N JANUARY'S APPLE CLINIC 
(p. 17) Diane Hubbard of Morgan- 
town, North Carolina, asked about 

software that can produce cross-stitch 
graphs. Cynthia Field listed one source, 
but there are others, as well. 

For instance, Stitch-It by Sheridan 
Software works with any Apple 11, 
including the I1 Plus. Stitch-It is also 
available for the Mac; that version lets 
you overlay pictures on a grid to pro- 
duce cross-stitch graphs. Stitch-It for PC 
compatibles converts a picture automat- 
ically to a cross-stitch graph. 

Roger Sheridan 
Sheridan Software 
Freeland, WA 

HE EMULATION 

M Y WIFE AND I RECENTLY 
purchased a Mac LC with a l ie  
emulation card. We're both 

teachers. Although we do about 60 to 70 
percent of our work on the Mac, we 
prefer to do our grade keeping and 
other spreadsheet work, as well as some 
word processing, with IIe programs. 

Although IIe productivity programs 
work fine, we're just now discovering 

Nlthough U -mter  Club 

:Norfolk. NB and Pmblic Domain 

FJriMwd CSanfca Clara. CM car 
lumber of fine products, they app 

don't stock many of the sha 

are products mentioned in t h e L  
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that  some other Apple I1 programs 
won't run on the He card - Print Shop, 
Oregon Trail, and Carmen Sandiego, 
for example. This is a problem that has 
made us question the wisdom of our 
investment in the He emulation card for 
the Macintosh. 

We realize many of these programs 
are also available for the Mac, and in 
some cases run better on an LC than an 
Apple 11. But our schools are equipped 
with Apple IIs, so we need to prepare 
our lessons and preview new programs 
for the lie, preferably at home. 

Our request, therefore, is that when 
you review Apple I1 products you also 
indicate whether they also operate  
properly on a Mac in IIe emulation. 

John R. Klees, Jr. 
Tamaqua, PA 

In general, Apple 11 products that are copy 
protected (Oregon Trail, for instance) or use 
a non-standard disk filing system (early 
versions of Print Shop, for example) won't 
work under the Mac's lie emulation. (We 
should note that our copy of Carmen San- 
diego worked fine with the Mac lie emula- 
tion card; perhaps you have a very early 
version.) Several of the software manufac- 
turers we've contacted recently are taking 
steps to provide Apple 11 product versions 
that will work under Mac lie emulation, so 
contact the program's publisher for an update 
ifyou have problems. 

We'll also take your suggestion to include 
Mac l i e  emulation information in our 
reviews. For additional commentary on II/Mac 
connectivity, see "Power Peripheral" in this 
issue, p. 42. - eds. 

who use the Ufonic Voice System. Contact the 
company at 7878 North 16th Street, Suite 
100, Phoenix, AZ 85020, (602) 678- 7.272, 
(800) 752-6684 to replace the unit stolen 
from your classroom. - C. F. 

LOST AND POUND v ITHIN T H E  PAST YEAR I 
purchased Music Studio 2.0 
for my Apple IIGs, but destroyed 

the manual accidentally. The program 
was p r o d u c e d  or iginal ly  by Acti- 
vision, but that company has since 

gone out of business. Where can I get 
a new copy of the manual? 

Howard Tatar 
Highland Park, IL 

The folks at Big Red Computer Club sell 
Music Studio 2.0. Contact them for a new 
manual (423 Norfolk Avenue, Norfolk, NE 
68701, 402-379-4680). - eds. 

INCIDER/A+ WELCOMES READERS' COMMENTS. 

WE RESERVE T H E  RIGHT TO EDIT FOR STYLE 

AND SPACE. WRITE TO LETTERS, MCIDER/A+, 

80 ELM STREET, PETERBOROUGH, NH 03458. 

4 Meg Memo y Card for the Apple Ugs Computer 

U51 I 

I 'M LUUKING FOR A UFONIC 
Voice System for the Apple IIe to 
replace the one our children were 

using in class until it was stolen. The 
software we use requires the Ufonic 
System, and I'd be grateful if you or any 
of your readers have a clue as to where I 
could locate one. 

e n e  Broyls 
Chicago, IL 

A company spokesman tells us that Jostens 
Learning Corporation continues to support 
all its Apple lie customers, including those 

The Hgs Super Ram uses today's popular 
SIMM modules. Easy to upgrade at any time! 

The Hgs Super Ram adds an additional 1,2, or 4 Meg of RAM 
to your existing Apple IIgs computer. This added memory is 
vital to running today's more intensive software. And nothing 
could be easier than to just plug the card in and begin to enjoy 
the benefits of added memory. Your computer will soar to 
new heights with the Hgs Super Ram! 

Choose from three models for full power now or expandability later: 

IIgs Super Ram with 1 Meg Memory (ZGSSRI) ............. $99.95 
IIgs Super Ram with 2 Meg Memory ( ~ G S S R ~ )  .......... $ f 49.95 
IIgs Super Ram with 4 Meg Memory ( ~ G S S R ~ )  .......... $249.95 

1 ,  

PaceMark Technologies, Inc. 

1824 North Besly Court 
Chicago, Illinois 60622 
312-384-5600 
800-888-5240 Toll Free 

Circle 54 on Readir Service Card. 
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a secret activity engaged in by 
military officers at  nation 
colleges and by the inner 
maior corporations. 

Each $19.95 program 
Crisis Gaming series Ca sit 
costs only $20 extra1 tnc 
story starter. In Zero, fo 
the uh-oh scenario goes 
like this: Washington, D.C., is atom- 
bombed by terrorists, killing 1 
million people. Mario Cuomo declares 
himself President, and the states 
secede one by one. Cuomo calls for 
an attack on the Middle Eastern 
country thought t o  have bombed 
Washington. But then i t 's  discov- 
ered the bomb came from within. 

Vance explains that small groups 
of social-studies students or writers 
can "advance the story within the 
warp and woof of the main plot" bv 
anticipating events, predicting 
effects, and documenting their 
thoughts on disk. A password- 
protected log-on system safe- 
guards each student's contribution. 

You can also use the built-in 
Predictor program t o  compute the 
probability of an event.As Vance 
points out. events with lower prob- 
abilities often have more story 
appeal - something supermarket 
tabloids discovered a long time ago. 
For more information or t o  request 
a free catalogue listing AV's pro- 
grams, contact AV Systems, 1445 
Estrella Drive, Santa Barbara, CA 

G ood things come in small packages: professionals in corporations respond- 
That old saying certainly applies to ing to ADA (Americans with Disabilities Act) 

Academic Software, a small educational priorities, and school personnel who 
research and development firm special- perform physical-disability assessments 
izing in computer products for the or prepare IEPs (Individualized Educa- 
elderly, for persons with disabilities, and tional Plans). Others for whom ADLS 
for professionals who work with those represents an important resource are 
groups. According to company president professionals and volunteers who work 
Warren E. Lacefield, Ph.D., Academic in universities, schools, hospitals, clinics, 
Software develops, maintains, and dis- sheltered workshops, rehabilitation 
tributes one of only two full-spectrum agencies, or any other facility that offers 

services or trains others to 
provide information on adap- 
tive and assistive technologies 
for basic living, communica- 
tion, mobility, environmental 
improvement, and workplace 
modifications. 

Academic Software isn't a 
one-product company, how- 
ever. "We're one of the larg- 
est suppliers of picture 
graphics or, at least, picture m vocabularies for augmenta- 

X-Change converts special-needs graphics for DTP use. tive communication for the 

national databases of commercially avail- 
able assistive-technology products. 

The Adaptive Device Locator System 
1.6 (ADLS) covers more than 1000 assis- 
tive products in categories such as 
Communication, Environmental Adaptation, 
In-Situ Motion, Rehabilitation, and Travel. 
A Sports and Recreation database is the 
company's newest enhancement, provid- 
ing device descriptions and pictures as 
well as sources of products and product 
information. Thanks to ADLS, you can 
automatically generate mailing labels 
and form letters for any of the 700 man- 
ufacturers and distributors represented. 

ADLS costs $195. The program runs 
on any 128K Apple He, IIc, IIc Plus, or 
IIGs, as well as on the Mac LCILC I1 and 
Performa 400 or 600 with He Card. 
(Mac and PC versions are also available.) 

Among those who can benefit most 
from ADLS, says the company, are indi- 
viduals with disabilities, counselors who 
work with the elderly, human-resource 

Apple I1 family," adds Cindy 
George, senior research associate. 
Academic Software's 4500-plus images 
work with the company's Unicorn Over- 
lay Express, a $140 desktop-publishing 
system that lets Apple I1 users create 
paper overlays for Unicorn Keyboards 
- alternative-input devices for adults 
and children who are  physically or 
speech-impaired. 

The company recently released a $40 
graphics converter, Picture Icon X- 
Change. This utility lets you use Mayer- 
Johnson Company's Picture Commun- 
ication Symbols as well as Core Picture 
Vocabulary (from Don Johnston Develop- 
mental Equipment) and Academic 
Software's own Keypics and Holidays 
graphics libraries with programs such as 
Appleworks GS, Print Shop, and Tutor- 
Tech Hypermedia Toolkit. 

For information, contact Academic 
Software, 331 West Second Street at 
Broadway, Lexington, KY 40507, (800) 
842-2357 or (606) 233-2332. - C.F. 
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NEW SOFTWARE 

Â 
COSMIC EXPERIENCE 

E veryone's favorite spice- 
colared teddy takes the 

throttle as students in kinder- 
garten through grade 3 prac- 
tice vowel-sound recognition in 
Cinnamon Bear's Outer 
Space Adventure. The lessons 
in this entertaining, animated 
drill-and-practice program 

feature --vowel- - and u o n a n t -  
ufflvuel-RnnRnnant-R word 
patterns. 

When each brightly colored 
hi-res picture appears on 
screen, the child tries to  think 

sf the associated three- t o  
five-letter word. He or she 
then presses the arrow keys 
t o  select the correct vowel 
sound/symbol from the ten 
short and long vowels 
displayed on screen. 

Each correct answer moves 
a tiny rocket around the 
program's solar-system-like 
game board. When the space- 
ship lands on a planet, the 
student can t ry his or her 
hand piloting the craft through 
an arcade-style meteor-shower 
game. 

Dr. Kay B. McCormack, 
president of McCarthy- 

McCormack, explains, "We do 

a lot of field testing t o  make 
sure the program is some- 
thing kids love. Teachers fael 
good because the children are 
learning. " 

School administrators and 
budget crunchers can feel 
good, too. Cinnamon Bear's 
Outer Space Adventure costs 
only $49.95. That price 
includes a school-building site 
license, which means you can 
make all the copies you need 
a t  no extra charge. Just use 
the 5.25- and 3.5-inch 
master disks included in the 
package. 

Cinnamon Bear's Outer 
Space Adventure requires an 
Apple lie, llc, llc Plus, or IIGS 

with 12BK. You can write t o  
McCarthy-McCormack a t  
2885 Downhill Drive, Colorado 
Springs, CO 8091 8, or call 
toll-free (8001 BBQ-1446. The 
company's fax number is (71 91 
598-5579. For more informa- 
tion, circle number 350 on the 
Reader Service card. 

Â 
UGGA, UGGA 

I f you enjoyed & 
Cave &, you'll feel right 

a t  home with The Lost Tribe, 
a new social-studies "edutain- 
merit" program for the Apple 
IIGS from Lawrence Produc- 
tions. They're the folks who 

brought you McGee and 
Katie's Farm, two popule 
n o  words" programs for 

preschoolers. But com- 
pared with McGee and 
Katie, the characters in 
The Lost Tribe are, well, 

c,memlL. 
In this beautifully designed 

prehistoric strategy 
game, players aged 8 
and up assume the role 
of tribal leader. To 
achieve your goal - 
returning your people t o  
their ancestral home- 
land -you must learn 
how to  cope with 
natural disasters 

as well as placate 

dis-arunt-led clan 
members. 

The program sums up 
the challenge this way: 
"Find the right volcano Think you can lead this bunch home? 

to call home, and the 
tribe will shower you with 

praise. Fail, and your name will 
be Muck." 

An on-line survival guide 
offers clan personality profiles 
as well as information about 
prehistoric animals, artifacts, 
and trivia. On the serious side, 
you can learn about early recy- 
cling efforts, medicinal herbs, 
and shamans. 

The Lost Tribe also features 

an attractive hypermedia-style 
interface. Don't be surprised, 
though, to  find an incongruous 
smiley-face icon emblazoned 
among the authentic-looking 
hieroglyphs. 

Digitized photographs of 
clan members add a comic 

touch. Just wait 'ti1 you meet 
Burgle, for example - this guy 
had t o  be the original Hair 
Club for Men president. 

Sometimes The Lost Tribe's 

1 if'-, m m -  . ,: humor is as when 
Glurg challenges Bloog for the 
office of Drain Commissioner. 

You cast your vote on election 
Kids learn their vowels as they blast off with Cinnamon Bear. ; day by selecting from this 

multiple-choice list: A a 
!he uumbentL  5 UUL !&E 

&allenaerL m L - YQM 
smalevotewouldn'tmakem 
difference Sufftce it t o  
say that the program's 
wonderful humor makes The 

Lost Tribe laugh-provoking as 
well as thought-provoking. 

The Lost Tribe is priced at 

$49.95. For more information, 
use your opposable thumb, 
grab a stick of graphite, and 
bull's-eye number 351 on the 
Reader Service card. 

More highly evolved beings 
can contact Lawrence 
Productions at 1800 South 

The more-serious side of 
Lost Tribe features infor- 
mation on prehistoric cul- 
ture, artifacts, and magic. 
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35th  Street, Galesburg, MI 

49053-9687, (8001 421 - 
4157, (6161 665-7075, 

or (61 61 665-7060 [fax). 

Â 
MEMORY SHORTAGES? 

NOT! 

w hile our Macintosh- and 

PC-using friends spend 

all their money on SIMM 

P L E  1 1  A P P L E  1 I G S  

children in grades 3 t o  5 learn 

about charts and tables as 

well as bar, line, circle, and 

pictographs. 

The program's built-in data- 

base contains information 

about rainforests of the world, 

as well. 

Let's Learn About 

Geography: U. S.A. includes a 

database of historical and 

modules t o  keep up with the ; geographic information orga- 
memory demands of all that : nized around five themes: 

really cool software, devel- location, place, human/envirun- 
mental interactions, 

-) movement, and 
regions. 

In m, stu- 

dents travel around 

a game board, land 

1 on squares, and 1 answer questions 

about the United 

Graph Maker features a database of 
e-mailed by imagi- 

information on rainforests of the world, 
while teaching kids how to  use picto- nary GeO whiz pen 

graphs and other types of charts. Pals, whose elec- 

opers such as Troll Associates 

continue t o  release Apple I1 
programs requiring a miserly 

48K. A t  press time, the com- 

pany was readying five new 

educational products: Graph 
Maker: Introduction to 
Graphs and Charts, Let's 
Learn About Geography: 
U.S.A.. Parts of Speech: Fun 
with Adjectives and Adverbs, 
Reading for Understanding: 
Native Americans, and 

SOS Planet Earth: Puzzle 
Games. With the exception of 

Reading for Understanding: 

Native Americans, which 

retails for $29.95, these new 

Troll programs cost $39.95 

apiece. 

Graph Maker: Introduction 
t o  Graphs and Charts incorpo- 

rates animated tutorials, a 

graph-design module, and a 

Mvstery game t o  help 

tronic postcards 

are delivered by a Troll Postal 

Service truck tooting across 

the top of the program 

screen. 

Ann Anchor, the Oprah 

Jessy Donahue of the Troll 

Parts of Speech TV Network, 

is your host in Parts of 

Speech: Fun with Adjectives 

and Adverbs. 

Ms. Anchor interviews a 

series of animated guests, 

such as fashion designer Ralph 

Trendi, circus acrobat I. M. 

Best, and jockey Truly Swift as 

they help students learn how 

t o  use adjectives and adverbs 

t o  describe, modify, and 

compare words. 

In the Name That Ad!ective 

gr  Adverb qame, third- t o  
fifth-graders choose the word 

form required t o  complete a 

fill-in-the-blank sentence 

correctly. 

Reading for Understanding: 

Native Americans introduces 

students in grades 4 t o  6 t o  

the stories of Pocahontas, 

Sacajawea, Sequoyah, Sitting 

Bull, and Squanto. 

This comprehensive package 

combines five paperback books 

and a software program 

featuring a TV talk-show simu- 

lation, plus and 

Name That Book quiz games. 
SOS Planet Earth: Puzzle 

Games contains four paper- 

back books [Air Scare, Nature 

h w, Power Failure, and 
Water -1 and four 

coordinated software disks. 

Each disk includes cross- 

word, word search, or coded- 

sentence puzzles and other 

activities t o  help improve 

reading comprehension, stim- 

ulate logical thinking, and build 

science vocabulary. 

For additional information, 

contact Troll a t  1 0 0  

Corporate Drive, Mahwah, NJ  

07430,  or call C3001 526-  

5289,  (201 1 529-4000, or 

(2011 529-0953 (fax), or 
circle number 3 5 2  on the 

Reader Service card. 

Â 
LET'S BE GAREFUL 

OUT THERE 

s kills for Living, a new 

series of Apple It 
programs for secondary 

and adult students 

from Hartley 

Courseware, 

explores several 

consumer- and 

job-related sub- 

jects. The ten 

programs in the 

series teach stu- 

r 

behave on the job, shop wisely, 
buy a used car, and evaluate 

goods and services. 

Writ ten a t  the fourth-grade 

reading level, the programs 

feature simulations and 

games. Teacher's guides and 

black-line masters are included. 

Hartley's new life-skills pack- 

age runs on any 12BK Apple I1 

and costs $650. Selected 
tit les are available separately 

for $69.95 each, o r  in two 

sets priced a t  $350 each. For 

more information, contact the 

company a t  133 Bridge 

Street, Dimondale, MI 48821,  

[8001 247-1 380,  o r  (51 71 

646-6458. or circle 3 5 3  on 

the Reader Service card. 

Â 
CIRCUS, CIRCUS 

w i t h  help from a baby 

elephant, children in 

grades 1 t o  3 can learn t o  

solve math word problems 

while they explore circus tents  

in the MathLand theme park. 

MathLand requires only 48K 

and runs on any Apple II. I t  

features eight categories, 

including numbers and count- 

ing, money, time and calen- 

dars, measurement, distance 

and travel, math scramble 

[arranging equations], frac- 

tions, and graphs and charts. 

The child uses the arrow 

keys t o  move a baby elephant 

dents how t o  use 
credit cards 

wisely, manage a exi ition 

checking account, 

interview for a job, MathLand's circus characters teach kids time. 
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NEW RESOURCES 

p&ur intsa your curriculum and 
y w  artministmtiwe war%- 

load. For bast results, invitee 
teaching oalleaflues bo share 

t(w witem with yau. The film 
and acmqanying 

But see for yourself: The real 
stars in this program are 

chws, kids, and Apple llas. 
tf you'd lib ta h r m w  the 

Reader Service cad. 

four 91 Source far Educufional Software & Technohey 

Ai irica's largest supplier of 
lucational Technology ,A= d 

brings you America's Most 3fi 
Complete Educational 
Technology Catalog! 

Consumer Vmtons Â &A .- -=. 
.- 

School Versions Â I- 

xaderoicVerslons d 

Accessories 

Save up to 60% every daj 
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SHAREWARE SOLUTIONS 
BY JOE KOHN 

E ver notice that a lot of computer aficionados seem to 
also have a major fascination with science fiction in 

general and &ac Ic& in particular? As a vesultl outer-space 
simulations are some of the most popular freeware and 
shareware programs available. Your Apple I1 can conjure up 
whole new galaxies to conquer, and it can take you to places 
where not even NASA has gone before. There's a multitude of 
exciting games to choose from - so don your space helmet, 
fasten your seat belt, and ready and steady that trigger 
finger as we blast off for deep-space fun and excitement. 

Battle Zone, by Russell Nielson. $5 shareware. Battle Zone 
is a colorful arcade game for the lle/llc/llGS. As war rages on 
the planet Bannore, you're the only person who can stop the 
evil invaders from destroying the peaceful inhabitants. Using 
either keyboard commands or a joystick, you pilot a ground 
vehicle over rocky terrain, as you t ry  to  avoid outcroppings and 
alien bombs. You'll s ta r t  with SO lives, but each direct h i t  
costs you one life. The game includes 25 levels. One through 9 
are easy t o  complete; as you get t o  level 10, though, bombs 
come fast and furious, and you'll be trying to  avoid huge boulders 
while firing a t  anything that moves. Happy hunting, space ace. 

Creature Features, by Russell Nielson. $5 shareware. I t ' s  
another wild-and-woolly outer-space shoot-'em-up arcade game 
for the lle/llc/llGS. In this one, you'll encounter a number of 
weird-looking alien creatures; some you protect, some you zap. 
Using a joystick, you'll t r y  t o  defend the friendly creatures a t  
the bottom of the screen from creatures falling from alien 
bombers. The hostile ones also direct energy bombs your way; 
if you're hit, your controls freeze for a moment. When all four 
friendly aliens are dead, you lose the game. 

Ship Zone, by Russell Nielson. $5 shareware. More arcade 
action, controlled by keyboard commands. You star t  with three 
lives; whenever an alien ship appears, t r y  t o  blast it. There's 
just one problem: Three fast-moving barriers block your shots if 
your timing is off. With lots of wild sound effects and unlimited 
shots, a t  least you'll be treated t o  a good animation when 
you're blasted into oblivion. 

Star Trek: First Contact, by Jim Royal. Freeware. Fi rst  
Contact is a double-hi-res graphics-based strategy game for 
the 12BK llc/llGS/enhanced lie. Based on the simulator used by 
first-year students a t  Starfleet Academy, this one puts you in 
command of a --class starship on an exploration mission 
near the center of the Federation's frontier - a region popu- 
lated by 38 star systems and two Deep Space Outposts. Your 
objectives are t o  explore as many planets as possible and 
decide which are likely candidates for successful contact; you'll 
then be responsible for first-contact procedures with those 
worlds. You must also deal with the presence of an alien vessel 
somewhere in the quadrant; the intruder's purpose changes 
each time you run the mission simulator. Just  like Captain 
Picard and Commander Piker, you'll have full command-level 
access to  navigation, computer, engineering, and transporter 
functions, scanner controls, and tactical and communication 
functions. Do you have the right stuff t o  be a successful star- 
ship captain - or will you violate the Prime Directive? 

Invaders from Space, by David and April Taylor. $5 shareware. 
This GS game is a variation of one of the all-time-great arcade 
titles, Space Invaders. Wave upon wave of enemies crisscross 
your screen, dropping deadly bombs. With three barriers t o  
protect you, you'll be shooting back with your mouse, taking out 
lots of amusing-looking animated ships. These invaders aren't 
your basic run-of-the-mill spaceships, either - they're Mac 
computers, happy faces, Easter bunnies, and Christmas-tree 
ornaments. Upon payment of the shareware fee. you'll receive an 
even livelier version of the game [with sound effects1 by mail. 

Missile Attack, by Terry Burdett. S5 shareware. This one's 
another arcade game for the GS - an updated version of the 
popular Missile Command from the early 1980s, complete with 
sound effects. Using both mouse and keyboard, you t r y  t o  defend 
three cities from incoming alien attackers. You'll need steady 
reflexes and a fast trigger finger. 

Solarian GS, by David Tolson. $10 shareware. Based on a Mac 
shareware title, this version gives you three lives and several 
seconds of shield protection t o  star t  with Your colorful enemy 
flies in a circular formation; with unlimited mouse-activated fire- 
power, you'll t r y  t o  blast everything tha t  moves. Watch out, 
though - the  enemy shoots back. Complete with lots of digitized 
sound effects, Solarian is like a super Space Invaders with 
bombs and fireballs. Released in December 1992, this one quickly 
became one of the most popular GS games thus far. While high 
on the mayhem meter, Solarian sports a socially responsible 
aspect, as well: Players are directed t o  submit the shareware 
fee t o  Tolson's favorite elementary school. 

SpaceArrow, by Tom Gooding. $1 0 shareware. This is one of 
those rare shoot-'em-ups tha t  require both strategy and a 
steady trigger finger to  win. I t 's suitable far one or two players. 
All action is  displayed simultaneously in colorful windows. 
Controlled by keyboard commands or joystick, the game features 
an extensive built-in help system plus tats of stereo sound 
effects. You can also customize SpaceArcow t o  your liking: The 
software includes an artificial-intelligence module that  lets you 
produce your own scenarios or modify any of the eight battle 
scenarios included. SpaceArrow is  nothing i f  not  challenging; 
novices may want t o  load several scenarios during setup so that 
the computer represents both players. 

Space Cluster, from Miami Beach Productions. Freeware. 
Space Cluster is the brainchild of a now-defunct French develop- 
ment team. I t 's  an action-packed. super-hi-res, Galaxian-style 
shoot-'em-up for the GS, complete with fabulous sound effects 
and a thrills-and-chills soundtrack. Play by keyboard or joystick; 
you'll s tar t  with five spaceships and will soon find yourself the 
target of 18 enemy vessels. For the f irst few seconds, your 
adversaries will fly in formation, and you can pick them off easily. 
But watch out when they swoop in for the kill; they'll be coming 
from all directions in an unrelentless attack formation. 

Equipped with an Apple lle/c or a lies and any of these free- 
ware or shareware simulations, you too can wanderthe 
farthest reaches of the galaxy - battling evil aliens and safe- 
guarding civilization without ever leaving the safety and 
comfort of your own computer mom. 

GAMES MENTIONED ABOVE ARE AVAILABLE ON DISK FROM JOE KOHN. 
FOR MORE INFORMATION, SEND A SELF-ADDRESSED, STAMPED ENVELOPE 
TO 166 ALPINE ST., SAN RAFAEL, CA 94901. SOME TITLES MAY ALSO BE 
AVAILABLE FROM APPLE 11 USER GROUPS, OR BY DOWNLOADING VIA 
MODEM FROM THE ON-LINE INFORMATION NETWORKS AMERICA 
ONLINE, COMPUSERVE, AND GENIE. 
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Exclusive Source for the Best IIGS Programs 1 - 
I anahai 11:  Dr 

Out of this World": HIGHEST RATED GAME 
EVER by Computer Game Review! Using the 
new technology of polygonal graphics, Out of this 
Worlds amasterpiece in acton/advenluregames. 
Hurtled through space and time by a nuclear 
experiment gone wrong you must blend logic and 
skill to survive the alien land. Order product 
number IP60. Introductory price $49.95. 

1 1 ~ ~ .  Thisitem includes sixdisks: listall, Sv&m different layouts, animated tilesets and over 100 
sound effects. Several ways to play - Solitaire, 
Challenge &Tournament. Beyondall this there is 
the interactive version of the Dragon's Eye, a 
special challenge for superior Shanghai players. 
Order product number BR92 for $49.95. 

ln)idel,~all~hoo,~u8~ect,~itnessandotherclas- Toots 1 & 2, Fonts, SystemDisk and synihLab, 
sics. Alortune in InteractiveMystery, Fantasyand plus the official Apple IIGS System 6 User's Ref- 
Science fiction Adventures. Now available in GS erence. This 400-page manual tells you all about 
specific format with menus and GS/OS compat- System 6, including FSTs, Finder, Teach and 
ibilitv! Order product number BR93 forSS9.95. I Archiver.Order product number SX52 for $39. 

Other Great Apple llua rrograms 
Title Member's Non-Mem e s Title Membets Non-Member's 

Xenocide ' 

I 

I 
Battle Chess'": The most challenging game on 
earth comes to life in Baffle Chess, An entire 
medieval world at war Is reflected on the check- 
ered Held. BatBe Chess not only captures the 
basic logic of chess it brings it to life with colorful, 
humorous, and dramatic 3-D animations. Watch 
with fascination as your pieces act out your 
moves. Order product number IPS0 for $25. 

Mindscsps 
Balance of Power 1990 
Captain Blood 
Deia Vu I or Deja Vu I1 
Shadowgate 
Electronic Ans 
Bard's Tale I or II 
Cartooners 
Instant Music 
Instant Synthesizer 
Deluxe Paint 11 
Keef the Thief 
The Immortal 
Zany GoH 
InfeiQlay 
Neuromancer 
Sierra On-Line 
Black Cauldron 
King's Quest I, II, or Ill 
King's Quest IV 
Gold Rush 
Manhunter- New York 
Mixed Up Mother Goose 
Police Quest 
Space Quest I or 11 
Thexder 
MicmWusions 
Fire Power 
Accolade 
Bubble Ghost 
Hardball 
Jack Nicklaus' Golf 
Mean 18 Golf 
Serve and Volley 
4th &Inches 
FTA 
Photonix ll 
Three S i q  Pacihc 
Warlock 
Dark Castle 

Price 

$1 5 
$15 
$1 0 
$1 0 

$1 5 
$10 
$10 
$15 
$10 
$15 
$24 
$20 

$10 

$20 
$20 
$20 
$20 
$15 
$15 
$20 
$20 
$15 

$20 

$1 0 
$10 
$20 
120 
$15 
$1 5 

$15 

$10 
$10 

Price 

$20 
$20 
$15 
$15 

$20 
$15 
$15 
$20 
$15 
$20 
$30 
$25 

$15 

$25 
$25 
$25 
$25 
$20 
$20 
$25 
$25 
$20 

$20 

$15 
$15 
$25 
$24 
$20 
$20 

$20 

$15 
$15 

Software Toolworks 
Gin KingICnbbage King 
Hun1 for Red October 
Life & Death 
Mavis Beacon Typing 
Activislon 
GBA Basketball 
Hacker II 
The Last Ninja 
PantWorb Gold 
Music Studio 2 0 
Shanghai 
Mah1rnn 
Alrball 
California Dreams 
Blockout 
Tunnels of Armageddon 
Club Backgammon 
Tnango 
Vegas Craps 
Vegas Gambler 
Bnlanmca 
Gnarly Golf 
Great Western Shoolout 
Jigsaw! 
FTl Software 
Dungeon Master 
Casady & Greene 
Crystal Quest 
JaDa Graphics 
Basic Paint 
Seven Hills Software 
Express 
superConveli 
Space Fox 
DreamWorldSoftware 
DreamGralix 
Software Solutions 
Your Money Mailers 

Price 

$15 
$10 
$1 5 
$15 

$20 
$20 
$20 
$34 
$34 
$20 

$20 

$1 5 
$15 
$8 
$8 

$1 0 
110 

$7 
$10 
$10 

$20 

$20 

$30 

$26 
126 
$30 

$69 

$79 

- 
Sequential Systems RAM-GS": With memory 
expansion this cheap, there's no excuse for 'Out 
of Memory' errors. RAM-GS is a iow-cost, 4 
Megabyte memory expansion lor the IIGS. Easily 
installed, it is fully compatible with GSIOS, DMA 
and ail software its multi-layer circuit design 
makes it run cool and draw less power. Order 
product number SQ50 for only $140. 

Xenodde": An alien race has taken over a 
research outpost on a moon. Your job is to travel 
across the moon'ssurface in your hovercraft, then 
go into the undergound caverns and locate live 
explosive devices Next get to the Bio-lab and 
place lhebombsln thenuclear reactors lodestroy 
themoonandtheailens Order product number 
MR50 for only $23. 

Battle Chess 

Bhckjack~cademy~~:  The ultimate tutorial pro- 
gram for learning to play Blackjack, the most 
popular Vegascardgame. Itleaturesafive player 
table, multiple table rules llkein LasVegas, Reno 
and AtlanticCity anddifferent play strateg1es.The 
program will teach you when the odds are in your 
favor. Are you good enough to bust the bank? 
Order product number BR91 for $20, 

Tha I m m n r t a I n '  
Fast Service. Order by Fax (402) 379-3361 

Mastercard or Visa Accepted 
Youdon'thave to beamembertoorderout member 
orices are from $2 lo $10 less oer title. You can 
become a member lor only $19.95 and place your 
orderatthesametimetosave Big Bucks. Plus you'll 
receive twelve issuesof ourgreat newslettercalled 
Scarlett and our full catalog School purchase 
orders accepted. 

The Gate": Fight your way through a castle 
riddled withmazes tosavea bewitched kingdom. 
Battle against ghosts, magicians, snakes and 
other evil monsters. You'll need to use your head 
to solve the puzzles and your agility lo conquer 
the action. Nintendo type action for the IIGS. It 
earned hclder's Editors' Choice award. Order 
product number SV71 for only $30. 

Shareware Game 10-Pack: Get ten 3 5' disksfull 
ofthegreatestshareware&freewaregameslorthe 
Apple IIGS including Milestones GS, Star Trek 
Classic, Bouncing 'Ferno, Columns, Fioortlles, 
Cosmocade. Cnbbage, Blackjack Tutor, Space 
Clusters and many others Requires 1 25 Megs of 
memory and a joystick Order product number 
GP54 tor only $28. 

The Immortal": The best adventure game ever 
written forthe IIGS. Ventureintothedungeon and 
unravel the mysteries of the levels below. Fight 
against anlmatedtrollsandgobllns. See the blood 
spray off the edge of yoursword and hear the last 
groan of your enemy. Can you get past the whirl- 
pool? Product number EA82 Is only $30 for 
non-members or $24 for members. 423 Norfolk Avenue, Norfolk, NE 68701 



Share the wealth - and stretch your budget - 
when 11s and Macs line up to print. 

BY CYNTHIA E. FIELD, Ph.D. 

NETWORK NEWS 

I HAVE AN APPLE IIGS SYSTEM, A 
GCC Technologies BLP Elite laser 
printer, and an ImageWriter 11. The 

laser printer operates over AppleTalk, the 
ImageWriter is a "direct connect" device. 
Is there any way to switch between my laser 
printer and the ImageWriter I1 without 
having to swap cables and reset the 
Control Panel? 

David Holmes 
Duncan, BC 
Canada 

I HAVE A MACINTOSH LC, AN 
Apple IIGs, an Apple Personal Laser- 
Writer NTR, and an ImageWriter I1 

with an AppleTalk-compatible controller 
- all connected with PhoneNet cabling. I 
can use either printer from the Mac, but 
I've been unsuccessful getting my GS 
to print. Should I install Appleshare on 
my GS? Which folder(s) should contain 
the ImageWriter and LaserWriter printer 
drivers? 

Nordeana Nimphius 
Delavan. Wl 

0 UR SCHOOL NEWSPAPER OFFICE 
uses a Macintosh Ilci, a Mac Classic, 
and two Mac Classic 11s with Apple 

LaserWriter and Hewlett-Packard Desk- 
Writer printers. Can you suggest an 
under-$400 network we could use to trans- 
fer files and share printers? 

David Xu 
San Francisco, CA 

The quick answer for you, David Holmes, is 
to  plug the ImageWriter into your lies' modem 
port [PI, and set up on the Control 
Panel for a printer. Thereafter, simply select 
the printer you prefer from the Chooser, or 
print t o  

If both GS ports are already in use, or if you 
want to  connect more devices - computers 
and printers -you should invest in a local-area 
network M. In fact, all of you can best share 
your printers - and files - among Macs and 
Apple 11s over en AppleTalk network. Because 
Apple builds AppleTalk into all the latest Macs 
and the lies, networking is a snap and costs 
you only a few dollars for connectors and cables. 

If you're looking for a short [really short) 
course on AppleTalk networks, you've come t o  
the right place. For a more-exhaustive treat- 
ment of the subject, be sure to read back issues 
of j&kh!&, particularly Gregg Keizer's Bridg- 
ing the Gap columns, which help foster the 
peaceful coexistence of Macs and Apple 11s - 
specifically "Printer Polygamy," May 1991. 
p. 66; "Update: Printer Polygamy," August 

1991, p. 25: "Tricks of the Trade." January 
1992, p. 20; "Teamwork," August 1992, p. 18; 
and  tami in^ the Beast." November 1992, 
p. 20, You may also want to pick up a copy of 
the which contains self- 
paced instructions on how to configure and use 
AppleTalk and other networks. 

In a nutshell, first make sure each device you 
want t o  connect in an AppteTalk network has a 
"Loca~alk" intmke. m k r s  to  the 
network's Mw6re; &&B& indudes those 
connections and the enabBng software.] Your 
Macs and lleses use the printer por t  for 
LocalTalk. As you already know, Nordeana, 
Apple's laser printers abo haw built-in LocalTalk 
interfaces, as da some third-party printers, 
including your HP OeskWriter, David Xu, 

You can purchase optional LocelTalk inter- 
bees frem Apple for other devices, such as an 
hogeU- IW Locaffelk Option Cad for 
your ImageWriter, David Holmes, or an Apple I1 
Workstation Card for a lie. A Timbuktu 
PhoueNet Kit  (connectors included1 from 
Farallon lets you connect a PC compatible t o  
an AppleTalk network. 

Unfortunately, you can't make all third- 
party printers "AppleTalk-ready" - be sure to  
check with the printer's dealer before you buy 
a unit that's destined for an AppleTalk network. 
And follow the manufacturer's instructions 
carefully t o  configure the LocalTalk interface 
properly. For instance, you have t o  reset the 
Imagewriter's DIP switches to  enable AppleTalk 

I 
Figure, Sharing two printers on an Apple lies/Macintosh AppleTalk network. 
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Next. you need t o  purchase some LocalTalk 
connectors and run cabling t o  t ie all the devices 
together.  Apple sells t h e  connectors and 
cables, but that 's the  more-expensive option. 
Instead, other companies, such as Farallon, 
Hardware That Fits, and Maya Computer, sell 
LocalTalk connectors tha t  use standard four- 
wire telephone cable t o  t ie devices together. 
Depending on the source, each connector costs 
about $15 t o  $20. Some manufacturers 
include the cable with the  connectors. 

For maximum flexibility in configuring your 
network wiring, head for your local Radio Shack 
or  other electronics-supply outlet and buy a 
spool of four-wire telephone cable, standard 
RJ-11 four-conductor telephone connectors, 
a pair of wire strippers, and a modular-plug 

NETWORK PRODUCTS 
Apple II Workstation Card 
Part Nft A 
Apple LAN 
Part No. A1 055.81 DO 
ImageWriter JW LocalTalk l$WiOn 
Part Mn. ABB0314. S1 I9 
LocalTalk Locking Cable Kits 
Pat% No. Meoefi, SSS I 0  . sewes~waws. 

nectar Kit OHV-8 

Hy wsp-Net RJ-11 rk Connector 
Hadwade That Fits 

crimping too l  [ t o  cr imp those  telephone 
connectors onto the ends of your cables). Or get 
precut lengths of telephone wire with connec- 
to rs  from the same sources. 

The simplest LocalTalk network is linear: Each 
device [computer or printer) is daisychained t o  
the next one in series; the order isn't important. 
Insert a terminating resistor [supplied with 
each LocalTalk connector1 into the empty RJ-11 
jack on the connector attached t o  the f irst and 
last  devices in t he  network chain. [Apple's 
LocalTalk connectors don't need terminators.] 
How far can your network extend? The Hypar- 
Net RJ-11 Network Connectors we use 
suppor t  as many as 3 2  LocalTalk devices 
located along 3000 network feet. Once you've 
run wires between connectors, plug those Local- 
Talk connectors into each printer, into the PC's 
limbuktu PhoneNet or the lie Workstation Card, 
and into the printer port of your Mac or l lsa 

Next, if you haven't done so already, install 
the appropriate AppleTalk and printer device- 
driver software in your Mac, GS, PC, andlor lie 
f rom the appropriate system Installer. For 
example, with the pvstem 6 Installer program 
found on your OSIOS Install Disk, click on the 
Customize button, then select t o  install Apple- 
Talk and the AppleTalk options for each of your 
printers. The Installer puts the  needed device 
drivers into the GSIOS Svstern/Drivers folder. 
Similarly, install the proper Mac printer drivers 
in the Mac's Zvstem folder. 

You're nearly there. Finally, enable AppleTalk on 
each of the computers on the network. On the 
GS [ROM 01 systemsl. set in the Control 
Panel t o  Your Card and W t o  Built-In 
m. On the Mac you activatejnactivate Apple- 
Talk from the Chooser. Thereafter, just select the 
printer you prefer from the Chooser. 

For David Holmes, an AppleTalk setup will 
cost about $150 because you'll need t o  invest 
in an Imagewriter 111LQ LocalTalk Option Card. 
Nordeana, your network probably looks some- 
thing like the accompanying Figure, a t  a cost of 
less than $200, The arrangement David Xu 
could use may be only slightly more complicated, 
because of the two additional computers in the 
newspaper office. The connectorlcable assem- 
blies you need should set  you back no more 
than $1 0 0  -well within your $400 budget. 

Beyond printer sharing, there's also an added 
benefit t o  an AppleTalk network: file and appli- 
cation sharing. By installing Appleshare on each 
of your computers, you can gain access t o  other 
computers and their disk drives -but that's a 
story for another Clinic, 

BYOD 

T 0 MAKE MY APPLE IIGS MORE 
useful, I'd like to attach a 40-mega- 
byte Quantum ProDrive LPS hard 

drive that was removed recently from a 
Macintosh IIsi. I'd like to install the hard 
drive in a case outside the GS. I know I 
need to buy an Apple I1 High-speed SCSI 
Card, but what other components do 
I need? 

Charles R. Gundersen 
Poulsbo, WA 

For hands-on types like you, Charles, Sun 
Remarketing sells the BYOD [Build Your Own 
Drivel SCSI Kit, including case, power supply, fan, 
and switch. Jan Quayle, a Sun Remarketing sales- 
person, says the case accommodates drives up 
t o  half-height in size (5.75 by 4 by 1.5 inches]. 
She suspects your drive may be smaller than 
that,  so you'll need t o  purchase appropriate 
mounting brackets elsewhere. Try the folks a t  
Jameco Electronic Components; they sell mount- 
ing plates, bezels [to fill empty space], and rails. 

Unless your Quantum drive is  internally 
terminated [check the manual if you have one, or 
ask a local Apple dealer), you'll need a $19 SCSI 
terminator. 

Because the drive is currently formatted with 
Macintosh system software, you'll also have 
t o  reformat the unit before using it with your 
GS. Formatting software is included with the 
Apple II High-speed SCSI Card. 

Sun Remarketing can provide the final link: a 
SCSI cable [$IS) t o  connect this do-it-your- 
self drive t o  the GS. 

14151 592-8087 
(8001 237-8948 fan 
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UDDERLY POSSIBLE w E'RE USING APPLE IIES DATING 
back to 1984 as data-acquisition 
systems to monitor artificial-heart 

experiments. Over the years most of the 
utility software we currently own, as well as 
the source listings for our programs, have 
been destroyed, lost, or eaten by the cows 
in which we install the artificial hearts. We 
need to modify our software. Can you 
suggest a good assembler/disassembler so 
that we can reconstruct the source code? 

Also, we have the utility program Copy 
I1 Plus, but it needs at least an enhanced 
lie. Can we install the lie enhancement kit 
(with its 65C02 processor and new ROMs) 
without affecting our assembly-language 
programs adversely? 

Pat Thomson 
Artificial Heart Lab 
University of Utah 
Salt Lake City, UT 

According to a spokesman at  Roger Wagner 
Publishing, assembly-language programs run 
just as well after you install the four chips ofthe 
Apple lie Enhancement Kit as before. Depend- 
ing on the motherboards in your lies, however, 
you may also need the Apple lie Revision A to 
Revision B Logic Board Upgrade. It 's free from 
your local Apple dealer. See "Free Lunch," Apple 
Clinic, December 1992, p. 17, for details. 

Roger Wagner Publishing's Merlin 8/16 soft- 
ware may meet your assembly-language pro- 
gramming needs. The package includes four 
assemblers, among them &bit ProDOS 8 and 8- 
bit DOS 3.3 versions, as well as a disassembler. 

Gentrat Paint Software 

" disk, 

WHO YA GONNA CALL? 

I 'VE RECENTLY UPGRADED MY 
Apple IIGS to System 6.0. Now I need 
to update my copy of the Apple IIGS 

Toolbox Reference to reflect GSIOS' new 
features. How can I contact the Apple 
Programmers and Developers Association 
(APDA) to update my manuals? 

David Meyer 
Bloomington, IN 

For more than a year now, David, Resource 
Central has handled all APDA products, includ- 
ing the three-volume Apple l ies Toolbox 
Reference. But  Resource Central's Tom 
Weishaar says that what you probably need is 
The Byte Works' Programmers' Reference for 
System 6. This book contains all the information 
you need about the Apple lies Toolbox and 
G S W .  including System 6. 

TOOLBOX RESOURCES 
Apple lies Toolbox Reference 
Volumes 1 and 2. 
8B6. B6 each 
Apple 116s Toolbox Refee 
Volume 3. $39.95 
GB/OS-6 
S3S with manuals 
Pmgrai~BiBî ' UBrBronco 
(or System B, $45 
Resource Central 
P.O. Box 1 1250 

BB207 

THE WRITE STUFF 
USE APPLEWORKS 1.1 FOR WORD 
processing on my Apple IIc. Are there 
any spelling- or  grammar-checker 

programs that work with AppleWorks? 

Darryl Mat ter  
Portis, KS 

Two Apple II grammar checkers come to  mind, 
Darryl, Sensible Grammar - an Apple II family 
classic - is a stand-alone program, It ana- 
lyzes ProDOS word-processing files created 
with programs such as AppleWorte. To grammar- 
check a document, you must f i rst  "print t o  
disk" or save the text in ASCII format. The, 
start  up Sensible Grammar and load that text 
file. According t o  a Quality Computers 
spokesman, you can make some of the recom- 
mended editorial improvements from within 
Sensible Grammar itself. For more-extensive 

changes you need t o  re-open the file in your 
word-processing program. 

TimeOut Grammar, a much newer Apple II 
product also marketed by Quality Computers, 
works within AppleWorks. That means you don't 
have t o  shuttle files back and forth between a 
word processor and a grammar checker. Time- 
Out Grammar requires AppleWorks 3.0, which 
includes the spell checker you want. You can 
order an AppleWorks 3.0 upgrade through Claris 
Corporation. 

r.Hâ‚¬Ciriiu UP 
& 3.0 
Claris Corporation 
5201 Patrick Henry Drive 
Sanca Clara. Cft 95052-81 B8 
(4081 727-8227 
$249 
ST@ upgrade 

Sensible Grammar, S49.95 
TimeOut Grammar. $49.95 
Quality Computers 
2Q200 East Nine Mite Road 
St. Ctsir Shares, MI 48080-OB65 
(8003 777-3642 
(313) 774-7200 
(3733 774-2698 f Ã  

DISAPPEARING ACT?' [NOT!! 

T HE 40-MEGABYTE CHINOOK 
Technology hard drive that's 
attached to my IIc is on its last legs. 

Although the drive hasn't crashed recently, 
I don't trust it. Is Chinook still around? 
How can I contact the company? 

Ron Sullivan 
Newport News, VA 

Sequential Systems has acquired the 
Chinook Technology product line, Ron. According 
t o  Joseph Yandrofski, company president, 
Sequential Systems sells and supports Chinook 
drives and honors all warranties. 

m 

Sequential Systems, Inc. 
1200 Diamond Circle 
Lafayette. CO 80026 
(8001 999-1 71 7 
(3031 666-4549 

1 (3031 665-0933 fax 1 

BLAST FROM THE PAST 
FRIEND GAVE ME A DC HAYES 
Micromodem He. Where can I get 
an instruction manual? 

James Taylor 
Shaw Air Force Base 
Sumter, SC 

18 inCider/A+ March 1993 



A customer-service representative at Hayes 
Microcomputer Products says you can 
purchase a copy of the Micromodem lie manual 
for $99. But don't get out your checkbook yet, 
James. For one thing, the Micromodem lie runs 
at a snailish 300 baud -a rate that's way too 
slow for today's telecommunications needs. 
Unless you're just going to log onto local 
BBSes (bulletin-board systems], you're better 
off investing in a newer, faster (2400-baud plus1 
Hayes-compatible modem. You say you already 
have a Super Serial Card, so you should consider 
purchasing an external modem, which you can 
connect physically to another computer when 
it's time to upgrade from the Apple lie. 

Hayes Microcomputer Products 
5953 Peachtree Industrial Blvd. 
P.O. Box 105203 
Norcross, GA 30092 I 
(4041 441-161 7 customer support = 

THANKS FOR THE MEMORY w ILUAM L. DUNHAM OF BOYNE 
Falls, Michigan, tells us he experi- 
enced several annoying problems 

with his StyleWriter printer until he 
increased his GS' memory from 2 mega- 
bytes to 3 megabytes. Among other things, 
the StyleWriter now prints Pyware Music 
Writer scores correctly and handles larger 
(20-point plus) Appleworks GS text, as 
well. If you've experienced similar problems 
with the Stylewriter, William's tip may help. 

PRINT SOLUTIONS 
ApplaWorks 68 1.1 
Claris CorporatiBn 
5301 Patrick Henry Drive 
Santa Clara, CA 95052-8188 
(4081 727-8227 
$299 

Pyware Mush Writer 
Pyamohtes Corporation 
P. 0. Box BSB 
725 East Worth 
Grapevine, lX 7E8DB1 
181 71 481-7538 
8119Ã‡2S5ASa 

Stytawrtter, 
Unavailable Far ordering ' Stylewriter It. 
Apple Computer Inc. 

8 20525 Mwiani Ave. 
pupepcim, GA 95014 
(4081 89B-1010 

WRITE T O  APPLE CLINIC, INCIDERLA+, 80 ELM 
ST., PETERBOROUGH, NH 03458, AND ENCLOSE 
AN SASE. BECAUSE O F  T H E  VOLUME OF 
LETTERS, HOWEVER, WE'RE UNABLE TO RESPOND 
TO ALL QUESTIONS INDIVIDUALLY. 

PICTURE PERFECT 
/Â If you're co~nnected to Internet, 
either directly or through a mall gate- 
way, you already have the ability t o  
send electronic-mail messafles around 
the world. But did you know you can 
also send Apple 11 programs and files 
via Internet e-mait? 

To <So so, firet eawesa your 01-0- 
gram or file with Andy Nichoiaa' fres- 
ware utility Shrinklt. Then process the 
compressed file through David Wit- 
nay's freeware utility BinSCII 1 S.3. 
In a message posted on Usenet's 

program 'far the Apple 11 series that 
encodes and decodes Apple ProDOS 
files t o  allow convenient and error-free 
transmission over computer networks. 
BinSCll is the functional equikmleat of 
UNIX's utilities, as it 
allows any loeal file to be transferred 
via mail in a format that consists 
entirely of printable text, Including the 
file's Incat attributes, so that the ftle 
may be re-created pflrfectty on the 
detBEination system. " 

Once you've transmitted the file via 
e-mail, the recipient must process It 
first through BInSCll and then through 
Shrinkife The pesuttang file, extracted 
and decompressed, will be an exact 
duplicate of the original. 

Shrinktte is available via modern Â¥fro 
any Apple 11-oriented BBS or on-line 
network. BtnSdI may be a little harder 
t o  locate; if you're having cBftioutey find-, 
ing it, send a request to Joe Kotin at 
78702.565& pcmpseroe. corn and by 
return e-mail you'll receive a 15K file 
that includes an executable version of 
BinSClI. along with Todd Whitesel's 
complete irtstructi~ns describing how 
and when t o  use it. 

PRINT SHOP UPDATE? 
est stumbling block fop 

Apple 11 owners who have purchased a 
Hewlett-Packard DeskJet or LaserJet 
Brincer is that they cant use it wish 
BrodBfbund<s popular desktop-publish- 
inn programs Print Shop, New Print 
Shop, and Print Shop GS. Although 
Broderitund offers an update that 
includes HP printer drivers for the IBM 
versions of Print; Shop, the  uampany 
says It currently has no plans t o  do so 
for the Appte II versions. If you'd be 
interfasted in purchasing a Print Shop 
update that would work with HP 

printers, write to  the folks at Bratler- 
bund and tel l  them so. If eriouah of us 
respond, maybe they111 recolnsider. 
Send your requests t o  Bmderbundi 
Software, ,&En: Product Manager/ 
Apple II Print Shop,, P. O. Box B125. 
Nwato, W %S4@-872S. 

4 1 TIMEOUT 
If you have a TimeOut Ultra- 

Works Classic, press the open-apple, 
~ h i f c ,  and eonma keys simultaneously, 
and you'll see an itqmrtant "Easter 
egg" msssagje displayed In the tower 
pim-hand portion of your screw. 
Â Randy Brands, tifeetor of Ultra- 
Macros (published originally by Beagle 
Bros, now marketed by Quality 
Cornputersl, has released a significant 
update, Ultras 4.1, through his own 
company, JEM Software, 7578 Lamar 
Court, An/site, GO 00003,13031 422- 
4856. The program provides numerous 
new enhancements and features, more 
than 100 new commands, task-file 
caching, ten tames the variables, an 
enhanced commnd, and user- 
defined labels, 

Ultras 4.1 runs on any HBS, Ite, or 
enhanced lie with at least 266K of 
RAM. It requires AppleWorks 3.0 and 
TimeOot UleraMacros 3.1. Retail 
price is $80. As a special offer to 
itC&&r& readers, mention 
when you place your order and gee 
Ultras 4,1 for 8547 plus $3 shipping. 

Brsndt offers ongoing technical 
swpprt fw Ubas 4. f an Enie's A2 
a m  inma@QilZL-B In aMi- 
tion, inCicter/A+ contributor Will Nelkffn 
is tfffBriq an on-line tutorial for Ultras 
on EEni~*zi &%k~ area. If y a ~  have 
a G w s  &o t h ~  A2Pm libraryg download 
file #ED39 far an overview, and ftle 
#El40 for the first lesson. Fm those 
of you who don't own a modern or don't 
subscribe to BEnie, Naiken has pub- 
lished a 100-page book, titled ULJBA 

4,1 lessons, tutorials, hints, and tips, 
plus a disk of sample macros. The 
boofc/dtsk combination sells far $24. B5 
from Marin MacreWorks. 1 B75 Brand 
Avenue, San Rafael, CA 94801. 
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* * * *  
POOR OOOll GREAT 

It's beautiful, it's haunting, 

it's a whole new digital universe. 

T he next generation of GS game software has arrived, 
and it's Out of This World. Created by French devel- 
opers Delphine Software and ported to the GS from 
the Super Nintendo version by Bill Heineman, Out of 

This World is filled with level after level of ominous yet dazzling 
animated graphics and eerie digitized music and sound effects. 
There's never been a computer game quite like it before; play- 
ing Out of This World is like being thrust into someone's inter- 
active paranoid nightmare. This one's in a class by itself, blending 

successfully the best elements of strategy 
games and fast-action outer-space 
shoot-'em-ups. The sheer beauty of its 
murky and mysterious scenarios makes 
it a marvel to look at and an experience 
to play. 

THEY'RE BACK..  . 
Out of This World contains 15 per- 

ilous levels of super-hi-res fun and 
nerve-wracking excitement. You'll watch 
in amazement and horror as your latest 
particle-accelerator experiment goes 
awry. Struck by a lightning bolt that 
causes a massive explosion, you'll be 
transported out of this world into a 
beautiful yet dangerous universe, a 
world where wild beasts stalk you and 
death awaits around every corner - a 
world filled with deadly earthquakes, 
killer slugs, voracious wild beasts, carni- 
vorous vines, and sadistic, trigger-happy 

guards whose sole purpose is to 
put you out of your misery. 

You'll soon be swimming, 
crawling, running,  kicking, 
swinging, and shooting at an 
unrelentless adversary that 
grunts in an incomprehensible 
alien tongue. Along the way to 
fast-action arcade adventure, 
you'll find yourself traversing 
rock-filled caverns and leaping 
bottonlless chasms, shooting 
everything that moves, running 
and ducking alien-fired lasers. 

You'll die a thousand deaths, 
but you'll learn from your mis- 
takes. You'll find yourself inside 
prison cages and war machines, 
escaping from alien arenas and 

harems, falling and crawling through 
underground passages. You'll make 
friends with an alien fellow prisoner 
who will ultimately save you from your 
hellish environment, if you're persistent 
and lucky. 

You'll learn how to avoid fatal situa- 
tions, and you'll become an expert on 
alien weaponry. Out of This World is 
nothing if not challenging, and there's 
no room for hesitation or error. 
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Cinematic themes are evident through- 
out the game, from the configuration 
menu that lets you play in 16mm full- 
screen mode or half-screen TV resolu- 
tion, to the dosing scene, which depicts 
you flying off into the sunset. State-of- 
the-art, real-time polygonal graphics and 
rotoscoped animation make you wonder 
whether you're playing a computer game 
or watching a multimillion dollar Holly- 
wood sci-fi epic. From the opening notes 
of the Pink Floyd-style soundtrack to the 
closing Star Waretype scrolling credits, 
you're surrounded by a high-tech master- 
piece that redefines for all time the status 
of GS gaming. 

HOOKED ON THE CHALLENGE 
No doubt about it, Out of This World 

is hard to play. The manual is purpose- 
fully vague - figuring out the sequence 
of moves that will let you escape your 
worst nightmare is where the fan and 
challenge, lie. Timing's critical; one mis- 
step or missed shot may result in instant 
annihilation. Whenever you die, the 
game lets you restart on the last level 
played - but even though you've over- 
come the same perils before, you may 
have difficulty duplicating those exact 
moves the next time. No one ever said 
that fighting for your life was easy. 

Out of This World may be the best 
game ever released for the Apple IIGs. 
Its mass appeal will have both teenagers 
and adults coming back night after 
night, month after month. The only 
problem is that once you've played it, all 
your other computer games will seem 
low-tech and obsolete. Good thing 
Interplay has plans for a sequel to this 
Out of This World experience. 

Joe Kohn 
San Rafael, CA 

Out of This World: You'll die a thou- 
sand deaths, but you'll keep coming 
back for more. 

G etting the most from your Apple 
IIGS sometimes demands a little 

extra - in terms of both time and 
money. Take the problem of data stor- 
age, for example. If you're running out 
of disk space, file-compression software 
can help you squeeze more into every 
kilobyte. That extra room doesn't come 
without a price, though - you'll have to 
wait for compressed files to unpack and 
launch. Is it worth it to install still another 
utility? This one's worth it - AutoArk is 
one solution that packs a wallop. 

THE BASICS 
AutoArk installs as part of the Apple 

IIGS operating system, putting a new 
menu on your Finder and space-saving 
utilities at your fingertips. It consists of a 
GSIOS INIT and a system extension that 
activate when you boot your GS. The 
program requires a minimum of 1 
megabyte of RAM, Finder 6.0, and 
GS/OS 6.0; it won't work with earlier 
Apple IIGS operating systems. 

When you boot up with AutoArk, the 
Finder's Extras menu is activated with 
five new items (Compress, Encypt, Expand, 
Archive Info, and Configure AutoArk); two 
new selections appear under the Apple 
menu (AA Compress File and AA Expand 
File). So what can you do with all these 
wonderful new system modifications? 

Selecting files from a hard or floppy 
drive and choosing Compress from the 
Extras menu will start compression and 

display a dialog box listing the pertinent 
file(s), compression percentage, and 
number of bytes saved. A nifty document 
"thermometer" shows graphically how 
compression is proceeding. 

The Expand menu selection activates 
decompression and a similar dialog box. 
Encrypt lets you add password security 
before compressing a file. Choosing a 
file and selecting Archive Info brings up a 
dialog box displaying filename, original 
type, original and archived size, creation 
and modification dates, and the file's 
encryption status. 

Choosing Configure AutoArk produces a 
dialog box from which you can cus- 
tomize the way the program works, 
including enabling and disabling the 
AutoArk selections in the Extras menu, 
creating a temporary compressed file, 
verifying compressed and expanded 
data, and displaying compression and 
expansion dialogs. 

The AutoArk configuration dialog box 
includes two additional selections: Key 
Equivalents, which lets you set keyboard 
shortcuts for AutoArk's Extras menu 
items, and Assign Compressors, which gives 
you a list of application types with 
default compressors assigned. You can 
assign each application type a specific 
compressor from a list that includes Run 
Length, UM/LZ W, Huffman/Adaptive,  
Huffman/816,  and HuffmanIASCII - 
industry-standard compression schemes. 
Econ recommends UMILZW compres- 
sion for most applications. 

AA Compress File and AA Expand File, 
installed on the Apple menu, let you 
select files to compress or expand from a 
dialog box. You can work from within an 
application, which saves you the trouble 
of navigating through your hard-drive 
and folder icons to find the files you want. 

Files compressed with AutoArk are dis- 
played on the Finder desktop as Auto- 
Ark icons with archive filetypes. In the 
file dialog of a desktop application like 
Appleworks GS, however, compressed 
files appear with their native filetypes 
and names. AutoArk lets you run com- 
pressed files by double-clicking on a 
compressed-data or application-file icon. 
This unpacks the file and then (in the 
case of a data file) launches the applica- 
tion that created it. The process is sur- 
prisingly fast. AutoArk is a GS "desktop" 
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1 unaccelerated 1 1 1 1 
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Table. AutoArk compression/decompression times. UW/TEXT= U W  compression modeltext 
file; UW/SHR = U W  compression mode/640-by-200 single-hi-res graphics screen dump; 
HUFF/TEXT= HuffmaWAdaptive compression modeltext file; HUFF/SHR = HuffmanIAdaptive 
compression model640-by-ZOO single-hi-res graphics screen dump. 

application, so you'll have to unpack 
files created by text-based applications 
such as AppleWorks Classic before you 
can use them. 

ROOM AT THE TOP 
Compressing and expanding files on 

your hard drive creates the potential for 
file corruption in thecase of a power out- 
age or system reset midway through a 
job. To guard against data loss, AutoArk 
lets you create temporary files for each 
compression or  decompression 
(Configure AutoArk menu), which it  
deletes upon successful completion of 
the job. Choosing Data Verification from 
the Configure AutoArk menu ensures that 
the original and final data files match 
before the original is deleted, an addi- 
tional safety feature. Selecting these 
options adds to file compression/decom- 
pression time, though, and requires disk 
space for temporary files. 

Adding new extensions to a loaded 
GSIOS system carries the potential for 
disastrous conflicts all on its own, as well. 
I tried to "break" AutoArk by running it 
on a system loaded with other extensions; 
the program ran with no problems. That 
doesn't guarantee that AutoArk won't 
cause problems with your particular 
system, but it's some indication that the 
program is fairly compatible. 

To gauge AutoArk's performance, I 
ran it accelerated and unaccelerated, 
and used UMILZW and Huffman1 
Adaptive compression to evaluate differ- 
ent compression techniques on a variety 
of single-hi-res 640-by-200 graphics 
screen dumps and a 164K text file. 
Compression times (wen unaccelerated) 

and the degree of compression were 
impressive. (See the accompanying 
Table, above.) 

The extras are all here, too. Many of 
the program's configuration options and 
special features aren't offered anywhere 
else. Menus are well designed; the docu- 
mentation is comprehensive, with a 
number of useful "screen shots" showing 
program menus and dialog boxes. An- 
on-disk help file provides last-minute 
information on AutoArk's compression 
options and update plans. If you need to 
get more productivity from your Apple 
IIGs, AutoArk is a worthwhile addition to 
your system. 

Garry Howard 
Vancouver, BC 

Canada 

UNIVERSE MASTER 1 
Econ Technologies 
P.O. Box 195356 

requires system Software 6.0 or later 
hard-disk drive recommended 
$149 

T he Apple IIGS is the last personal 
computer for which a hard-disk 

drive was considered (until recently) just 
a peripheral; 40 megabytes of space for 
data and programs is what even inex- 
pensive PCs and Apple's lean Power- 
Books start with. Because the hard disk 
came late to the GS, the machine's Finder 
software doesn't manage the hardware as 
well as it might. 

Universe Master fills that gap. It can 
recover files you damaged or deleted by 
mistake; it can repair disks, create back- 
up copies of valuable files, and even 
keep the files on your hard drive tidy for 
optimum performance. But Universe 
Master's greatest strength isn't what it 
does, but how it does it: Its user interface 
is easy to understand and operate. 

That's especially important when it 
comes to backing up data files. Keeping 
separate copies of data is something 
every computer user should do, but most 
don't, because it's too much trouble: You 
have to find the files you want to back 
up, check to see whether they've 
changed since the last backup, copy 
them, perhaps even compress them. 
Universe Master offers a solution: It 
writes a "script" containing step-by-step 
instructions the software will follow, 
detailing the files you want to copy, 
where you want to keep the copies, and 
when you want them. Each script you 
write is a Universe Master file - you can 
keep your scripts on the Finder desktop 
and simply double-click on a script each 
time you want to back up. You can even 
"chain" scripts together to perform all 
your backups at once, o r  to  make 
changes to a script you wrote earlier. 

It's fast, too. Backing up a folder con- 
taining everything I wrote for inCider/A+ 
in a year - about 100 AppleWorks files, 
each 10K to 20K in size - took only 30 
seconds. And it's painless: Just make it a 
habit to run your script at the end of 
each workday as you shut down your GS. 

But even taking Universe Master's 
simple interface into account, the busi- 
ness of backing up calls for a certain 
level of hard-drive organization if you're 
going to avoid disaster. Organization is 
something software can't do for you - 
yet - but Universe Master's excellent 
documentation offers a straightforward 

22 inCider/A+ March 1993 



guide to keeping your files in order. It's 
important to understand, for instance, that 
Universe Master isn't designed to back up 
whole volumes, such as your entire hard 
drive, at a time, but instead keeps copies 
of files associated with your current work. 

Universe Master includes a wealth of 
additional features: password protection, 
printed tree catalogs, file-attribute modifi- 
cation, file copying and deletion. Universe 
Master also works with Econ's AutoArk 
(reviewed on p. 21), using the same file- 
compression routines. If you're using 
AutoArk to archive the files on your GS' 
hard drive, it makes sense to use Universe 
Master as your file-management program. 
(If you're using a program such as Apple's 
System 6 Archiver or Westcode's Hard- 
Pressed, Universe Master can't expand or 
compress your archived files.) 

I was less impressed with some of 
Universe Master's other features. Its file- 
recovery program, for example, was 
unable to return my deleted AppleWorks 
Classic files to a usable form, and my luck 
was no better with AppleWorks GS docu- 
ments. Universe Master does include a 
block editor, which you can use to recover 
files manually by restoring header infor- 
mation, as you do  with ProSel, but I 
expected more from a program that backs 
up data so effortlessly. 

Let's hope an improved file-recovery 
function is in the works for a future 
version of Universe Master. There's every 
reason to believe it is; Econ has offered 
two free upgrades to registered users since 
version 1.0. The next version promises to 
offer backups of entire volumes onto a 
number of floppies and better optimiza- 
tion of hard-drive space. (The program 
currently offers only the ability to "zero 
out" unused blocks.) 

If you have a hard disk, all your valuable 
data is probably in one place. When I 
switched from using floppies, which dis- 
tributed my data over many disks, to a 
hard drive, it took a hard-disk crash to 
convince me of the necessity of backing 
up. Don't take that chance - if you're 
looking for a simple way to ease your disk- 
management chores, Universe Master is a 
great choice, and a program that also 
holds a lot of promise for the future. 

Paul Stat t  
Senior Editor, jnCider/A+ 

MPD 5%" DISK DRIVES FO 
1 Year Warranty Apple 11, II+, He & 
Parts & Labor Franklin Ace 1000 

100% Compatible Apple IIGS 
Apple lie UniDisk #& 

super Quiet Apple Ilc, llc+ 
-- Cable & Laser 128's 

PROTERM 5 '/4 inch Disk I1 
Disk Controller Card $39.95 

Memory Chips.. .......... Call For Apple 11, H+ & He UniDisk 

MPD 4 Meg GS Card 
5 Year Warranty $59.95 

0 Meg ................ $59.00 
1 Meg ................ $99.00 GS MOUSE 
2 Meg ............... .$139.00 
4 Meg ................ $219.00 GS TRACKBALL 

SUPER EXPANDER 
11+ He Hc ...... OK $95.00 $69.00 $79.00 ... 256K $115.00 $89.00 $99.00 ... 512K $135.00 $109.00 $119.00 ... 1 Meg $175.00 $149.00 $159.00 

MPD He 256K/80 COLUMN BOARD 
(256K Only) Gives Appleworks 3.0 

Desktop of 137K 

Parallel Text Only ....... $36.95 

CPM Card. ............ $36.95 
He Numeric Keypad ..... $34.95 
Hc Numeric Keypad ..... $39.95 

$79.00 

Extended 80 Column Card 
With 64K for Apple He * 100% Appleworks 

Compatible 
5 Year Warranty 

He to Modem lIc to Modem 
He to IMG I lie to IMG I1 
He to IMG I1 Others 

Talk & Data Kits 
SCSI Cables 

Cooling Fan 
For Noise 

Apple IIGS *nted::ence 

SERIAL/PARALLEL CONVERTER 
Hc ................ $49.00 
GS ................ $59.00 

11+ OWNERS 
16K Card. ............. $36.95 
128K Card ............. $64.95 
80 Column Card ........ $49.95 
Plus Works ............ $49.00 

5 Year Warranty 
Prices subject to change without notice. 

SWITCH BOXES 
DIN 8 A/B ............ $24.95 
DIN 8 A/B/C/D ........ $29.95 
DB 25 A/B ............ $24.95 
DB 25 A/B/C/D ........ $34.95 
Parallel A/B ........... $24.95 
Parallel A/B/C/D ....... $34.95 

IMAGEWRITER I1 
32K Internal Buffer 

g!##@ 
SUPER SERIAL CARD 
100% Apple Compatible 

5 Year Warranty ........ $54.95 

Graphics Printer Card w/Cable 
For Apple 11+ & He 

VBA & MASTERCARD - NO EXTRA CHARGE DEALER 
Shipping Most Items $6.001 Drives $8.001 C.O.D. + $4.00 

(̂ aaf U E M O R Y  PLUS DISTRIBUTORS, 
7902 East Pierce Street 

We cany only the Scottsdale, Arizona 85257 9 a.m. to 4 p.m. 

Highest Quality products for (602) 820-8819 M.S.T. 
your Apple. Mon - Fri. 

That's why we are FAX# (602) 968-3211 university & School P.o. 
the LARGEST Serving Apple Users Since 1983 Accepted 

and Wh Restocking charge 
the BEST! CImla 248 on Reader Service Card. (MI returned items 

G S  Power Supply 
7 Amp 

He Keyboard 

- 
Replacement 7 Amp. Pwr. Supply 

11, 11+ & lie 
$60.00 $55.00 

Joystick for Apple He, He, 
Hc+ & IIGS 

With Fire Button 
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MUST BUY! 

FORGET I T  

WORTH A 
SECOND LOOK 

C R O S S C O U N T R Y  
C A L I F O R N I A  

Didatech Software 
4250 Dawson St. 
Suite 200  
Burnaby, BC V5C 4B1 
Canada 
1800) 665-0667, 1604) 299-4435 

new geography simulation 
128K Apple II 
color monitor recommended 
hard disk installable 
$77 

"California Dreaming" becomes reality 
as kids take t o  the highway in 
Didatech's new interactive geography 
simulation. Students work as truck 
drivers, delivering payloads of commodi- 
ties. Challengers determine the best 
routes t o  travel; the goal is t o  reach a 
target destination in the shortest time 
with the lowest expenses, while avoiding 
traffic violations and accidents. This 
fast-action simulation motivates young- 
sters t o  improve map skills as they 
learn the political, economic, and physi- 
cal geography of California. 

F O O D  F R I E N D S  
N U T R I T I O N  P R O G R A M  

CoNi Corporation 
5839 Abbott St. 
Fort Wayne, I N  46816 
(219) 447-2337 

new nutrition-education program 
64K Apple II 
$29.95 
$39.95 with Activitv Book 

If you still think of ketchup and relish as 
vegetables, take a look a t  Food Friends. 
Six game-style activities use colorful 
animated graphics and sound effects t o  
teach kids aged 4 t o  7 how t o  recognize 
the four basic food groups and plan 
balanced meals. Although you can't exit 
an activity in midstream or erase typing 
errors, Food Friends is both entertain- 
ing and informative. Note that  the 
program requires adult supervision, 
though, because it involves reading and 
constant disk swapping. An optional 
Activitv Book provides lesson plans and 

Â 
si~nn~cstinns fnr aririitinnal niirciiit-c 

F R E E D O M !  

MECC 
6160 Summit Drive North 
Minneapolis, M N  55430-4003 
(800) 685-MECC, (612) 569-1500 

new history simulation 
128K Apple I1 
$59 

I t 's  not easy teaching children about 
the horrors of slavery. MECC's new 
simulation of the Underground Railroad 
simplifies that  task by giving youngsters 
in grades 5 through 9 an electronic 
taste of what life was like for enslaved 
African Americans trying t o  escape t o  
freedom. The action takes place in 1830 
in the slave states of Delaware, Mary- 
land, and Virginia. Escaping slaves travel 
through hill country, mountains, and 
swampland, with game experiences 
based on historical fact. Players learn 
t o  follow the stars, forage for food, and 
survive by their wits. The goal of the 
simulation is t o  reach freedom before 
personal indicators (nourishment, 
stamina, health, and injury1 lead t o  
capture or death. Games include four 
levels of difficulty; those who succeed 
become Freedom Achievers in the 
program's hall of fame. Freedom! is an 
excellent simulation because it person- 
alizes the slavery experience in a way 
textbooks can't. 

G A T E  

Seven Hills Software1 
Big Red Computer Club 
423  Norfolk Ave. 
Norfolk, NE 6870" 
1402) 379-4680 

new adventure game 
1 MB Apple lies 
requires one 3.5" drive 
two disk drives recommended 
not hard-disk compatible. 
$30 

All work and no play makes for a very 
unhappy day. That's why computer 
games were invented - you can escape 
t o  faraway lands and distant times 
without ever leaving home. In Gate, 
each player becomes a warrior with a 
mission: Your goal is t o  escape from 
prison, find Darg the evil Firemaster, 
and beat him in a duel t o  the death, 
thus restoring peace t o  the troubled 
land of Divesia. As you travel through 
the castle, you collect special objects, 
n n  qnd pnnm, f r t m  sill t h r t e ~  

supplies you'll need. You'll encounter 
daunting obstacles, challenging puzzles, 
and any number of castle rooms you'll 
want t o  explore. But beware - 
health indicator hits zero, the g 
ends. Gate plays like Nintendo's 
of Zelda on steroids, with colorful 
animated graphics, lively music, and r 
istic sound effects. Not every progra 
has t o  be educational, but if you're a ,,% 

purist, take heart: You can boost yo 
foreign-language skills by playing Chi 
action-packed adventure game in 
French instead of English. 

G R A P H S ,  C H A R T S ,  
A N D  T A B L E S  
I N  T H E  S C I E N C E S  

Educational Activities, Inc. 

6 6  

students t o  read information from , .. . 
grams, then answer questions. 
(Graph data comes from life science, 
earthlspace science, and physical 
science.] In Part 3, students convert 
tables of values t o  bar, line, or circle 
graphs. All three activities provide 
immediate feedback, with questions 
tailored t o  student responses. Four 
reproducible print worksheets reinforce 
concepts. 

R E A D I N G  
S T R A T E G I E S  

Hartley Courseware, Inc. 
133 Bridge St. 
Dimondale, M I  48821 
(800) 247-1380, (517) 646-6458 

new reading-comprehension program 
128K Apple ll 
$69.95 single level 
$240 levels 2 through 5 
classroom pack 2 - 5 $1 89.95 each 

Activities in this package teach 
students (grades 2 t o  51 t o  read for 
details. The program emphasizes 
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location s t ra tegy  a technique t h a t  
nelps kids look for clues t h a t  answer 
~ ~ e s t i o n s  Students  read a high 
Â¥ceres non fiction s to ry  then answer 
- ~ l t i p l e  choice questions They receive 
. sual reinforcement for  cor rec t  
answers if readers answer incorrectly 
they can re tu rn  t o  t he  s tory  or  ask t he  
computer for  help Each Reading 
St ra teg ies  package contains t e n  
s tor ies  Readers learn t o  identify a 
s tory  s m o s t  impor tant  words look fo r  
t e x t  containing those words read 
ta rge t  words in sentence context  and 
determine whether a sentence w i th  
those words helps answer a question 
Activities are also suitable for youngsters 
who need remedial reading practice 

R O C K E T  F A C T O R Y  

MECC 
6 1 6 0  Summit Drive North 
Minneapolis, MN 5 5 4 3 0 - 4 0 0 3  
18001 685-MECC, 16121 5 6 9 - 1 5 0 0  

new physical-science package 
128K  Apple I1 
$59 

You don t have t o  be a rocket scient ist  
t o  build model rockets In th is  new two -  
pa r t  simulation f rom MECC children in 
grades 3 through 6 learn about force 
and motion a5 they const ruc t  and 
launch several types of rockets In 
Rocket Factory t he  f i r s t  act iv i ty young- - -- 

s t e r s  design a variety of rockets  t o  see 
how high their  machines can fly 
Experimenting w i th  different nose cones 
fins engines and payloads they deter  
mine how size shape and weight af fect  
f l ight pa t te rns  An on line char t  keeps 
t rack  of all launch data  In k d  
Chasers t he  program s second activity 
children use information learned in pa r t  
1 t o  const ruc t  a rocket t h a t  reaches a 
smoke-trail t a r g e t  Successful launches 
earn points high scores depend on the  
size of t h e  rocket s payload on impact 
Management options le t  teachers con- 
f igure t h e  program for  English or  met r ic  
measurements w i th  English or  Spanish 
t e x t  a well w r i t t en  manual provides 
bilingual instruct ions lesson plans and 
worksheets Rocket Factory is great  for  
teaching kids about controlled experi 
ments  and the  scientific method 

S T O R Y  T A I L O R :  
W H O  W I L L  H E L P  M E ?  

Humanities Software Inc. 
408 Columbia St . ,  Suite 2 2 2  
Hood River, OR 9 7 0 3 1  
18001 2 4 5 - 6 7 3 7  

new reading- and writing-skills program 
128K  Apple I1 
$99 

The Story  Tailor series f rom Humanities 
Software le ts  teachers personalize pop 
ular children's s tor ies  and poems by 
placing s tudent  names, school informa- 
t ion and o ther  individualized data into 
t h e  original t ex t .  A built-in word 
processor le ts  children add the i r  own 
words and ideas. A Draw Frame option 
automatically inser ts  blank screens 
for  s tudent  i l lustrations. Who Will 
Help Me7 comes wi th  a colorful pr int  
version of The L i t t le  Red Hen, which 
serves as a s to ry  s t a r t e r  for  six on-line 
activit ies, helping children in kinder- 
gar ten through grade 3 develop reading 
and process-wri t ing skills in an engaging, 
open-ended way 

Let us help you find 
Apple I1 Software 

Order Your Free Apple II Software Newsletter! 

You'll find more useful Apple I1 Software and Hardware in The Apple Catalog. 
Call 1-800-795-1000 En. 500 for a free copy. 

We're behind you and your Apple 11. 
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* * ^  
POOR G O L  

L 
ooking for the right Apple I1 software 
or hardware? Here's a quick summary 
of the more than 35 products we 
looked at in depth over the last year. In 

each category is the product name, the critical 
rating it received from the inCider/A+ reviewer, 
which Apple I1 computer(s) it runs on, its retail 
price, the publisher or manufacturer you can 
contact to purchase the product, a nutshell 
summary of the review, and the review's issue 
date and page number. Although the product 
version, price, and ordering information are up 
to date, we've indicated those cases in which we 
reviewed an earlier version of the product. 

APPLICATIONS 

DreamGrafix 1.06 ***I12 
IIGs, $99.95 plus $5 shipping. Dreamworld Software, P.O. Box 830, 
Iowa City, IA 52244-0830, (319) 338-6491 or (212) 853-6785.3200- 
color drawing program. Version 1.02: Proof that it's possible to push 
the envelope hard enough to stretch the seams. You can create and 
edit 3200-color pictures on your Apple IIGS - but just barely. 
(8192, p. 22) 

Hyperstudio 3.1 ***** 
IIGs, $179.95; version update from 2.1 or earlier, $45 plus $5 
shipping; update from version 3.0 free with returned disks. Roger 
Wagner Publishing, 1050 Pioneer Way, Suite P, El Cajon, CA 92020, 
orders: (800) 421-6526; tech. support: (619) 442-0522. Hypermedia 
authoring system. Version 3.0: Substantial update to already robust 
authoring system. Includes new menu-driven scripting language. 
(5192, p. 22) 

LogoEnsemble *Â¥* 
IIGs, $299. Logo Computer Systems Inc., 3300 CoteVertu Road, 
Suite 201, Montreal, Quebec H4R 2B7, Canada, (800) 321-LOGO. 
Logowriter combination pack: database manager, word processor, 
graphics system, communications package. (5192, p. 50) 

ProLine ***** 
Apple IIe/liGS, $259.95. Morgan Davis Group, 10079 Nuerto Lane, 
Rancho San Diego, CA 91977-7132, (619) 670-0563; fax: (619) 670- 
9643; BBS: (619) 670-5379. Apple bulletin-board program. 
Outstanding for wanna-be sysops with advanced messaging, 
electronic mail forwarding, and file-library options. (12192, p. 27) 

ProTerm 3.0 ****I12 
Apple He, $129.95. InSync Software, 3035 East Topaz Circle, 
Phoenix, AZ 85028-4423, (602) 992-5515; BBSIfax: (602) 992-9789. 
State-of-the-art telecommunications software with scripting 
capabilities. You can get there from here. (6192, p. 26) 

Your Money Matters *** 
HGS; $74 plus $5 shipping. Software Solutions, 5516 Merritt Circle, 
Edina, MN 55435, (612) 929-8947. Hornelsmall-business finance. 
Sophisticated financial package helps you prepare budgets, balance 
your checkbook, and track current versus last year's income and 
expenses. (1193, p. 48) 

EDUCATION 
Elementary School Grade Builder *** 
Apple 11, $29.95. Compton's New MediaDritannica Software, 2320 
Camino Via Roble, Carlsbad, CA 92009, (619) 929-2500. 
Designasaurus: dinosaur information; Math Maze: arithmetic skill 
builder; Spellicopter: arcade spelling game. (2192, p. 60) 

First Aid with Reddy *** 
Apple 11, $29.95. Quality Computers, 20200 East Nine Mile Road, 
St. Clair Shores, MI 48080, orders: (800) 443-6697; (313) 774-7200. 
First-aid education. Good information as far as it goes, but very 
young children should be supervised - several graphics depicting 
dangerous situations could be misinterpreted. (6192, p. 54) 

Gold of the Americas: The Conquest of the New World 1.0 **** 
IIGs, $49.95. Strategic Studies Group, 8348 Monticello Drive, 
Pensacola, FL 32514, (904) 494-9373; fax: (904) 494-9374. Historical 
simulation of New World colonial expansion. Not particularly 
accurate, but plenty of fun nonetheless. (6192, p. 30) 

GSymbolix 1.7 *** 
IIGs, $134. Bright Software, P.O. Box 18; 4153 Reinach 2, 
Switzerland, 061-71 1-23-83; fax: 061-71 1-52-63. In U.S.: Larry 
Schneider, P.O. Box 120, Exeter, ME 04435-0120, (207) 379-3181. 
Algebraic calculatorlgraphing software. Version 1.6: Remarkably 
powerful computing engine hampered by poor documentation and 
platform speed limitations. Not much use for teaching concepts - 
better at crunching numbers. (12192, p. 29) 

Jr. High School Grade Builder *** 
Apple 11, $29.95. Britannica Software, 345 Fourth Street, San 
Francisco, CA 94107, (415) 597-5555. Anatomy, grammar, 
geography programs. (2192, p. 61) 

Storybook Weaver: World of Adventure **** 
IIGs, $59. MECC, 6160 Summit Drive North, Minneapolis, MN 
55430-4003, (800) 685-6322, (612) 569-1500. Creative-writing tool 
with words and pictures. MECC supplies the pictures, the kids write 
about them, and it seems to work. (2192, p. 27) 

The Treehouse ***I12 
Apple 11, $49.95. Broderbund Software Inc., 500 Redwood Blvd., 
P.O. Box 612 1, Novato, CA 94948-612 1, orders: (800) 521-6263; 
(415) 382-4400; fax: (425) 382-4582. Music, math, and science 
games. Entertaining and mildly educational. The premise is a 
treehouse filled with games and animal friends. (10192, p. 52) 

Toolbox Programming in Pascal ***** 
IIGs, $75. The Byte Works, 4700 Irving Blvd. NW, Suite 207, 
Albuquerque, NM 871 14, (505) 898-8183. Pascal desktop- 
programming tutorial. Clear, well-written instruction with loads of 
examples. (1 1/92, p. 56) 

Where in America's Past Is Carmen Sandiego? ***** 
Apple 11, $49.95. Broderbund Software Inc., 500 Redwood 
Boulevard, P.O. Box 6121, Novato, CA 94948-6121, orders: (800) 
521-6263; (415) 382-4400; fax: (425) 382-4582. Educational 
adventure game, featuring detective motif and the infamous 
inscrutable villainess. This latest in the Carmen series is just as good 
as the previous ones - maybe better. (10192, p. 26) 

Weekly Reader Fractions and Decimals Math Word Problems *** 
Apple 11, $49.95. Optimum Resource Inc., 10 Station Place, Norfolk, 
CT 06058, (203) 542-5553. Drill-and-practice math program. Drill 
and kill from acknowledged leaders in the field. Weekly Reader 
manages to make an educational necessity bearable. (10192, p. 30) 
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GAMES 
Neurobics **** 
Apple 11, $46. Ocean Isle SoftwarelDLM Inc., 1 DLM Park, Allen, TX 
75002, (800) 527-5030, (214) 248-6300. Six brain-teasing puzzles for 
kids and adults. (2192, p. 62) 

Prince of Persia ***** 
Apple 11, $39.95. Broderbund Software, 500 Redwood Blvd., Novato, 
CA 94948-61 2 1, orders: (800) 52 1-6263; (4 15) 382-4400; fax: (425) 
382-4582. Animated action adventure. Smooth cinematic-style 
animation is the highlight of this charming swashbuckling epic. 
Can you save the princess? (8192, p. 25) 

Space Fox ***I12 
IIGs; $30. Seven Hills Software, 2310 Oxford Road, Tallahassee, FL 
32304-3930, orders & info.: (904) 575-0566; tech. support: (904) 576- 
9415; fax: (904) 575-2015. Arcade shoot-'em-up in space. Updated 
Defender - fun for veteran and novice space cadet alike. (1193, p. 24) 

The Secrets of Bharas ***I12 
IIGs, $69.95. Victory Software, P.O. Box 821381, Houston, 
TX 77282-1381, (713) 493-3232. Ultima-style game. 
Straightforward adventure for the adventuresome. If you liked 
Ultima, you'll probably enjoy this one. (7192, p. 28) 

UTILITIES 
DB Pix **** 
Apple 11, $25 plus $3 shipping. JEM Software, 7578 Lamar Court, 
Arvada, CO 80003, (303) 422-4856. AppleWorks 3.0 add-on utility. 
Add pictures to your AppleWorks databases with this extension. 
You'll be wondering how they did it. (9192, p. 50) 

Desktop Enhancer 2.01 ***I12 
IIGs, $24.95, $3 demo disk. Simplexity Software, 13045 Chapman 
Ave., Suite 302, Orange, CA 92668, (714) 283-3957. GSIOS and 
ProDOS 8 customization program. Version 2.0: Second-rate desktop 
jewelry might appeal to some. Take advantage of the demo-disk offer 
before you buy. (12192, p. 28) 

Express 1.1 **** 
HGS, $39.95. Seven Hills Software, 23 10 Oxford Road, Tallahassee, 
FL 32304-3930, orders & info.: (904) 575-0566; tech. support: (904) 
576-9415; fax: (904) 575-2015. GS/OS print spooler. Version 1.0: 
Solid, quality utility for the Apple IIGs. Spooled documents actually 
take longer to print, but the flexibility to print when you want can be 
a lifesaver. (9192, p. 20) 

Pointless 2.0 **** 112 
IIGs, $69.95. WestCode Software Inc., 15050 Avenue of Science, 
Suite 1 12, San Diego, CA 92128, (619) 487-9200; fax: (619) 487- 
9255. TrueType font utility. Version 1.0: Outline font capability on 
the Apple IIGs. Need we say more? (7192, p. 24) 

Signature GS *** 
IIGs, $29.95. Q LabsIQuality Computers, 20200 East Nine Mile Road, 
St. Clair Shores, MI 48080, (800) 443-6697; (313) 774-7200. GSIOS 
desktop-environment customization programs. Desktop jewelry for 
the Apple IIGs. Includes a screen saver and sounds to attach to Finder 
actions. (8192, p. 54) 

Total Control 2.1 ***I12 
Apple He, $60 plus $3 shipping. JEM Software, 7578 Lamar Court, 
Arvada, CO 80003, (303) 422-4856; fax: (303) 422-4856. AppleWorks 
3.0 add-on. Version 2.0: Enhanced control over your AppleWorks 
database fields and records. (4192, p. 50) 

COLLECTIONS 
Hyperstuff Collection *** 
IIG, $39.95 ClipArt Plus; $39.95 ClipTunes; $29.95 Animated 
Icons; $49.95 Soundconvert. Triad Venture Inc., P.O. Box 12201, 

Hauppauge, NY 1 1788, (516) 360-0797 or (516) 732-3771. 
HyperStudio tools, clip art, sounds, icons. Nifty hypermedia extras 
for spicing up your stacks. (7192, p. 55) 

Shoebox 1.1 ***I12 
IIGs, $59.95; version 1.0 update $8.50, $13.50 with Hypercard 
upgrade. Seven Hills Software, 2310 Oxford Road, Tallahassee, FL 
32304-3930, orders & info: (904) 575-0566; tech. support: (904) 576- 
9415; fax: (904) 575-2015. Hypercard IIGS stacks and extensions. 
Version 1 .O: Solid financial software for advanced and novice book- 
keepers. Slowed by Hypercard, but still worthwhile. (8192, p. 52) 

PUBLICATIONS 
A2-Central on Disk *** 
Apple 11, $90/year (12 issues). Resource Central , P.O. Box 11250, 
Overland Park, KS 66207, (913) 469-6502. Monthly Apple I1 
newsletter, shareware, and public-domain software included. Good 
software, good tips, spotty editorial quality. Great if you don't have a 
modem. (1 1/92, p. 24) 

Script-Central **Â¥**Â¥ 
IIGs, $48/year (6 issues). Resource Central, P.O. Box 11250, 
Overland Park, KS 66207, (913) 469-6502. Bimonthly Hypercard 
IIGS electronic publication. One of the best software products on any 
platform. Imaginative layout, useful content, tremendous 
entertainment. (1 1192, p. 25) 

Studio City ***I12 
Apple 11, $48/year (6 issues). Resource Central, P.O. Box 11250, 
Overland Park, KS 66207, (913) 469-6502. Bimonthly HyperStudio 
electronic publication. Promising young publication with a lot to 
offer. Early issues lacked maturity, but there's no getting by the 
quality content. (1 1/92, p. 27) 

Timeout-Central **I12 
Apple 11, $48/year (6 issues). Resource Central, P.O. Box 11250, 
Overland Park, KS 66207, (913) 469-6502. Bimonthly electronic 
publication on TimeOut products. Somewhat self-serving repository 
for good TimeOut macros. (1 1/92, p. 27) 

HARDWARE 
A-Hive Jr. **** 
IIGs; $499 with Apple high-speed SCSI card; $559 with RamFast 
SCSI; includes cables, two 21MB disks, one 1.44MB disk, one 720K 
disk. Tulin Technology, 2 156H O'Toole Avenue, San Jose, CA 95 13 1, 
(408) 432-9057. Floptical SCSI drive for Macintosh or Apple IIGs. 
Unlimited high-density storage for data-intensive applications. Not 
the fastest, but one of the least expensive. 
(9192, p. 22) 

InFocus 1600LC PC Viewer **** 
IIGs, $2695 1600LC color; $1695 1600GS monochrome. InFocus 
Systems, 7770 Southwest Mohawk Street, Tualatin, OR 97062, (800) 
327-7231; (503) 692-4968. 16-color LCD projection panel. 
Sometimes you just gotta see the big picture. The color and the 
monochrome displays are reasonably priced solutions to classroom or 
business presentations. (9192, p. 52) 

Tulin Optical Drive *** 
IIGs; $1319 includes one cartridge, $49 each additional cartridge. 
Tulin Technology, 2 156H O'Toole Avenue, San Jose, CA 95 13 1, 
(408) 432-9057. Rewritable, removable optical storage. Although 
much slower than a hard-disk drive, 120MB 3.5-inch optical 
cartridges provide unlimited, virtually indestructable data storage for 
power users. (1193, p. 49) 
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Expanding Your K GS-RAM 
RAMPak4 GS or GS RAM 11 

1 Meg SIMM ......................... $27.00 
RAMFast Cache RAM 1Meg 
Upgrade Set 2 441024-80 ....... $45.00 

PCT IB'M Ke board cable ..... $7 00 
MS DOS 5.0 Facka e .............. $59 00 
8087 Math ~o..808?.2 ............. $49.00 
3.5. 720K Ad-on Drive ........... $59.00 

II+. / / e  Power Su ply Exch $35 00 
I[+. / / e  P/S ... NO Exch ........... :$4i00 
Igs Power Supply Exch ........ $59.00 

IIzs Power Suvolv No Exch ..$7 9.00 
/7c ~eplacekent  Ext P/S .... $29.00 
/ /c  External Power Sup ly ..$3 9.00 
/ / e  or / / c  M/B W / E X C ~  ...... $89.00 
//e or / / c  Motherboard ....... $139.00 
/ /e  Ke board Exch ................ $45.00 
11+ ~ e ~ b o a r d  ........................... $29.00 
11+ Motherboard ..................... $49.00 
//e, / / c  . / lies Case $25./ .$3 5.00 

C-Itoh ProWrlter Jr (9 Pin) $89 00 
Imagewriter I ..................... $179 00 
ImageWnter I1 ........................ $259 00 
9 Pin Parallel Printer .............. $89 00 
ImageWr~ter I1 Sheetfeeder ... $89.00 

P r i n t  H e a d s  ............. 
IW-I (Exch Only .................... $35.00 
IW-Ll (Exch . Ord ) ................. $79.00 
Epson 9 Pin ~ e a d s  (Most) .... $59.00 

We rebuilt print heads 

Mousewrite 1.5.7 .................... $9.95 
Cop ][ Plus V.8.x ................... $14.95 
Pi-oIbs Users Disk & Man ... $1 5.00 
PartyQuiz (4 Player) .............. $19.95 

5.25" DSDD Disks 100 for ..... $16.00 
3.5" DSDD Disks 50 for ........ $17.50 
3.5" DSHD Disks 10 for ........ $8.50 

Zio GS 7Mhz /8K Cache .... $139.00 
Zip Chip 8 Mhz We. 11c) ....... $139.00 
Super Serial Card ................... $52.00 
IIeasy IW-II32K Buffer ........ $30.00 
20 Pin 5.25" Disk Cont ........... $39.00 
19 Pin 5.25" Disk Cont ........... $45.00 
I[+ 80 Column Card ............... $45.00 
Graphic Parallel Card ............ $45.00 
Text Parallel Card ................... $29 . 00 
AEC SCSI Card ....................... $59.00 
Bit Mouse / /e  Card ............... $49.00 
Bit Mouse / / e  w/Mouse ..... $69.00 
16KLan a eCard(][+) ...... $17.00 
No Slot 8 o c t  .......................... $23.00 

19 Pin  rive Converter .......... $14.00 
nes.e. c to Imae-eWriter I /  II ... $9.95 
~aser128  parallel Cable ........ $14.95 
Fullnet Connector ................. $14.95 

usR 1200 Modem oo A/B Switch Box ..................... $19.00 
SM1200 IReiurb) ..... $29 00 A/B/C or A/B/C/D ............ $29.00 

..... NEC 2400 Refurb External .... $59 00 SCSI Cable, 25-50 Or 50-50 $12.00 

Sumcom Party Quiz 
. Each Player has their 
ntroller with 4 button 
. Great fun! It's like 

ursuit only you can 
ke your own questions also! 
mes with Program Disk and 

one disk of questions . Add 
your own for more fun! For 
Apple //e. //c and IIgs! 5.25" 

Call for Chips Not Listed! 
/ / e  Related 
IOU/MMU 344-0010/0020 ..$2 9.00 
ROM 342-0303 or 0304 ........... $19.00 
ROM 322-0134 or 0135 ........... $9.00 
ROM 342-0133 or 0265 ........... $9.00 
Ke board ROM 342-0132 ...... $9.00 H/L 342-0170 ......................... $15.00 
KYBD Encoder AY3600PRO.$29.00 
6502 ........................................... $3.00 
65C02 ........................................ $7.00 

/ I c  Related 
IOU/MMU 344-OOll/OO2l ..$2 9.00 
ROM 344-0272 ......................... $9.00 
ROM (3.5" Drive) 344-0033 ... $29.00 
TMG or GLU ........................... $15.00 
65C02 ........................................ $7.00 
6551 ........................................... $3.00 
IWM 344-0041 ......................... $29.00 
Keyboard Ma 342 0132 ........ $9.00 
Keyboard ROM 342-00265 .... $9.00 

11 s Related v^bc 65C816-7 (Di ) .............. $49.00 
VGC 344S0046-C (fipgrade) $2 9.00 

11+ Related 
ROM Set (CO-F8) .................... .$2 9.00 
Other Chips ..$ 3.00 to $7.00 ... Call 

//e Drive & Monitor Stand ......... $9.95 
Apple lie Enhancement KitÃ‘Ã‘$49. 

.................... 16 Pin Joystick I[+. //e $9.95 
9 Pin Joystick. IIgs ........................... $12.95 
Mouse Pad (Static Free) d 2 . 9 5  
Koala Pad -. .. A 2 9 0 0  
Apple lie Card (Mac L O 2 9 . 0 0  

ALLTECH ELECTRONICS Co . 602 Garrison St . Oceanside, CA 92054 
9-6 PM Mon.Fri. 9-5 PM Sat 

With Purchase of a hard drive ... 
Add $99 for Ap le Hi h S eed or 

$159 for CV Tech k ~ & s t  ~ C S I  256K 
A le High S eed SCSI ............................. $104 . 
k X b ~ a s t  ~ ~ $ 2 5 6 ~  $169.00 / 1 Meg ...... $199 . 

.......... . SCSI Case. Power Supply & Cables $69 
3.5" Footprint Low Power SCSI Case ....... $49 . 

Sequential Systems 4096K ........................ $139 . 
.......... . MPD or GS Sauce 4 Meg with 1024K $77 

MPD or GS Sauce 4 with 2048K .......... $112 . 
MPD or GS Sauce 4 Meg with 4096K ......... $177 . 
CVTech Memory Board 4-8 Meg ............. Call . 

I[+. lie & llc Memory Expansion 
Extended 80 Column Card . . . . . . . . .  $25 . 
RAM-Z / / e  with 1024K ............................ $79 . 
SE //corSequential Systems //c l024K ........ $119 . 

5.25" Generic Full Height (Refurb) .......... $59 00 
....... 5.25" Generic Full Height w/19 Pin $69.00 

5.25" Apple Disk 11 (Refurb) add $10.00 for above . 
5.25" AMR HH (Mac LC. ROM 03 IIgs) ... $109.00 

....................... Apple DuoDisk 5.25 Exch $129.00 
Apple DuoDisk 5.25 (Refurb) .................. $159.00 
Apple UniDisk 3.5 (NEW) ........................ $159.00 
Apple 3.5" Drive (Refurb) .......................... $165.00 
Apple 3.5" Drive Service Exchange .......... $95.00 

A Residents please add 7 75% Sa CashICertified Funds Only Minimum Shipping & Handling Charges5 00 (This covers most orders) Some products are refurbished products and carry a 90 day 
ranty All Repairs are warranted for 90 days . Some RAM Chipsmay be 11 RAM has a one year warranty Â NO Returns without an R M A  number. 
Restockmg Fee is applied to all returns due to incompatibility or unneed r Please be sure what computer you have before 

AOC only Prices and availability subpct to change at  any time without a atsoever 'Discounts on certain merchandise only and mm Qty Applies 

Circle 103 on Ruder Senrin Can) . 



This old Classics getting a facelift: 
Apple's new Mac Color Classic will sport a 10-inch, 
256-color screen and an LC motherboard. 

MARCH 1993 ..................... 

News & New Products ... 30 

Reviews ......................... 34 

.................. 

I - ....... 
Mac Extracts 38 

The Holzbeg Report 40 



I N E W S  P R U J J U L T S  

IN WITH T P ~  

T he fashion buzz at Apple Computer 
this season is rainbow hues - black- 
and-white is out. Apple introduced 

a number of new productsin ~anuary and 
February, and the general theme seems to 
be color. Here's a sampling. 

rn The new Macintosh Color Classic 
sports a 10-inch screen with exactly the 
same number of color pixels (5 12 by 384) 
and color depth (256 at 8 bits) as the Mac 
LC's 12-inch screen. With added video 
RAM (VRAM), the new Classic can dis- 
play as many as 32,000 colors. The simi- 
larity between the Color Classic and the 
Mac LC isn't surprising: The Classic's 
motherboard is an LC 11. You can remove 
and expand it easily: Anything you can 
add to an LC you can now add to a Color 
Classic, including an Apple IIe Card or 
EtherNet Card. You can also increase the 
Color Classic's memory, like that of the 
LC 11, to 10 megabytes. Suggested retail 
price is $1300. 

Running at 25 megahertz and with a 
32-bit data bus, the Macintosh LC 111, 
also expected to cost around $1300, is 
faster than its predecessor, the LC I1 (16 
megahertz, 16-bit data bus), and supports 
more and larger color monitors without 
modification. You can also expand the 
LC I11 easily with a math coprocessor and 
a new type of memory card that increases 
its RAM to as much as 36 megabytes. 

1 computers and periph- 

erals is the Mac Color 

Classic, priced at 

$1300. With added 

rn video RAM, it can dis- 

play up to 32,000 hues. 

1 The new PowerBook 165c, with 256- 
color screen, uses a back-lit passive-matrix 
display for low power consumption (at 
some cost to quality). Its 33-megahertz 
68030 microprocessor runs as fast as the 
PowerBook 180. Reasonable for $3200. 

I Apple also announced a new line of three 
mid-priced, mid-performance computers, 
the Centris series. The Centris 610 
(around $2000) sports a fast 68040 proces- 
sor. The Macintosh IIvx (thought to be 
the last of the Mac Us, also around $2000) 
is slower with its 68030, but offers more 
expansion opportunities. If you want per- 
formance and expandability, you'll need 
the new Centris 650, with its faster 68040 
processor and the same expansion slots 
as the IIvx. All Centris computers include 
a built-in bay for an Apple CD-ROM drive. 

B The Apple Color Printer is priced at 
only $2600, competitive with the Hewlett- 
Packard PaintJet. It prints using color ink 

w 16 s easy co weace cuscom uesw I 
top icons. Just use from the 
menu or 86-C t o  copy the picture you 

want t o  the  clipboard. Then select the 
file or folder t o  which you want t o  add 
the icon, choose W Jnf.~ from the .E& 

menu or press 86-1, and click on the 
icon in the window. Then press 
8-V t o  paste the new icon in. 

jets in "large format," or 11-by-17 (A3) 
color printing. It isn't a network printer, 
but it does support Apple's new Gray- 
Share printer-sharing software, which lets 
more than one user on a network use a 
printer connected directly to a single com- 
puter. Apple's replacement for the Style- 
Writer ink-jet printer, the Stylewriter I1 
($360), also now uses Grayshare. The 
Stylewriter I1 is twice as fast as the origi- 
nal, and is a single piece combining a ver- 
satile sheet feeder with the printer body. 

a The Apple Color Onescanner, priced 
at $1500 to compete with Hewlett- 
Packard models in homes, schools, and 
small businesses, accurately reproduces 
color images on the Macintosh. It includes 
Ofoto 2.0, a color version of the original 
Apple Onescanner's software, which was 
noted for simplifying the process of 
creating digitized pictures. 

I Apple's new ColorSync software tech- 
nology lets scanners, digitizers, computers, 
monitors, and printers reproduce the 
same colors accurately. It's a transparent 
software standard, not unlike QuickDraw 
or Postscript, that operates automatically 
in the backaground. You'll never need to 
worry about it - but you may notice the 
difference it makes. In brief, ColorSync 
assigns a "color-use profile" to any 
device that uses color, and applications 
that support ColorSync choose colors 
based that profile. 

In other exciting - yet "colorless" - 
announcements, Apple spokespersons 
stressed that the new ergonomic Apple 
Adjustable Keyboard, which comes in 
only one hue ($219), isn't a response to 
the recent furor over repetitive-motion 
injuries, which some lawyers claim over- 
worked computer users suffer. The key- 
board splits into two halves to keep the 
typist's arms and wrists straight. The new 
Apple Desktop Mouse I1 sports a round, 
comfortable shape and a large single 
button that lets you click with more than 
one Finger. The ball is placed farther 
forward in the device for finer control. 

Brodie Keast, Apple's director of CPU 
product marketing, told us that Apple 
hopes to "further differentiate its product 
offerings," noting that "there's a price 
war going on among [IBM PC] clones, 
and you see less and less differentiation." 
The difference at Apple is differentiation. 
Apple will soon drop the monochrome 
Mac Classic, as well as its equally color- 
less twin, the Performa 200. Apple's only 
black-and-white products will then be 
t-shirts and PowerBooks. - P.S. 
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.... .... S p ~ t o l l  Parul&l Pro wlMK Buffer Ã‘ amn,.ÃˆMI 
Serial Pro ........................................................................... $89 

AE Disk Drives 
..................................................... Uml 3.5" 1.6MB (GS) $237 

3.5" BOOK (GS. He. Ilc+) .................................................. $189 
3.5" Controller Card (He, 1I+) ............................................ $65 
5.25" Disk Drive (all Apple ll's) ...................................... $149 
5.25" Controller Card He, II+) ........................................ $55 

KeyTronics 
ADB Keyboard (PCTIGS) ................................................. $139 

M a ~ ~ A n a l O g f l O l g i t a l  RGB Monitor 
(includes digital cable-He, GS) ........................... OVERSTOCK. 

We are currently 
overstocked on several 
memory boards, hard 
drives, accelerators, 
modems and many other 
items. Call us for details! 

M: 
m a c t o r  Zen K..., a9 
DdtflUnk 2400 ....... $139 
r ~ W ~ S . . , . " . S 2 W  

(limited-) 

mi Hover Blade GS ................................................... $32.50 
N#wl Secrets of Bharas GS ............................................ $39.95 
Tetris ............................................................................ $24.95 

Applied Engineering Upgrades 
Appleworks 3.0 Expander ........................................... $15.00 
New! Vulcan Gold-cache Upgrade ............................. ..$49.00 Applied Eneineertm 

GS-Ram Plus 1MB (GS) ................................................... $205 
@@id! Uat~Wwb iWzz-uw,:: .-.. ....-..=..- $175 
RamFactor 1MB (He, 1I+) ................................................. $264 
Ram Express I1 1MB Qlc, IIc+) ........................................ $205 
2-Ram Ultra 3 1MB with dock (Ilc) ................................ $299 

Memory C U ~ S  
1MB Chips (bank) ............................................................. $59 
256K Chips 0 ............................................................ $24 

Westcode 
....................................................... Nwl Pointless GS $49.95 

Ribtiom 
Value Pack (5 ribbons) ................................................. $14.50 
Value Pack (3 ribbons) ................................................. $16.50 

..................................... New! PC Transporter "~2.05 " $15.00 
............................................ Hew1 ProDOS Timepatch $15.00 

Ben k Bros. 
pfitinum paint .............................................................. $58.95 

$24.50 
$29.95 

.................................................... $36.50 

$35.00 

......... GS (Make your GS 2 112 times faster!) $219 
Transwan) GS w/32K Cache ........................................... $285 
TWGS 3 2 ~  Cache (Make your 

TransWa GS 22% faster!) .......................................... $79 
TransWarp&ig~naI accelerator for 11, Il+ and Ile) ........... $89 

UaiamiK-"tw OpS\mi.J ................................................ Ã ˆ l  

DL 2400 w/SendFAX! (GS) ............................................. $199 
DL/X 2400 wMNP-5 &FAX ......................................... $239 
Zoom Pack - includes MX2400, ReadyLink & Cable ... $129 

Claris 
Appleworks 3.0 .......................................................... $169.00 
Appleworks GS ........................................................... $199.00 

Glen Bredon 
Prosel 16v8.7 ............................................................... $74.95 

PC Globe 
GeoQuu GS, or Geo Puzzle IIe ..................................... $29.95 ........................................................... $77 

Timeblaster HO (GS, He. II+) ............................................ $79 
IIe/II+ Power Supply ..................................................... $59.95 
Parallel Pro ........................................................................ $77 

Seiko 
Watches Ole, IIc) .......................................................... $39.00 

Softspoken 
Cross-Works 2.0 .......................................................... $68.50 

Timeworks 
................................................... SMfMlt Publish It! 4 $89.95 

Call Today For a FREE Catalog, 
or to Place Your Order: 

ER CORNER - 
15-Day Monty Back Gvomitct on 
hardware returned in new condition. 
Sony, no refunds on rimers, 
monitors, CPUS or software. 
1n.Sliidi Saro Day Sh 
ordered kfore 6OOpm%%v%ys 
ship the same day. UPS and Federal 
Express Next Day Service available. 

Tkokuuuti<4NaKBnwl Y&% tever your needs, we cany 
To FAX Your O d y  Call 1-214-247-8151 

Tech Support/Custorner Service Call 1-21 4-484-546 
a full line of name brand systems, 

' 

hardware and software. 

Hours: Monday-Friday 9:00 AM to 6:00 PM CST. 
P.O. Box 815828 Dallas, Texas 75381 FAX (214) 247-8151 



NEW SOFTWARE 

I KNOW MY RIGHTS 
If you're a student wondering whether 

you have any legal rights at all - to 
privacy, freedom of speech, freedom of 
religion, or any other civil liberties -you 
can consult Express Yourself, a new 
interactive Hypercard stack from the 
American Civil Liberties Union of 
Northern California. 

Express Yourself explains students' 
constitutional rights in matters such as 
censorship, religion, music, dress, asso- 
ciation, and protest. It includes a history 
of civil liberties in the United States, as up 
to date as the rap of 2 Live Crew and 
Robert Mapplethorpe's photographs. 

Students and teachers can get Express 
Yourself at no charge from the ACLU of 
Northern California, other interested Mac 
users can send $10 to Howard A. Free- 
man, First Amendment Education Project, 
16663 Mission Street, Suite 460, San 
Francisco, CA 94 103. For more informa- 
tion, circle number 360 on the Reader 
Service card. 

The National Council of Teachers of 
Mathematics recommended recently that 
all levels of instruction include geometric 
transformations. The Geometric Golfer 
does that, and offers ten golf courses and 
a course designer to keep students enter- 
tained. Other features include a practice 
hole for exploring transformations, 
instant replay of shots, and management 
options to save games, control sound, and 
edit the "leader board." 

The Geometric Golfer, available for all 
Macintoshes, retails for $69, and includes 
two disks and a teacher's manual. For more 
information, contact MECC, 
6160 Summit Drive North, 
Minneapolis, MN 55430-4003, 
(612) 569-1500, or circle 
number 361 on the Reader 
Service card. 

OFF TO THE 
SOLAR SYSTEM 

Destination: Mars! is the 
name and the goal of a new 
educational game from Compu- 
Teach. players join a space- 
ship's crew, and by using an 
extensive database, a mission 

log, and a detailed map, 
plan their journey to the Red Planet. 

Along the way, you participate in 
a variety of 21 missions, including 
launching the spacecraft, solving 
on-board emergencies, performing 
Held experiments, docking with the 
space station or Mars Excursion 
Vehicle, and rescuing a satellite. A 
typical mission takes about half an 
hour to solve; Destination Mars! will 
provide hours of challenge for kids 
aged 11 and up. 

This innovative entertainment 
was produced in collaboration with 
NASA by Compu-Teach, 16541 

GEOMETRIC LINKS 1 ~ e d m o n d ' w a ~ ,  suite 1374,  Red- 
mond, WA 98052. (206) 885-0517. 

Tee off in the classroom with MECC's It's priced at $59.95. For more informa- 
The Geometric Golfer, an exciting game tion, circle number 362 on the Reader 
for one or two players, who use basic Service card. 
transformations - translation, reflection, 
rotation, and dilation -to change a ball 
so that it fits into the hole. In the corn- 1 MESSAGE TO THE STARS 
puter game, as in the real thing, the goal 1 In 1977 a Voyager spacecraft was 
is to put the ball into the hole in the fewest launched from Earth; on board was an 
number of steps. early compact disc designed to offer 

inhabitants of other worlds a elimnse of 
Before you give up when an 

application program "locks up," t r y  
the handy key combination 

Option-%-Escape. I t  may offer you 
the option t o  "Force [the application] 

t o  quit? Unsaved changes will be 
lost." (This may not work in a very bad 
crash.) If you force the application t o  

quit, you'll return t o  the Finder. 

" A 

ours - and of ourselves. Murmurs of 
Earth is a re-creation of that disc on 
Macintosh CD-ROM. 

The Voyager disc was created by a team 
of scientists, musicians, and artists under 
the direction of astronomer and writer 
Carl Sagan. The disc they produced is a 
substantial reflection of our varied 
cultures. You can hear musicians from 
Senegal, Zaire, Peru, Azerbaijan, China, 

and India, as well as Chuck Berry, Louis 
Armstrong, and Blind Willie Johnson. 
There's even a recording of whale songs, 
plus "Greetings from Earth" in 55 
languages. 

A number of beautiful color photo- 
graphs of our small planet are digitally 
encoded on the disc, and can also be seen 
in the accompanying book, also titled 
Murmurs of Earth, published by Random 
House, with an introduction by Carl 
Sagan and Ann Druyan. 

Murmurs of Earth is a moving testa- 
ment to humanity. It's available for $59.99 

from Warner New Media, 3500 Olive 
Avenue, Burbank, CA 91505, (800) 593- 
6334, and in computer and record stores 
nationwide. For more information, circle 
number 363 on the Reader Service card. 

JAPAN THROUGH 
THE LOOKING GLASS 

The newest CD-ROM from Cameo 
Interactive Japan is a sampling of the 
beautiful, puzzling, and sometimes 
erotic work of the renowned Japanese 
painter Kaneko. Alice is described as an 
"interactive museum": 12 virtual rooms, 
loosely based on Lewis Carroll's Alice 
stories, that you navigate with your 
Macintosh mouse. 

Each room is based on a different 
theme; the first room, for instance, is 
modeled on the artist's own living room. 
But in every room, switches are hidden 
in the walls, in the furniture, and on the 
shelves. If you find all the buttons, doors 
open, paintings move, and other bizarre 
events transpire. 

A deck of 53 playing cards, hidden 
throughout the rooms, provides dues that 
illuminate the whimsical universe of 
Kaneko and Carroll. 

This prize-winning "coffee-table soft- 
ware" from Japan costs $99 in the United 
States, from East~West Communications, 
163 1 Woods Drive, Los Angeles, CA 
90069, (800) 833-8339. For more infor- 
mation, circle number 364 on the Reader 
Service card. 
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I 
Edit Detail Options to developing areas, laying the 

groundwork for the housing, 

Take a seat in the cockpit of an F-16 
Fighting Falcon, power up, and you're off 
into the wild blue yonder with Falcon MC, 
a brand-new flight simulation for the Mac. 
It's based on the classic Falcon game, but 
now includes 3-D color graphics, a new 
world to do battle in, more missions, extra 
weapons, and additional kinds of play. 

Falcon MC offers strategic missions for 
the '90s: destroy nuclear power plants, 
disable air defenses, and take out armored 
ground units, to name only three. And 
to go up against adversaries in MiG-29s, 
the Falcon MC fighter jock will need all 
the most powerful new weapons, such as 
long-range, radar-guided, air-to-air AIM- 
120 missiles; unguided 2000-pound 
Mk84 and GBU-15 bombs; and short- 
and medium-range missiles. 

You can choose how hot the action gets 
with fully adjustable difficulty settings, 
but you'll have less control over your 
opponent if you do battle head to head 
via modem, network, or direct connec- 
tion. Falcon MC offers a choice of views 
and tracks your progress for you, award- 
ing ranks and medals to ace heroes. 

Falcon MC is priced at $69.95 from 
Spectrum HoloByte, 2490 Mariner Square 
Loop, Alameda, CA 94501, (510) 522- 
1164. Circle number 365 on the Reader 
Service card for more information. 

The latest "software toy" from Maxis, in 
the tradition of SimCity and SimLife, is 
A-Train, challenging players to erect the 
metropolis of your dreams 
from bare dirt, using a railroad 
as your city's link to the world 
and proving that clean, effi- 
cient public transit is possible 
and profitable. 

You start with building 
materials and cash - then buy 
land, lay track, put any of 19 
kinds of freight and passenger 
trains in place, and devise a 
schedule. The trains will I 

1 industrial, and recreational areas 
your city needs. 1 Your simulated trains puff 
around a simulated landscape that 
includes farms, trees, hills, and even 
livestock. Day and night, summer 
and winter repeat their cycles as 

J 
the game goes on. You can grow 
wealthy by speculating in stocks or 
real estate, developing your city as 
you choose. 

Maxis calls A-Train "the capital- 
ist's SimCity - the private-sector 

approach to urban development," 
combining city building with railroad man- 
agement and sophisticated financial mod- 
eling. A-Train is priced at $69.95, from 
Maxis Software, 2 Theatre Square, Suite 
230, Orinda, CA 94563-3346, (510) 254- 
9700. Circle number 366 on the Reader 
Service card for more information. - 

The ~~a r i sworks  Users Group 
(C*WUG) has made its popular, 
professionally written spreadsheet 
templates for preparing your 
federal income taxes available in 
Claris Works format. 

1040Works (also available for 
Appleworks) helps you collect and 
enter data, do all the necessary 
computations, and print the 
required tax forms. 1040Works is 
easy to use, prepares the 23 most 
widely used federal schedules and 

Ã§i$hhh . . . At AT&Ts Bell 
Laboratories in Murray Hill, New 

Jersey, researchers working with on 
line journals now have the pleasure o 

browsing the old-fashioned way, 
;hanks to  a powerful database manage 

called RightPages. The RightPages 
project duplicates the look and feel o 

a traditional library by allowing for 
'andom peeks into a rich mix of image 

and text, says a report in Science 
magazine (1 0131921. 

including shipping. It's priced separately 
at $29.95 plus a $3.50 shipping and 
handling fee. 

For more information, contact the 
ClarisWorks Users Group International, 
P.O. Box 701010, Plymouth, MI 48170, 
(313) 454-1969, or circle number 367 on 
the Reader Service card. 

6 File Edit Forms Tan Tools Wew Window '1 

forms, and includes complete documen- 
tation in a 64-page manual. 1040Works 
carries a suggested retail price of $39.95, 
but is available from C*WUG for $32.95 
plus $3.50 shipping and handling. 

C*WUG is also distributing the 1993 
1040Works Tax Planner, a comprehen- 
sive package that can estimate your 
federal income tax for 1993 to 1995, 
determine how the alternative minimum 
tax will affect you, calculate proper with- 
holding and quarterly tax payments, and 
compare financial strategies to minimize 
your federal tax bill - legally. 

If purchased with 1040Works, the 1993 
1040Works Tax Planner costs $19.95, 

transport people and supplies 

NO NEW TAXES 
If you don't even know what to ask 

about saving money on federal taxes, con- 
sider TaxCut. Unlike other tax-prepara- 
tion programs, TaxCut uses an "inter- 
view process," developed by leading tax 
attorney Daniel Caine. It asks a series of 
questions to determine relevant infor- 
mation about your personal tax situation. 

TaxCut then tailors additional questions, 
and, based on your responses, selects and 
completes all required forms automatically. 
TaxCut even checks your figures against 
national norms and can alert you to the 
possibility of an IRS audit by looking for 
inconsistencies and math errors. 

TaxCut lets you transfer information 
from any of a number of best-selling 
personal-finance programs, such as 
Managing Your Money (MECA) and 
Quicken (Intuit). It shows you more than 
1000 ways to save money by preparing 
your return differently and includes more 
than 85 schedules, forms, and worksheets. 

TaxCut is priced at $49.95, from 
MECA, 55 Walls Drive, Fairfield, CT 
06430, (800) 288-6322. For more infor- 
mation, circle number 368 on the Reader 
Service card. 
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Two new access-control programs protect your files from inquisitive eyes. 

w e all want the best for our kids, 
right? If you've got a home com- 
puter, sure, you'd like your child 

to experience the wonders of technology 
- particularly the ever-increasing array of 
educational programs for kids of all ages. 
There's just one problem: You don't want 
your 3-year-old or your 6-year-old or even 
your 15-year-old working on your 
machine if there's any chance you'll come 
home to find that while Junior was 
experimenting he eliminated that 40-page 
proposal you worked on all weekend. 

In response to this concern, two man- 
ufacturers have developed programs that 
let computer owners deny other users 
access to materials they deem off limits. 
From Edmark, a company specializing in 
educational software for children, comes or, if the program has been personalized, 

a picture representing the 
child alone with his or her 

KidDesk. It's designed to give kids aged 3 
to 10 something of their own to play with, 
leaving Mom's or Dad's work alone. 
Parents work in the program's "adult sec- 
tion" to customize the screen each child 
will see upon opening the "kids' section." 
At Ease, from Apple Computer, also limits 
an outsider's access to your computer, but 
it doesn't keep out just kids. This pro- 
gram can prevent any unauthorized 
person from accessing programs or 
documents you consider restricted. 

FUNANDGAMES 
The first thing kids see when they click 

on the KidDesk Start-up Folder is a screen 
with an blue-ribbon icon labeled Quest, 

name. By clicking on the pic- 
ture, your child sees one of the 
six desktop themes KidDesk 
offers -Victorian, circus style, 
and four others. Each desk 
displays nine accessories - 
name plate, picture frame, 
lamp, phone, pen and pencils, 
dock, calculator, recorder, and 
calendar - each matching the 
desktop's general theme. For 
example, the"circus" desktop 
features a phone that looks like 
a down and a lamo with a tent I 
shade and an eleihant base. 

Many of the accessories allow for fur- 
ther personalization. If your computer is 
equipped with a microphone, for instance, 

UDDESK 
Wmark Corporation 
6727 185th Avenue NE 
Redmond, WA 98073-3218 
18001 426856 
(206) 556-8400 

desktop interface 
Macintosh Plus or later 
System 6-0.7 or later 
requires 1 MB for mono- 
chrome, 2MB for color 
System 7 requires 2MB 
for monochro-me, 
4MB for color 
requires hard disk 
printer, microphone, 
Touch Window optional 
$39.95 home version 
$54.95 school version 

AT EASE 
Apple Computer 
20525 Mariani Avenue 
Cupertino, CA 95014 
(4081 996-1010 

desktop interface 
4MB Macintosh Plus or later 
requires System 7 
requires hard disk 
$58 
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the software's "recorder" lets you leave 
messages such as "Happy Birthday" or 
"Pickup your socks!" that play when you 
clickon the phone. 

You can enter the child's name on the 
name plate and insert any of a variety of 
images into the picture frame. Edmark 
provides icons (a butterfly and a dragon, 
for example), or you can import com- 
puter graphics or scan in images, such as 
a photo of your youngster's dog. Once 
you've entered a picture and a name, 
they appear on the opening screen men- 
. . .  

tioned above. 
The KidDesk manual offers excellent 

suggestions for using these accessories to 
further your child's learning experience. 
You might use the calculator to teach 
"skip counting," for example - count- 
ing in increments of three, perhaps, by 
adding 3 + 3 + 3+ 3, and so on. 

KidDesk doesn't restrict children to 
playing with the accessories on the desk- 
top, but it does offer a way for parents to 
limit kids' access to files. Working in the 
adult section, you decide which applica- 
tions - certain paint programs, games, 
math programs, and so on - you'll let 
your youngster access; you then put an 
icon for each of those programs on the 

when I booted the machine, I (or my 
child) could have simply ignored the 
KidDesk folder and tried any other 
application on screen. 

That's not the case with At Ease. Once 
installed, the At Ease screen appears 
automatically every time you turn on the 
computer. You can't access the main desk- 
top unless you know the password or the 
rules for circumventing this protection. 
Instead, you see what looks like a card- 
file divider labeled Applications. One 
application, Mouse Practice (designed for 
those who need experience in handling a 
mouse), is already installed; the rest you 
choose just as you do with KidDesk. If 
you install MacWrite 11, for instance, your 
kids or staff can access that application 
and create their own data files (which 
thereafter appear on another card labeled 
Documents), but can't get into MacWrite 
files you created previously. 

At Ease is also easier and faster to 
install. The documentation is clear, while 
some of the instructions in the KidDesk 
manual are fuzzy and misleading. For 
example, the manual describes the pur- 
pose of each accessory and points out the 
different styles each item comes in, but 
doesn't explain until somewhat further 

f FRO EQI  

At business, rasswo 1 1 access hides the main desktop 
and protects your files. 

desktop. The child clicks on an icon to 
enter a program directly; when it's time 
to quit, the child returns to his or her 
personalized desktop. The software also 
includes other options for limiting access 
to the main desktop, including password 
protection. 

YOUR EYES ONLY 
Because At Ease is designed for busi- 

ness as well as home use, there are no 
cute desktops or sound effects. From a 
child's point of view, KidDesk is more 
fun; if your primary concern is security, 
though, At Ease does a better job. 

When I booted my machine with 
KidDesk, I found a new folder on the 
main desktop, along with all my old 
folders; I clicked on KidDesk Start-up 
and called up the kids' desktop. But 
because all my other folders were open 

along that you can't mix accessory styles. 
It's a small point, but that lapse cost me a 
confusing 10 minutes or so of set-up time. 

You'll also need some optional equip- 
ment, such as a scanner and a sound- 
input device (if your Mac doesn't have a 
built-in mike), if you want to take full 
advantage of all of 
KidDesk's capabilities. 
On the other hand, 
note that KidDesk 
works under either 
System 6.0.7 or System 
7, while At Ease does 

1 
require System 7. If 
security's your main 
concern, though, and 

i 
you have System 7, 
At Ease may be the 
better bargain. 

Wendy Meyeroff 
Brooklyn, NY i l l  

* * * * 
Broderbund Software, Inc. 
500 Redwood Blvd. 
P.O. Box 6121 
Novato, CA 94948-61 21 
I41 51 382-4400 

interactive animated chil- 
dren's book on CD-ROM 
4MB Macintosh LC or higher 
requires System 6.0.7 or later 
requires 256-color monitor 
requires CD-ROM drive 
$59.95 catalogue price 

T he snappy opening refrain from 
Broderbund's Living Books series may 

soon become as familiar as Mr. Rogers' 
Beautiful Day in the Neighborhood. Its 
bouncy, upbeat melody makes kids sit up 
and take notice of their Macs. And, unlike 
television, which entertains by turning 
youngsters into couch potatoes, Broder- 
bund's Living Books invite children to 
take charge. There are colorful screens 
to explore, talking words, hidden sur- 
prises to discover, and new story charac- 
ters to meet. 

The latest CD-ROM title in this inter- 
active series is Marc Brown's popular 
Arthur's Teacher Trouble. It's the story of 
Arthur Aardvark, a personable third- 
grader with a "rat" for a teacher. Mr. 
Ratburn is so mean, he gives homework 
even on the first day of school. Arthur's 
troubles don't end with homework, 
though. He has a pesky 4-year-old sister 
named D.W., plus a 100-word spelling 
test and little time for study. 

But Arthur does well on the test - so 
well, in fact, that he gets to represent the 
third grade in the annual All-School 
Spellathon. He's under great pressure to 
succeed. You'll have to listen to the story 
on CD-ROM, or read the original print 
edition (included in the package), to find 
out whether he wins. 

ITS STORY TIME 
Like Broderbund's first Living Book - 

Mercer Mayor's Just Grandma and Me - 
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Arthur's Teacher Trouble is an electronic 
version of a widely known children's story. 
The computer edition contains 24 colorful 
pages with screen illustrations that faith- 
fully reproduce the drawings of the print 
version. In fact, the computerized pic- 
tures are better than their print counter- 
parts: sharper, brighter, and more finely 
detailed. 

But what distinguishes the electronic 
product most are its animated objects and 
characters, as well as sound and music. 
The program's high-quality graphics, 
animation, and sound effects, dramatized 
voice-over narration, and lively score 
are so well done, it's like watching a 
commercial-free cartoon special on TV. 

At start-up a main selection screen 
appears, in which an animated Arthur 
introduces the program and explains 
"play" options. Youngsters decide whether 
they want the written and spoken story 
language to be English or Spanish. 

They also choose the presentation 
mode. If they select Read to Me, they can 
sit back and relax while the story moves 
along page by page automatically. If they 
choose Let Me Play, they can explore each 
story page by pointing and clicking the 
mouse on interesting-looking objects or 
characters. Selecting an arrow at the 
bottom of a screen lets kids scroll forward 
or backward through the story. Clicking 
on the page-number icon returns read- 
ers to the main selection screen. 

Each of the electronic pages contains 
printed text, highlighted as the computer 
reads it. Youngsters can point and click 
the mouse on a specific word and hear it 
again, or switch between English and 
Spanish versions with a single keystroke. 
Three storybook screens feature animated 
words (40 in all), which children can 
review to strengthen spelling skills. 

Each story page is filled with a dozen 
hidden "hot spots" that respond with 
audiovisual rewards when you select them 
with the mouse in Let Me Play mode. On 
one page, for example, you can click on 
Mr. Ratburn's jacket to change its style 
and color. A doorknob might swing loose 
like a yo-yo. A student's book bag opens to 
reveal a surprise guest. A chocolate-chip 
cookie leads other cookies in a rousing 
song and dance. There's an explosion in 
the science lab, an enthusiastic food 
processor that bites off more than it can 
chew, an eager toaster, and much, much 
more. Kids won't let you pry them away 
from the computer until they're absolutely 
certain they've uncovered every possible 
surprise. 

FUN AND LEARNING 
Broderbund targets its Living Books 

mainly for the consumer market - 
parents with children aged 6 to 10. The 
program's graphical interface makes it 

so easy for youngsters to "play," that chil- 
dren need only minimal (if any) adult 
supervision. 

And Arthur's Teacher Trouble mostly 
entertains; it's not a curriculum-based 
product such as Davidson's Math Blaster 
or The Learning Company's Reader 
Rabbit. Yet it does have educational value. 
"If we make reading fun and interesting," 
says Marilyn Rosenbaum, Broderbund's 
director of educational marketing, 
"perhaps [kids] will read more on their 
own. Living Books allows kids to walk 
around inside the book. It gives [them] a 
sense of the power of their imagination." 

As Broderbund worked on the pro- 
gram, its developers visited several schools 
for feedback from teachers and students. 
The result is a highly polished product 
that teaches children to value reading 
skills. And because the program is bilin- 
gual, it's especially attractive to educators 
who teach English as a second language. 

HIGH MARKS FOR EFFORT 
Arthur's Teacher Trouble shows amaz- 

ing ingenuity. The voices of storybook 
characters are as individualized as their 
personalities, for example. Several 
animations are so hilarious, you'll find 
yourself laughing out loud (grown-ups 
included). Transitions from screen to 
screen are smooth: There's hardly any 
waiting time, even if you run the program 
from Apple's original CD SC drive (with a 
molasses-slow random-access time of 500 
milliseconds). 

Yet, while the electronic version of 
Arthur's Teacher Trouble can be a com- 
pelling reason to own a CD-ROM drive, it 
does have some limitations, all of which 
revolve around the program's reusability. 
Like the printed version, the story, once 
told, is done. 

And there's only one surprise under 
each of those hot spots. There are no 
open-ended, game-like activities with out- 
comes that depend on problem solving, 
strategy, or logical thinking. You can't 
build anything or draw a picture. 

How long can you expect a child to be 
entertained by a product that responds 
in exactly the same way every time? 
Children spend about two to four hours 
unattended with Arthur's Teacher 
Trouble. That's about five to ten minutes 
per screen for 24 story pages. Once they 
explore all the hidden buttons, there's 
really nothing else to do. 

Because the electronic version of 
Arthur's Teacher Trouble can be a baby- 
sitter substitute for television, the lack of 
human interaction limits a child's attention 
span. Adults reread good children's books 
to their kids countless times not because 
the story is so compelling, but because of 
the "quality time" spent together. The 
Living Books designers might increase 

the value of their storybooks dramatically 
by somehow encouraging family involve- 
ment with the products. 

Should you buy this CD despite its 
limitations? You bet. The software fea- 
tures so much painstaking attention to 
creative detail, it's easy to overlook its 
closed architecture. If your 256-color Mac 
has a CD-ROM drive, Arthur's Teacher 
Trouble will make you appreciate the 
wonders of mass storage and the value of 
having young kids. 

Carol S. Holzberg, Ph.D. 
Shutesbury, MA 

* * * 
Golden Triangle Computers 
4849 Ronson Court 
San Diego, CA 921 11-1 803 
(8001 326-1 858 
(6191 279-2100 
(6191 279-1069 fax 

file-compression utility 
requires Mac Plus or higher 
requires System 6.0.4 
or later 
requires SCSI hard disk, 
removable hard disk, 
or erasable optical disk 
$149 

I s a 40-megabyte hard drive with 20 
megabytes of data half full or half 

empty? Trust me, it's definitely half full, 
because one of the immutable laws of 
computing is that your files always 
expand to fill the amount of disk space 
available. 

To  a novice user, a common 40- 
megabyte hard-disk drive seems like a 
cavernous filing cabinet. But before you 
can say "QuickTime, multimedia, sound 
effects, and color graphics" three times 
fast, you'll be itching for a lot more 
storage space. 

And when you do, you can either ante 
up for a larger hard drive or eke out more 
space on your current one. Trashing or 
archiving old files and applications 
can help. But to stretch your drive's 
storage significantly, you need a file- 
compression utility. 
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Traditional "lossless" compression util- 
ities squeeze files to roughly half their 
original size by expressing data redun- 
dancies compactly. Companion decom- 
pression utilities faithfully reconstruct the 
original file. 

Manual file-compression utilities, such 
as Aladdin Systems' Stuffit, ask you to 
specify which files you want to compress; 
there are also automatic compression 
utilities, such as Fifth Generation's Auto- 
Doubler, which perform wholesale com- 
pression on your data files in the back- 
ground when your Mac is idle. 

One disadvantage of traditional com- 
pression utilities is that they alter com- 
pressed files' icons and creator types; 
another inconvenience is that you must 
decompress individual files before use. 
Both of these limitations can result in 
compatibility problems that may be too 
much for the novice or intermediate user. 

Golden Triangle attacks the problem 
of limited disk space on another flank 
with its new product, TimesTwo. Instead 
of shrinking files, TimesTwo appears 
to double the size of any SCSI (small- 
computer-systems interface) disk smaller 
than 1 gigabyte, including SyQuest and 
Bernoulli removable cartridges, as well 
as erasable optical disks. True enough, it 
transformed my test 40-megabyte TMS 
Shadow hard disk into an 80-megabyte 
drive- in under an hour. Is it magic? 

Not really. TimesTwo reformats your 
selected SCSI-based medium and creates 
a logical disk twice the size of the original. 
It also doubles the number of Macintosh 
File Manager storage blocks so that your 
applications "see" the apparently larger 
disk space. 

To make it all work, TimesTwo places 
a special driver between your Mac's File 
Manager and the disk's SCSI Manager to 
compress all files automatically as they're 
written to disk and decompress files as 
they're read from disk. It all happens in 
the background automatically, so Times- 
Two eliminates user interaction and 
greatly reduces compatibility problems. 

And because the TimesTwo special 
driver, like other low-level disk software, 
is stored on disk and loaded and executed 
when the SCSI device is initialized, a one- 
time installation is all you need. You can 
also move your "expanded medium to 
another Mac system. 

Suppose you want to give a copy of a 
file to a friend: Just drag it to a floppy 
disk. There's no need to decompress the 
file or give your friend an expander 
utility. Likewise, service bureaus don't 
needany special instructions for handling 
"enlarged" SyQuest cartridges. 

Once installed, you never know 
TirnesTwo is there because all your files 

work with your Mac's applications as 
though they're stored on a standard SCSI 
disk. The only obvious difference is that 
you have almost twice as much free space 
on that disk. 

Less obvious, however, is that your 
disk's increase in capacity comes at the 
expense of drive performance. On my 
Mac IIci test system running System 7.1, 
opening a 286K document with Microsoft 
Word 4.0 took 20 seconds before I 
installed TimesTwo; with TimesTwo the 
same operation took 40 seconds. Dupli- 
cating 1 11 items in a 642K folder took 
27 seconds without TimesTwo, and 54 
seconds with it. Not only does TimesTwo 
double the size of your disk, it also 
doubles the time required to read from 
and write to the disk. 

Golden Triangle also claims publicly 
that TimesTwo is compatible with all Mac 
applications, but then contradicts that 
statement in its documentation. For 
instance, you must remove any security 
programsthat restrict access t6an entire 
volume because they interact with the 
operating system at such a low level they 
may conflict with the TimesTwo driver. 

Nor can you currently install TimesTwo 
on QuickMail or Microsoft Mail servers, 
though the company promises this 
feature in a future release, as well as 
support for partitioned disks. 

You must also avoid installing new disk 
drivers or you'll destroy all your data. In 
addition, although you can use traditional 
compression and optimizer (defragmen- 
tation) utilities on a TimesTwo disk, you 
won't realize any space or performance 
benefits. 

PRESTO 

CONFLICT CATCHER 
AND OTHER 

INNOVATIVE UTILITIES 

Is TimesTwo worth its weight? That 
depends on your situation. If drive per- 
formance is at the top of your list, buy- 
ing a new drive to increase storage 
capacity is the way to go. You can get a 
new 40-megabyte hard disk, for instance, 
for about $200 through mail-order 
sources. (Larger capacities are even more 
economical, ranging from $4.50 down to 
$2 per megabyte.) 

If you're short of cash and can live with 
its current limitations, however, Times- 
Two is an elegant solution to the prob- 
lem of extending the usefulness of your 
existing storage devices. 

TimesTwo makes the most sense with 
removable storage devices used for back- 
up and archival purposes where speed 
really isn't an issue. For the cost of a 
couple of new SyQuest or  Bernoulli 
cartridges, TimesTwo can double the 
capacity of all your existing ones. 

Owen Linzmayer 
San Francisco, CA 

* *  
Casady 6 Greene 
22734 Portola Drive 
Salinas, CA 93908-1 1 19 
8001 359-4920 
(4081 484-9228 

utility set 
1 ME Macintosh Plus or higher 
requires System 6.0.5 
or later 
Memory Maxer 
requires System 7 
$79.95 *.....**........... b........,...... 

P ower users and other Mac aficionados 
who like to experiment with a variety 

of system accessories sometimes end up 
"short-circuiting" their machines' perfor- 
mance when some of those little extras 
clash. Now from Casady & Greene comes 
a new solution: Conflict Catcher, a control- 
panel program that can help you man- 
age Mac system add-ons by testing various 
combinations and resolving conflicts that 
might arise. To enhance the value of the 
package, Casady & Greene has also 
included four additional utilities: Color 
Coordinator, Memory Maxer, HotDA, 
and Whiz-Bang Window Accelerator. 
The question is: How many accessories 
do you need to make your computing life 
easier, and do you want to pay the price? 

LEAD ROLE 
The crown jewel of the package, 

Conflict Catcher, is a startup-file manager, 
handling INITs in System 6 or System 7, 
extensions in System 7, applications in 
the Startup folder in System 7, and dae- 
mons (similar to INITs) in System 7. 
Through Conflict Catcher, you can turn 
startup files on or off as your machine 
boots, configure sets of startup files, and 
link files that require each other to work 
properly. 

Conflict Catcher also lets you do trial- 
and-error checking to determine whether 
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R 
Drives, Drives, ........ 1 
tor Iigs. He, Mac, Laser 128 

incl. Apple Hi  Speed SCSI Oird 
and the NEW GSOS ver 6.0 
;I& S60 lor R;iinF;ist SCSI can1 I 

Half Shell -- the ~ ~ ; i r d  drive ttlii~ 
is W/< sm;illcr (him the floppy drive 

1.4"x5.5"x7.5" 
42MB(19ms) - $389 
85MB(17ms) - $449 
120MB(17ms) - $509 
170MB( 171ns'Ã - $559 I 
New & Exciting 

ADD to your Apple 11gs 
with your Apple SCSI card 
and share with your Mac: 

m m m m m m m m m m m m m m m  

Floptical Drive 21MB $395 
m m m m m m m m m m m m m m m  

TapeDrive 155MB $519 
m m m m m m m m m m m m m m m  

Optical Drive 120MB $1299 
m m m m m 8 m D D B m m m m m  

CD ROM Drive $469 

Tulin Technology 
2 156H O'Toole Ave. 
San Jose, CA 95 13 1 
Tel: 408-432-9057 

. Fax: 408-943-0782 

Circle 231 on Renter Service Card. 

two or more INITs conflict in operation 
or memory. Conflicts may simply cause 
erratic behavior, or they may prevent a 
machine from booting. When the result of 
a conflict is obvious, such as a crash 
during booting, it's easy to identify the 
problem with Conflict Catcher. Less- 
predictable problems are more difficult to 
identify, but that's not the utility's fault. 

Conflict Catcher does suffer from a 
couple of oddities, however. The pro- 
gram's Control Panel lets you view INITs 
by type or by the order in which they load; 
you can switch back and forth by clicking 
on a labeled button. When the button 
reads View by Type, it means you're viewing 
by order; when you click the display 
changes to view by type, but the button 
now reads View by Order. This trivial design 
flaw is irritating at first (although it's a com- 
mon convention among Mac applications). 

Also, temporary files that load before 
Conflict Catcher during system start-up 
are displayed in italics - but when I 
viewed INITs by the order in which they 
loaded, I found an italicized item in the 
middle of the list. Either the italicized 
item shouldn't have been italicized or 
Conflict Catcher displayed it in the wrong 
order. Casady & Greene's tech-support 
deparment didn't offer an explanation. 

Despite these quibbles, Conflict 
Catcher is a valuable utility, especially if 
you use a variety of extensions, INITs, 
or control-panel programs and like to 
add new ones often, or if your system 
crashes frequently. 

SUPPORTINGCAST 
The usefulness of the product's "other 

innovative utilities" depends largely on 
whether your needs match their solutions. 
For instance, Color Coordinator lets you 
assign a specific color mode to applica- 
tions, including the Finder. For example, 
you could run a word processor in black- 
and-white, a drawing program in 8-bit 
color, and an image-editing program in 
24-bit color. The rationale is that running 
an application in the least sophisticated 
color mode possible improves its perfor- 
mance. My logic, though, says that if you 
bought a color system, you want to use it. 

Memory Maxer lets applications grab 
all currently available RAM minus a user- 
definable reserve. For instance, if you 
reserve 500K and launch Adobe Photo- 
Shop while 6 megs of RAM are available, 
the application will be handed 5.5 rnegs, 
eliminating the need to adjust memory 
size manually from the Get Info box. You 
can assign "memory hunger" and RAM 
reserve individually to applications. 
Memory Maxer also lets you quit the 
Finder while running an application, free- 
ing about 300K of additional memory. 

Memory Maxer is convenient when 
additional RAM can significantly improve 

the performance of an application, such as 
a drawing or image-editing tool. Assigning 
most or all of the available memory to an 
application, however, means you'll give 
up the ability to start another application. 
If you consistently run several applica- 
tions simultaneously, this inherent trade- 
off may be a burdensome concession. 

Of all the utilities in the package, I 
found HotDA most helpful. HotDA lets 
you assign a keystroke sequence to open a 
desk accessory or another Apple menu 
item. I have several printers, for exam- 
ple, and often need to access the Chooser 
to select a different output device. With 
HotDA I was able to open the Chooser by 
pressing the shift and escape keys. 

Although HotDA can invoke only one 
accessory, you can duplicate the utility, 
rename it, define a different hot-key 
sequence, and assign the copy to another 
Apple menu item. For example, I've 
installed aliases in my Apple menu folder 
for frequently used applications. I 
assigned the HotDA copy to invoke the 
alias, which in turn starts up an application 
such as my database. The penalty for this 
convenience is 22K of system memory - 
an expensive way to create function keys. 

Finally, the package's Whiz-Bang 
Window Accelerator utility speeds up the 
Finder's window-zoom rectangles. Accord- 
ing to the documentation, it benefits faster 
Macs more than slower ones. The speed 
with which windows open and close has 
never bothered me, though, except on 
the slowest 68000-based Macs - Macs 
that Whiz-Bang probably won't help any- 
way. Even when running Whiz-Bang on 
my 68030-based Mac, it was hard to detect 
any improvement. 

I 
Installing Conflict Catcher and Other 

Innovative Utilities is smooth. The docu- 
mentation is a straightforward 33 pages, 
and the utilities generally function as 
described. I found the tech-support 
personnel friendly when I finally reached 
them, but phone messages left at the 
beginning of the day weren't returned, 
even the next day. 

Conflict Catcher is a great startup man- 
ager, and individually, the Innovative 
Utilities are potentially useful, but as a 
whole the package suffers from an identity 
crisis. Memory Maxer and Color Coord- 
inator attempt to squeeze added perfor- 
mance from strained machines; HotDA 
provides convenience for those with mem- 
ory to spare; and Whiz-Bang does less for 
slow Macs than for fast ones, which don't 
really need the assistance. 

Is it worth 80 bucks? In the words of 
Damon Wayan's Homey the Clown, "I 
don't think so." 

Barry D. Bowen 
Streamwood, IL 



ooking for the right Macintosh soft- 
ware or hardware? Here's a quick 
:summary of some of the 22-plus Mac 
products we looked at in depth over 

the last year. Although the product 
version, price, and ordering information 
are up to date, we've indicated those 
cases in which we reviewed an earlier 
version of the product. 

Applications 
Bank Street Writer *** 
$162.45; school, $129.95. Scholastic 
Software Inc., 2931 East McCarty Street, 
Jefferson City, MO 65102, orders: (800) 
541-55 13; (3 14) 636-527 1. Combination 
word processorldesktop publisher. Good 
for teaching youngsters, but too limited to 
be a serious WP solution. (7192, p. 54) 

The Miracle Piano 
Teaching System ****I12 
$4 19.95. The Software Toolworks, 60 
Leveroni Court, Novato, CA 94949, (415) 
883-3000. Piano-instruction program with 
MIDI keyboard. Revolutionary, but the 
miracle happens only if you can stick with 
the practice schedule. (12192, p. 24) 

Gold of the Americas **** 
$49.95. Strategic Studies Group, 8348 
Monticello Drive, Pensacola, FL 32514, 
(904) 494-9373; fax: (904) 494-9374. 
Historical simulation of New World colo- 
nial expansion. Not particularly accurate, 
but plenty of fun nonetheless. (6192, p. 30) 

Headline Harry *** 
$59.95. Davidson &Associates Inc., P.O. 
Box 2961, Torrance, CA 90509, (800) 
556-6141. U.S. history (1950 to 1990) and 
geography game. Good idea, but flawed 
execution. Features a few QuickTime 
movies - but too few. (1 1192, p. 54) 

Just Grandma and Me ***ID 
$49.95. Broderbund Software, 500 
Redwood Boulevard, Novato, CA 94948- 
61 2 1, (4 15) 382-4400. Interactive story 
on CD-ROM. Top-shelf electronic story- 
book for kids. Great graphics, great 
sound, engaging characters. (8192, p. 53) 

MacFrog 1.4 *** 
$35 blw; $39 color; site license $129 blw; 
$159 color. Intellimation, P.O. Box 1530, 
Santa Barbara, CA 9316-1530, (800) 3- 
INTELL, (805) 685-2100. Dissection sim- 
ulation. Won't replace the formaldehyde 
frog, but could be useful as introduction 
or post-operative refresher. (5192, p. 52) 

Spelunx and the Caves of Mr. Seudo **** 
$49.95. Broderbund Software, 500 Red- 
wood Boulevard, Novato, CA, 94948- 
612 1, (415) 382-4400. Non-competitive 
fantasy exploration for the young at heart. 
Hypercard based. (8192, p. 26) 

Stickybear's Reading Room ****I12 
$79.95. Optimum Resource Inc., 10 
Station Place, Norfolk, CT 06058, (800) 
327-1473. Bilingual reading-skills builder. 
Ever-lovable Stickybear helps children 
and adults find words, match words with 
pictures, and build sentences in English or 
Spanish.(l/93, p. 20) 

Super Solvers Outnumbered ***I12 
$59.95 consumer; $79.95 school (includes 
binder of classroom activities); lab $169.95. 
The Learning Company, 6493 Kaiser 
Drive, Fremont, CA 94555, (800) 852- 
2255. Math and problem-solving skill 
builder. Colorful and fun instruction for 
grade-school mathematicians. (4192, p. 54) 

Time Treks ** 
$59.95 consumer; $89.95 school. Davidson 
& Associates Inc., P.O. Box 2961, 
Torrance, CA 90509, (800) 556-6141. 
History game. Hypercard-based attempt 
at open-ended, discovery-based learning. 
Falls short in several categories, includ- 
ing historical accuracy. (10192, p. 28) 

Wordtris *** 
$49.95. Spectrum HoloByte, 2490 
Mariner Square Loop, Alameda, CA 
9450 1, orders: (800) 695-GAME; (5 10) 
522-3584. Arcade game: word spelling 
with falling letters. Not as addictive as the 
original. Success often depends more on 
luck than word acumen. (6192, p. 54) 

Games 
OIDS *** 
Mac, $44.95. FTL Games, 6160 Lusk 
Blvd., Suite C-102, San Diego, CA 92121, 
(619) 453-57 1 1. Space arcade game with 
editor. A combination of Asteroids, 
Defender, and a million other stand-up 
arcade games. OIDS has a large on-line 
following. (4192, p. 26) 

PGA Tour Golf *Â¥*Â¥ 
$59.95. Electronic Arts, 1450 Fashion 
Island Blvd., San Mateo, CA 94404, (415) 
57 1-7 17 1. Golf simulation. Fun and play- 
able, lets you feel like a pro. (4192, p. 26) 

Spectre **** 
$59.95 single-user edition, $99.95 three- 
user LAN pack. Velocity Development 
Corporation, 2 161 Union Street, San 
Francisco, CA 94123, (415) 776-8000.3D 
arcade battle game. Fast-paced action in 
an electronic world. Blast your buddies 
into cyberspace. (5192, p. 54) 

MacPalette II 2.2 **** 
$69; $249 AppleTalk version. Microspot, 
20421 Stevens Creek Boulevard, Cuper- 
tino, CA 95014, (800) 622-7568; (408) 
253-2000. Color printer driver. Essential 
for color printing on Imagewriter I1 from 
your color Mac. (1193, p. 22) 

Stack Enhancers ***I12 
$69 U.S., $79 Canada. Cheshire Grin 
Productions Ltd., 2145 Sherobee Road, 
Suite 43, Mississauga, ON L5A 3G8, 
Canada, (416) 896-8077. HyperCard 2.x- 
series add-on. Esoteric, but fun buttons, 
XCMDs, and scripts. (3192, p. 54) 

. - 

MacGlobe **** 
$49.95. Broderbund Software, 500 
Redwood Blvd., Novato, CA 94948-6 12 1, 
(415) 382-4400. Electronic atlas with maps 
and national data. You'll have the whole 
world in your hands with this product, 
even though the world keeps changing. 
(3192, p. 24) 

MacUSA **** 
$49.95. Broderbund Software, 500 
Redwood Blvd., Novato, CA 94948-61 2 1, 
(415) 382-4400. U.S. geography maps, 
charts, and information database. High 
information content and an easy inter- 
face make MacUSA both useful and just 
plain fun. (1 1/92, p. 58) 

USA Geograph **** 
$69. MECC, 6160 Summit Drive North, 
Minneapolis, MN 55430-4003, (800) 685- 
6322; (612) 569-1549. U.S. geography 
maps, charts, and information database. 
Just a shade below its competition, this 
product isn't quite as flexible, but holds its 
own in terms of depth and breadth of 
information. (1 1/92, p. 58) 

Deskwriter 550C **** 
$1099. Hewlett-Packard, 193 10 Prune- 
ridge Avenue, Cupertino, CA 95014, 
(800) 752-0900. Color ink-jet printer for 
Macintosh. Affordable, quality color 
output from an established name in 
printer technology. (3192, p. 25) 

lnFocus 1600LC PC Viewer **** 
$2695 1600LC color; $1695 1600GS 
monochrome. InFocus Systems, 7770 
Southwest Mohawk Street, Tualatin, OR 
97062, (800) 327-7231; (503) 692-4968. 
16-color LCD projection panel. Sometimes 
you just gotta see the big picture, right? 
These color and monochrome displays 
are reasonably priced solutions to either 
classroom or business presentations. (9192, 
p. 52) 
Tulin Optical Drive *** 
$13 19 includes one cartridge, $49 each 
additional cartridge. Tulin Technology, 
2156H O'Toole Avenue, San Jose, CA 
95131, (408) 432-9057. Rewritable, 
removable optical storage. Although 
much slower than a hard-disk drive, 
120MB 3.5-inch optical cartridges pro- 
vide unlimited, virtually indestructable 
data storage for power users. (1193, p. 49) 

March 1993 inCider/A+ 39 



1. Afield Trip to the 

40 inCider/A+ March 1993 



ftware includes a built-in spelling 

capability and supports P ~ C T  
as letterhead graphics. You'll 

d more than three dozen sample 
credit letters, leases, and so on), 

which you can use as small-business 
stationery templates. Many are set up for 
mail merge with contacts you enter in the 
application's address book. 

Expert Writer also includes 19 sample 
fax cover sheets, with original PICT-file 
artwork you ran edit. If you need a basic, 
low-cost word processor, this inexpensive 
DA sports several frills with minimal 
memory overhead (50K). 

4~ - 
Grolier Electronic Publishing 

$herman Turnpike 
 anb bury, CT 06816 
(8001 356-5590, (2031797-3500 

9 updated electronic encyclopedia 
on CD-ROM ',t ' , 
1 MB Ma(S5p4us1q$ ^\Qher 
MultiFindGr requires 2MB , 
requires System 6.0.5 or later 
QuickTime movies require - 
System 6.0.7 or later, , , 
4MB, color display, I 

68020 or faster CPU 
requires hard disk, 1 MB free space 
requires Mac-compatible 
CD-ROM drive 

Grolier's electronic reference on 
CD-ROM gets better with every release. 
The 1992 edition still includes the entire 
2 1 -volume Acodem1C American Encyclopedia 
on a single disc, but adds 7000 new or 
updated articles, 1000 new color and 
black-and-white illustrations, QuickTime 
animations and videos, and more than 
250 high-resolution color maps - plus 

. new speeches, high-quality sounds, 
animal vocalizations, and music clips. 

A Timeline lets researchers explore 
important historical events from prehis- 
toric times to the present. A Knowledge 

Tree index, structured around s i i  major 
topical "branches" (geography, history, 
Science. and so on\ nrnvides access to 

articles through a hierarchical list of 
topics and subtopics. For the price, this 
comprehensive desktop reference can't 
be beat. 

Spectrum HoloByte 
2490 Mariner Square Loop 
Alameda, CA 94501 
(5101 522-1 I64 customer support 
(8001 695-GAME orders 

new problem-solving game 
Mac Plus or higher 
requires System 6.0.5 or later 
requires 2MB Mac II for color 
color requires hard disk, 
256-color video card 
$49.95 

~ ~ ~ O O O O * ~ R ~ O ~ V ~ S W O O O ~ ~ O ~ ~ O O ~ O ~ ~  

Super Tetris blocks fall from new 
heights to amazing depths, as Russian 
melodies play faster and faster. The 
excitement is enough to drive you over 
the edge. Forget work; forget meals - 
when you take the Super Tetris challenge, 
you're always out to lunch. 

This latest Tetris variation plays out in 
a pit partially filled with water. Below the 
surface lie other blocks and bonus trea- 
sures. You must clear the pit by manipu- 
lating falling blocks to form solid lines. 
You have only a limited number of falling 
blocks at your disposal. 

Score points for each line you com- 
plete, then move on to more-difficult 
levels with every pit you empty. Tension 
mounts; your enthusiasm and blood pres- 
sure rise. 

With Super Tetris, Spectrum HoloByte 
scores another addictive chip off the old 
Tetris block. 

new geography program 
1 MB Mac Plus or higher 
requires System 6.0.5 or later 
$59.95 

So you haven't saved enough francs for 
a trip to the Left Bank or sufficient lire for 
La Dolce Vita on the Via Venuto . . . . 

Why not try Swamp Gas Visits Europe 
instead? It's an entertainintr rmnoranhv 

program that builds map-reading skills 
while strengthening your knowledge of 
Continental countries and capital cities. 

The programs casts you as a friendly 
extraterrestrial visitor; you must pilot your 
flying saucer to at least five or as many 
as 50 locations within a set time limit Up 
to four challengers can play in one round. 
Three levels of difficulty promise several 
hours of educational fun. 

Complete a mission (even if you're not 
successful) and you can visit the Alien 
Arcade, where you test your trigger finger 
playing one of three entertaining fast- 
action games - Fun@ Patrol, Androm- 
&ids, or Quasar Rain. Arcade activities 
don't reinforce the geography concepts; 
nevertheless, this program will motivate 
children to learn their facts and figures. 

The Tell-Tale Heart 

P.O. Box 45099 

(8001 567-4321. (41 61 

new electronic book on CD-ROM 
1 MB Mac Plus or higher 
requires 2MB for color 
System 7 requires 4MB for color 
requires hard disk 
requires Mac-compatible 
CD-ROM drive 
$59.95 
$89.95 with Teacher   and book 

Edgar Allen Poe's "The Tell-Tale 
Heart" is an amazing story of madness 
and murder. Written in the 1830s, this 
haunting first-person narrative takes 
readers on a chilling voyage into an 
insane mind. 

In the Discis CD-ROM version of this 
horrifying tale, you can listen to two 
dramatic readings, each featuring spine- 
tingling sound effects, colorful illustra- 
tions, and music. 

Words in the text are highlighted as 
the computer reads them. The disc also 
includes a series of follow-up questions 
and commentaries to help students 
understand the story and to stimulate 
classroom discussion. 

Customization options offer English or 
Spanish word pronunciations, definitions, 1 
on-line help, and information on parts 
of speech. An optional Teacher Handbook 
provides the full text of the story, addi- 
tional questions, and suggestions for 
supplemental activities. 

If "The Tell-Tale Heart" is on your 
reading list, this electronic book is an 
absolute must. 
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[hat's right: Apple's 
"other" computer can 
be your Apple 11's 
portable in the field, 
a telecommunications 
unit, a quality desk- 
top-publishing cen- 
ter, a number crunch- 

er, a file server. That's because 
Apple 11s and Macs are much 
more similar than most people 
realize - they can work quite 
effectively together, comple- 
meriting each other's abilities. 

Macintoshes make great 
helpers for Apple Us. A light- 
weight Mac can go on the road 



Apple 11s and Macs can work 
complementing each other's 
Shown left to  right: Powerbo 
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when a heavier Apple I1 can't. And even are hard to find, and many of the IIc's 
if Apple won't encourage development important accessories (such as a 
of new kinds of peripherals for the modem) are external. That's way too 
Apple 11, you can still use the latest much to lug around. 
hardware - on a 
Mac connected to a 
11. You can also use 
Apple I1 data with 
all kinds of soft- 
ware unique to the 
Macintosh, includ- 
ing the very best 
desktop-publishing 
applications. 

A Macintosh can 
pick up the pace of 
intensive work with 
spreadsheets and 
graphics, too - but 
if you're just look- 
ing for the basics, 
remember that you 

The Mac PowerBook 100, with built-in text 
processing, can write to PmDOS disks. 

don't need the biggest or newest system 
to take advantage of Mac power for your 
Apple 11. Some great bargains are avail- 
able in the used-Mac market, too. 

Is it really practical to use two differ- 
ent types of computers with two differ- 
ent operating systems and completely 
different programs? Sure - why not? 
There's no reason you can't learn how 
to maneuver through two word-process- 
ing programs, or graphics packages, or 
database managers, and no reason you 
shouldn't use both - because each has 
its own advantages. 

It's easy to find similar programs for 
both platforms, too. For example, if you 
use Appleworks on the 11, ClarisWorks, 
Beagleworks, and Microsoft Works 
offer modules with similar functions. 
You can use the I1 whenever it's more 
efficient and the Mac whenever it's bet- 
ter adapted for a particular task. You 
can transfer files between the two com- 
puters without losing any information. 

THE PORTABLE APPLE I1 
The Apple IIc was Apple's first 

attempt to make a portable computer - 
but the machine didn't succeed in that 
niche. While the IIc makes an excellent 
desktop computer, it's impractical as a 
portable. Its liquid-crystal screen is low- 
contrast and difficult to read, its power 
supply is heavy, its 12-volt power cords 

On the other 
hand, a Macintosh 
PowerBook is 
lightweight and 
includes a read- 
able display, an 
internal battery, 
and the ability to 
use an internal 
modem. You'll 
find a number of 
low-cost MS-DOS 
laptops and note- 
books on the mar- 
ket, but a port- 
able Mac can read 
and write ProDOS 
disks directly. 

Remember that you don't need the 
fastest PowerBook with the sharpest 
color and screen resolution if you simply 
want to take notes in the field: Apple's 
PowerBook 100 was considered a failure 
because it was slow and difficult to 
expand, with poor screen resolution. 
But PowerBook 100s are now a bargain 
on the used-computer market, often 
available for less than $1000. You don't 
even need to pay extra for a Mac word 
processor - you can take notes and 
save text files with Apple's free 
TeachText application. It's far from 
full-powered, but you can type in text, 
as well as cut, copy, and paste it. (You 
won't need to wonder how styles, fonts, 
and sizes will make the transition to 
your Apple 11, becuse TeachText 
doesn't offer any.) 

DOUBLE YOUR HARDWARE 
One of the biggest complaints for I1 

owners is lack of new accessories. Many 
"Mac" devices, however - including 
many products from Apple Computer 
- can connect to a I1 directly without 
any problem (the LaserWriter LS, the 
Apple Onescanner, and various 
Hewlett-Packard printer models, to 
name just three examples), but can't 
work with a I1 out of the box because no 
driver software is available for the 11. A 
few third-party companies have pro- 

duced drivers - such as Vitesse7s 
Harmonic and Seven Hills Software's 
Independence for the GS - that make 
SCSI and serial products from other 
companies compatible with' Apple Its. 
When no driver is available, though,? 
one solution is to hook up the device to 
a Macintosh and use that Macintosh as a' 
hardware interface. 

For example, you can write letters on 
your I1 and then transfer them to the 
Mac to print on a LaserWriter or an HP, 
Deskwriter, or send copy over a fax 
modem. Many Macintosh fax modems* 
- such as the innovative Powerport 
series, which uses the Apple Desktop 
Bus (ADB) to connect to the Mac - can 
receive faxes as well as send them. A. 
Mac with a fax modem can wait all day 
and night for incoming material, with- 
out tying up your main computer. 

You may prefer to scan pages of text 
into a Mac and choose from among the 
many optical character-recognition 
(OCR) software packages available for 
the machine. (Westcode's InWords 
brings OCR technology to the Apple 
IIGs, but Mac software such as Caere's 
Omnipage is faster and more accurate.) 
It's then a simple matter to use your 
Mac word processor to either save the 
text as an ASCII text file or use the 
Mac's built-in Apple File Exchange 
utility to save it as ProDOS text. 

If you use a word processor such as 
MacWrite I1 that incorporates Claris' 
XTND (Extend) software technology, 
and an Apple IIGS with System 6's HFS 
file-system translator, which can read the 
Mac's hierarchical file structure, you can 
even save text files directly as Apple- 
Works documents. (See the accompany- 
ing sidebar, "Exchanging Disks and 
Files," for details.) 

You can input photos with a Mac- 
intosh scanner, too, and save them in II- 
compatible graphics modes. Graphzcs- 
interchange format (GIF) is the easiest to 
use. After you save a Mac image as a 
GIF file, Seven Hills Software's Super- 
Convert can transform it into an 
Apple I1 format, as can Roger Wagner 
Publishing's Graphics Exchange. 

While drivers are available to connect 
CD-ROM (compact-disc read-only memory) 
units to Apple lies and Hoses, few of the 
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Remarkable Technologies announces a 
breakthrough product which now 
delivers AppleWorks power on an IBM 
PC or compatible. SuperWorks lets 
AppleWorks users step up to a PC with 
AppleWorks files, utilizing an Apple- 
Works work-alike Integrated package. 

New features provide full & complete 
integration of all capabilities including; 
spreadsheet (3-D capability), database 
(the easiest to use and one of the most 
powerful anywhere), word processing 
with spell checker, improved commu- 
nications package, new and improved 
graphics, new SWAT macros, the best in 
the industry and much more. 

SuperWorks uses only 180K on 
diskette and it's the only integrated 
package developed for the notebook. 

As a special introductory offer to 
incider readers, SuperWorks is now 
available at the special low price of 
$1 99.00. SuperWorks has a regular retail 
price of $488=60. 
N ENTIRE PROGRAM USES ONLY l8OK ON DISm 
Â ONLY INTEGRATED PACKAGE FOR NOTEBOOKS 
30 OBV MONEY &CK OUARANTEE 

-- 

. .  introductory offer lMaS3 

QPI~OM send nw SuperWoiks tor only $199.00 (phis $5.00 S&H). g,&oE;r;;; / 

CARD NUMBER 

1 SIGNATURE 
W E  
OMPANY 
DDRESS 
ITY 
ITATE - ZIP 
f l a i W  Remarkable Technologies, 245 Pe!laSUS A""., 

Dent. IM393, Northvale, New Jersey 07647-9971 
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Exchanging Disks and Files 

pple 11s and Macs may speak in 
different tongues, but with the 
right translators, they can 
exchange disks and data files 

+%edify. Today you can plug ProDOS- 
[including GSIOS-I formatted disks 
into your Mac, or HFS (hierarchical 
&structure - Mac format1 disks 
into your Itas, and have no-fuss 
access t o  all your stored files. And 
MacIApple 11-swapped files can retain 
text- and other specially formatted 
information that  was often lost with 
earlier translator systems, such as 
common ASCII text files. 

For disks, both System 6 for the 
HGS and System 7 for the Mac contain 
special software extensions, known 
as FSTs [file-svstem translators), 
which recognize ProDOS and Mac disk 
formats automatically. With an FST 
installed in your Svstem folder, you 
can put a 3.5-inch floppy created on 
your lies into your Mac, and vice 
versa, and read and write data files 
without running any special utilities. 
Because ProDOS doesn't have FSTs, 
though, you can't put Mac disks 
directly into any II except the GS. 

To share files between your Mac and 
Apple II - particularly if you need t o  
retain text formatting and other 
special, application-specific informa- 
tion -you need Claris' tech- 
nology. I t 's  a "universal" file-transla- 
tion system found bundled with many 
of Claris' Mac products, such as 
ClarisWorks. XTND is also licensed by 
other Mac application manufacturers. 

XTND is installed in a special Claris 
folder within the Mac's Svstern 7 
Extensions directory, along with a 
variety of file-format translators. Mac 
applications then use XTND and the 
appropriate translator t o  load and 
save other applications' file formats, 
thereby preserving many of the 
original file's special characteristics. 

Together with disk-sharing FSTs, 
for example, you might create an 
AppleWorks GS spreadsheet, save it 
on a ProDOS disk, then put that  disk 
into your Mac and load the file directly 
into ClarisWorks. All of the disk and 
file-format translations occur trans- 
parently, so i t 's as if you had originally 
created that  AppleWorks spread- 
sheet on a Mac with ClarisWorks. 

Unfortunately, there isn't any XTND 
utility for the Apple II, including the 
HGS, so you can't load a ClarisWorks 
document, for example, directly into 
AppleWorks. You must f irst load that  
document into ClarisWorks on a Mac 
and use XTND t o  save the document 
as an AppleWorks file on a ProDOS 
disk before you can load it into your 
Apple lie. 

You can save that  same ClarisWorks 
document as an AppleWorks file on a 
Mac HFS disk if you'll load it later into 
your lies, because your GS' System 6 
FST can recognize Mac disks. 

Claris supplies XTND word-process- 
ing file translators for MacWrite, 
Microsoft Word, AppleWorks, 
AppleWorks GS, Write Now, Word 
Perfect, and Wordstar, among other 
popular text formats. 

Likewise, XTND drivers are available 
for several graphics formats, spread- 
sheets, and simple file-card databases 
[such as AppleWorks' database). 

There are many different types of 
XTND translators from different 
sources - of differing quality. One 
publisher's XTND translator may 
translate only other file formats into 
i ts  own, without the ability t o  reverse 
the process and write files back into 
other formats. 

Or, while some XTND drivers trans- 
fer all of a document's special forrnat- 
ting commands, others may transfer 
only limited functions. 

titles available on disc work with Apple 
11s. For instance, many great works of 
literature, such as the plays of Shake- 
speare, are available on CD, but you 
need Macintosh software to search 
through the text for the data you want. 
If you use a Mac to retrieve the data, 
however, you can then transfer it to your 
Apple 11. 

Similarly, no CD-ROM encyclopedia 
is sold for the Apple 11, but you can use 
Macintosh multimedia versions of either 
Grolier or Compton's to "download" 
the text or pictures you want, then 
convert them to Apple I1 formats as 
outlined above. You may also be able to 
convert many stock photographs avail- 
able on Macintosh CDs in this way. 

SOFTWARE CHOICES 

The flip side of using the Mac as a 
hardware server is to use it in cases 
where a particular type of software is 
available for the Apple 11, but better, or 
easier-to-use, versions are available for 
the Macintosh. 

For example, the Mac edition of the 
popular commercial information service 
America Online, like many other 
menu-oriented programs, sports a 
better interface than the I1 version's. A 
Mac with a modem can download Apple 
I1 programs, which you can then trans- 
fer from Mac to ProDOS disks. (On the 
other hand, if you favor a text-based 
on-line service such as GEnie or  
CompuServe, you'll find that your 
Apple I1 meets your needs.) 

AppleLink, Apple's internal telecom- 
munications service (now open to the 
public), cries even more loudly for a 
Macintosh. It's all but impossible to 
navigate through AppleLink's inter- 
national messages and thousands of files 
of Apple information in any other 
manner than by "pointing and clicking." 

It's also handy to be able to use a 
low-cost Macintosh as a "dedicated" 
telecommunications machine: a com- 
puter that's turned on and connected to 
your modem all day long. 

If you've devoted a Macintosh to on- 
line duty, you can work at your Apple I1 
while you download files to a shared 
hard drive, where you can pick them up 
later. You can set up a Mac with an all- - - 
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purpose telecommunications program, 
such as Freesoft's White Knight, to 
receive text files from any remote 
computer. 

If you're interested in music, you'll 
find your Apple IIGS a high-quality 
synthesizer - but a lack of professional 
MIDI software for the GS may frustrate 
you. Make a Macintosh your MIDI 
connection instead. You can create 
MIDI files on your GS - that's called 
'sequencing" in the computer musi- 
cian's jargon - and use software such as 
Paul James' freeware Sound Studio or 
Ian Schmidt's $10 shareware program 
AudioZap to convert them to Macintosh 
format. Once your MIDI files are on the 
Mac, you can use scoring software to 
create sheet music, and all kinds of edit- 
ing and composition software to manip- 
ulate your sounds into music. 

Macintosh presentation software 
designed to show a series of slides to a 
large audience is also more sophisticated 
than similar Apple I1 software. You can 
convert your text and graphics to Mac 

format and use standard presentation 
software such as MacroMind Director 
(Macromedia), Powerpoint (Microsoft) 
or Persuasion (Aldus) to create a slide 
show that will run on almost any Mac. 

Another type of program that may be 
easier to use on a Macintosh is a 
spelling or  grammar checker. For 
instance, the spellers built into 
AppleWorks GS and ClarisWorks are 
similar, but ClarisWorks' corrects your 
orthography much faster. Mac spell 
checkers and style or grammar checkers 
really benefit from the Mac's faster 
processing speed. 

FANCY-DRESS MAC 

You'll find a number of excellent 
page-layout utilities for the 11, including 
Publish It! and AppleWorks GS. And if 
you have a Postscript printer you can 
create high-quality images directly from 
the Apple 11. 

When you want still higher-quality 
desktop-publishing results or fancy 
output beyond the capabilities of stan- 

dard 11-compatible programs, though, 
consider using a Mac layout program to 
design dressed-up output for presenta- 
tions, proposals, and resumes. 

Desktop-publishing programs that are 
available in both Apple I1 and Mac- 
intosh versions, such as Publish It! 
(Timeworks) and The Writing Center/ 
The Childrens' Writing and Publish- 
ing Center (The Learning Company), 
include translators that make it a simple 
matter to create your newsletter on an 
Apple I1 and print it from the Mac. 

Macintosh desktop publishing also 
has a distinct advantage when you 
don't own a laser printer. Many service 
bureaus and copy shops now offer laser- 
printing service: The shop simply takes 
your Postscript files and prints them for 
a small fee. But these shops usually have 
Macs and PCs and expect that your files 
will be in one of those formats. 

MAKE THE MAC COUNT 

For the most part, all computers share 
a similar architecture - they include a 
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microprocessor, memory, and a display. The  development of some simple 
There's no doubt that the Mac's 32-bit drivers and hardware devices and - 
68000-family processor is much more most importantly - a change in manu- 
powerful than the Apple 11's 8-bit 6502. facturers' attitudes could make these 
But you don't need a super-powerful computers much easier to use with each 
computer for simple word processing or other. If a company releases a product 
other character manipulation; in almost that interfaces the Mac to some hard- 
all cases, the system uses most of the ware device, why not a offer I1 driver as 
Mac processor's power to draw fancy well - or at least enough documenta- 
displays and make programs more "user tion to permit a third-party company to 
friendly." Still, there are cases 
where the Mac's processor 
does make a difference. 

It's obvious that spread- 
sheets, for example, do heavy 
number crunching, and it may 
be faster in some cases to con- 
vert an AppleWorks or  
AppleWorks GS spreadsheet, 
for example, to a Macintosh 
format before a major recalcu- 
lation, so that you can use the 
Mac's powerful processor to do 
the dirty work. That's especial- 
ly true if you have a Mac with a 
special mathematics processor 
called a floating-point unit 
(FPU). The Mac SE130 has one, 
a Motorola 68882, as do most 
of the more-powerful Macs. 
The FPU is optional with the 
Mac LC and PowerBooks. 

In some cases you may want Mac LC logic board; l ie Card installed, top left. 
to start with the Mac and trans- 
fer the results to your 11. For example, 
I've used Mac orbital-dynamics pro- 
grams to calculate the predicted loca- 
tions of artificial satellites, and saved the 
results in a text file. Transferring the 
file to a ProDOS disk, I've then used the 
data as input for an Applesoft BASIC 
program that manipulates the results. 

It's less obvious how much mathe- 
matics is involved in the creation and 
manipulation of computer graphics. If 
you often need to change the colors in a 
digitized photograph or otherwise 
"touch it up," for example, you might 
consider doing the job on a Macintosh, 
using a program such as Adobe's Photo- 
Shop, even if the original art  was 
created on an Apple 11. 

WISH LIST 
While it's possible to use Macs and 11s 

together, it's not as simple as it could be. 

develop a driver? It's important to note 
that a number of universities, govern- 
ment agencies, and schools still 
purchase Apple lies, IIcs, and I I ~ s e s  
because they have established networks 
of 11s and extensive I1 product libraries. 
The ability to use existing computers 
with new products encourages users to 
continue purchasing Apple equipment 
instead of other brands of computers. 

Here's my own wish list of hardware 
and software products to make Apple 11s 
more usable with Macintoshes in multi- 
platform environments: 

The ability to read and write files 
directly to a Macintosh's hard drive 
from a GS or a IIe with AppleTalk 
card. While Appleshare does make that 
possible, it requires a dedicated com- 
puter, and the I1 can access files only 
from a ProDOS partition. A number of 
utilities let Macs read to and write from 

other Macintoshes' hard drives on an 
AppleTalk network - so why not 
add ProDOS? 

A software driver to connect I1 SCSI 
cards directly to Macintosh hard 
drives. Imagine disconnecting your 
Mac's hard drive and hooking it up to 
your 11's SCSI card and reading and 
writing files. Unfortunately, no SCSI 
card comes with the right software to 
recognize Macintosh drive formatting. 
Better yet - can you imagine hooking 
up a I1 and a Mac to the same hard 
drive directly via the same SCSI bus? 
There's no reason why the hardware 
can't handle it -just lack of software. 

The ability to hook up a PowerBook 
directly to a 11's SCSI port. This is the 
same problem from the opposite side. 
The PowerBook 100 can Connect directly 
to another Mac's S(3SI port; its hard 
drive looks like an external hard drive 
as far as the Mac is concerned. But this 
feature isn't available inTthe  other 
PowerBook models, and it doesn't work 
with a 11's SCSI card. 

Drivers for QuickDraw-yd other 
Macintosh printers -&%$@a-modes. 
You can access ~ d g ~ r i n t e r s  on 
AppleTalk netwodsde&& from GSIOS, 
but not other Macintosh printers. 
ProDOS 8 users can't access most 
AppleTalk printers at all. 

And the ultimate hardware item - 
something that would make Macs and 
Us more members of the same family 
instead of distant cousins? The Mac 
GS. A dream version of this rumored 
machine would be a 68030 or 68040 
Macintosh with six NuBus slots and a 
processor-direct slot (like the Mac LC's). 
The GS board would be an inexpensive 
option, with its own slots capable of 
supporting standard Apple I1 cards. 
The system would support all GS func- 
tions - transparently, and as efficiently 
as if they were running on a standard 
Apple IIGs. Now wouldn't that be the 
ultimate power machine. Q 

PHILIP CHIEN IS A FREQUENT CONTRIBUTOR TO 

~CIDER/A+'S REVIEWS SECTION. WRITE TO HIM 

C/O INCIDER/A+, 80 ELM STREET, PETER- 
BOROUGH, NH 03458. ENCLOSE A SELF- 

ADDRESSED, STAMPED ENVELOPE IF YOU'D LIKE 

A PERSONAL REPLY. 
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8620 Westwood Center Drive 
Vienna, VA 221 80 
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$5.95/mmth membership 
$6 t o  $lO/hour connct time 
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,-AppleLlnk Consumer Edition, 
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(7081 559-1 300 Weighing Your Options" 

(7081 559-1 310 February 1932, p. 28 
- I 

customer service 
(8001 323-7744 

"Howward Bound" 
March 1992, p. 20 I 

Shakepmre "Deskwriter C" 
Creative Multimedia Carp. March 1992, p. 25 
514 NW 11th 
Suite 203 'Deals, Deals, Deals" 
Portland, OR 97209 March 1992, p. 26 

(5031 241-4351 "Words into Print" 

I 
$29.99 April 1992, p. 32 

PowerPort Bronze, $229 
PowerPort Silver. $429 
PowerPort Gold. $499 
Global Village Communication 
6856 East Middlefield Road 
Mountain View. CA 95043 
(4151 390-8200) 

White Knight 
Freesoft Company 
150 Hickory Drive 
Beaver Falls. PA 1501 0 
(41 21 846-27001 
$139 

FURTHER READING 
"Meet tha Mac LC" 
December 1690, p. 40 

'Connecting In the '90s" 
December 1990, p. 66 

"Family Tim" 
February 1991, p. 52 

"Swap 'ti1 You Drop" 
March 1991, p. 100 

"Telephone Tag" 
April 1991, p. 62 

'Printer Polygamy" 
May 1991, p. 68 

"Bargain Hunt" 
May 1992, p. 16 

"Working d ie Nets" 
May 1992, p. 28 

"Mac LC 11: 
Ready for Prime Time" 
June 1992, p. 12 

"Looking Ahead" 
June 1992, p. 20 

"Round 6" 
July 1992, p. 24 

'Low-Cost Power: Mac LC II" 
July 1992, p. 26 

"Smooth Operator" 
July 1992, p. 34 

"Teamwork" 
August 1992, p. 18 

"Wwks in  Prmgreus" 
August 1992. p. 36 

"Taming tha Bunt" 
N o m b a r  1992, p. 20 

'Microsoft Works 3.0" 
February 1993, p. 28 

'Top February Ten" 1993, p. 32 . 
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PROJECT: FORM 1040 

rab your bat and ball -we're going for the sweep. 
This month we play game 2 of our double-header 
featuring do-it-yourself spreadsheets for estimating 

personal income taxes. In our first installment (February 
1993, p. 38) we learned how to prepare a multipurpose 
template you can tailor to simulate IRS forms and sched- 

ules and other types of "math-smart" docu- 
ments. We also designed a worksheet for 
Schedule A (Itemized Deductions) that functions 
as an itemized log to help you "track your 
stats" - medical outlays, charitable gifts, and 
other deductible expenses. This time around 

Part 2 Ah, spring! Your favorite ball 
team's warming up for another 

season, your family's dreaming of fun in the sun . . . 
and you get to play catch-up with your tax records. 
But look on the bright side: Organizing a prelim- 
inary return on your Mac or Apple I1 can help you 
score the biggest refund you're entitled to. 

By THE STAFF OF INCIDER/A+ 

we'll translate the government's Form 1040, 
the U.S. Individual Income Tax Return, into an 
easy number cruncher created with Claris- 
Works or Microsoft Works on the Mac, or 
Appleworks Classic or AWGS on the 11. 

A word to the wise before we begin: We've 
designed these worksheets only for tax estima- 
tion and planning purposes. While they pro- 
vide reasonably accurate evaluations - often 
to within just a few dollars of the actual tax 
you'd owe - check the tax laws that apply to 
your financial situation. For example, our 
worksheets are content to let you take deduc- 
tions and credits to which you're not entitled; 
the IRS holds you to a higher standard. 



Note also that although our worksheet simulates the 
paper Form 1040, the IRS won't accept this computer- 
ized version of the form. Do not submit any home-grown - 

computer worksheets to the government. Instead, use 
only "official" forms - or IRS-authorized facsimiles 
generated by tax-preparation software designed specifi- 
cally for tax filing. (Check with your local software dealer- 
ship.) Now let's boot up and hit the ground running. 

1 Launch your spreadsheet and open 
, your blank tax-template file. 

Take a moment to consider your filing status: m a h d  
filing jointly (or qualifying widow/widower), married filing 
separately, head of household, or single. (If you're unsure, 
refer to the instructions accompanying your tax forms. 
For other sources, see the sidebar "The Fine Print.") 
Instead of wrestling with a one-size-fits-all spreadsheet 
containing formulas you don't need, you'll be customiz- 
ing this one to your filing status with selected formulas. 

In ClarisWorks, double-click your mouse button to 
open the file Blank SS Template, which you prepared last 
month. Pull down the File menu and choose Sane as to 

Â¥sav the worksheet with the prefix 1040 followed by 
a description of your status - something like 1040 
Married Jointly, 1040 Married Separately, 1040 
Household Head, or 1040 Single. 

If you're using Microsoft Works, double-click your 
mouse button to open last month's file, Blank SS 
Template. Pull down the File menu and choose Save as to 
save the worksheet with the prefix 1040 and your status 
- something like 1040 Married Jointly, 1040 Married 
Separately, 1040 Household Head, or 1040 Single. 

In AppleWorks GS, double-click your mouse button 
to open the file blank.ss.tmplt. Pull down the File menu 
and choose Save as to save the spreadsheet under a new 
working title: A1040.MJ, A1040.MS, A1040.HH, or 
A1040.S. (In AppleWorks GS and Classic, a filename 
may contain periods, but no spaces; it must begin with a 
letter; and it can't exceed 15 characters in length.) 

If you're using AppleWorks Classic, press Return to 
Add files to the Desktop from the main menu, then Get files 
from your data disk. Select the filename blunk.ss.tmplt. 
Now press Open apple-N (OA-N), then OA-Y (to delete 
the old name), and type in the new filename A1040.MJ, 
A1040.MS. A1040.HH. or A1040.S. Press Return. 

2 Type in the header information 
1 and format the worksheet's title. 

With the original blank spreadsheet still safe on your 
hard drive or floppy disk, you can use the renamed file 
on screen to create your personal version of Form 1040. 
Follow along in Figure 1 if you're using a Mac program, 
Figure 2 if you're using AppleWorks GS or Classic. 



CELL STATUS 1 CLARISWORKS 1 MICROSOFT WORKS 1 APPLEWORKS GS 1 APPLEWORKS CLASSIC 
I I I I 

C45 Single 

Head of Household 

I I I I 

Married Filing Separately 1 =3000+(700*SUM(C43..C44)) 1 =3000+(700*SUM(C43:C44)) 1 =3000+(700*SUM(C43..C44)) 1 +3000+(700*@SUM(C43..C44)) 
I I I I 

Married Filing Jointly or 
Qualifying Widow(er) 

=3600+(90(rSUMIC43..C44)l 

=5250+(900*SUM(C43..C44)1 

=6000+(700*SUM(C43..C44)) 

C55 Single 

=3600+(900*SUM(C43:C44)) 

=5250+(900*SUM(C43:C44)) 

Head of Household 

=6000+(700*SUM(C43:C44)) 

=IF(C53~=21450,0.15, 
IF(C53c =51900,0.28, 
IF(C53>=51901,0.31,G55))) 

Married Filing Jointly or 
Qualifying Widow(er) 

I I I 

G51 1 Formulas 1 Formulas 1 Formulas 1 Formulas 
G52 1 =C53*0.15 1 =C53*0.15 1 =C53*0.15 1 +C53*0.15 

=3600-r(900*SUM(C43..C44)) 

=5250-r(900*SUM(C43..C44)) 

=IF(C53c =28750,0.15, 
IF(C53< =74150,0.28, 
IF(C53>=74151,0,31,G55))) 

Married Filing Separately 

I I I I 
G53 Single 1 =3217.50+((C53-21450)*0.28) 1 =3217.50+((C53-21450)*0.28) 1 =3217.50+((C53-21450)*0.28) 1 +3217.50+((C53-21450)*0.28) 

I 

+3600+(900*@SUM(C43..C44)) 

+5250+(90O'@SUM(C43..C44)1 

=6000+(700*SUM(C43..C44)) 

=IF(C53<=21450,0.15, 
IF(C53c =51900,0.28, 
IF(C53>=51901,0.31,G55))) 

=IF(C53c =35800,0.15, 
IF(C53c =86500,0.28, 
IF(C53> =86501,0.31,G55))) 

I I I I 
Head of Household 1 =4312.50+((C53-28750)*0.28) 1 =4312.50+((C53-28750)*0.28) 1 =4312.50+((C53-28750)*0.28) 1 +4312.50+((C53-28750)*0.28) 

I I I I 

+6000+(700*@SUM(C43..C44)) 

=IF(C53< =28750,0.15, 
IF(C53<=74150,0.28, 
IF(C53>=74151,0.31,G55))) 

=IF(C53c =17900,0.15, 
IF(C53< =43250,0.28, 
IF(C53> =43251,0.31,G55))) 

Table 1. Form 1040 worksheet formulas for columns C, F, and G. Note differences among filing statuses for selected formulas. 

=IF(C53c =21450,0.15, 
IF(C53< =51900,0.28, 
IF(C53> =51901,0.31,G55))) 

=IF(C53c =35800,0.15, 
IF(C53c =86500,0.28, 
IF(C53>=86501,0.31,G55))) 
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@IF(C53< =21450,0.15, 
IF(C53c =51900,0.28, 
IF(C53> =51901,0.31,G55))) 

=IF(C53< =28750,0.15, 
IF(C53< =74150,0.28, 
IF(C53> =74151,0.31,G55))) 

=IF(C53c =17900,0.15, 
lF (C53~ =43250,0.28, 
IF(C53>=43251,0.31,G55))) 

@IF(C53c =28750,0.15, 
IF(C53< =74150,0.28, 
IF(C53> =74151,0.31,G55))) 

=IF(C53<=35800,0.15, 
IF(C53<=86500,0.28, 
IF(C53>=86501,0.31,G55))) 

@IF(C53c =35800,0.15, 
IF(C53< =86500,0.28, 
IF(C53>=86501,0 31,G55))) 

=IF(C53< = 17900,0.15, 
IF(C53<=43250,0.28, 
IF(C53>=43251,0.31,G55))) 

@IF(C53c = 17900,0.15, 
lF (C53~ =43250,0.28, 
IF(C53>=43251,0.31,G55))) 



In ClarisWorks, click on A2 and begin typing the 
"disclaimer" at the top of the sample worksheet (Figure 
1). When you get to the last word (tax) in the first line, 
press Return. Click on A3 and type the second line, and 
so on. Click on A7 and type the worksheet title; be sure 
to include your filing status. Now select the title by click- 
ing within the row 7 header. Pull down the Format 
menu; choose Style and then Bold from the cascading 
menu. Be sure to save your worksheet (Command-S, or 
Save on the File menu) every 15 minutes or so to avoid 
losing your work to brownouts or system bombs. 

In Microsoft Works, click on A2 and type the 
"disclaimer" in Figure 1. When you get to the last word 
(tax) in the first line, press Return. Click on A3 and type 
the second line, and so on. Click on A7 and type the 
worksheet title; be sure to include your filing status. 
Now select the title by clicking within the row 7 header. 
Choose Bold from the Style menu in the toolbox. Be sure 
to save your worksheet (Command-S, or Save on the File 
menu) every 15 minutes or so to avoid losing your work 
to brownouts or system bombs. 

If you're using AppleWorks GS, click on A2 and begin 
typing the "disclaimer" at the top of the sample work- 
sheet (Figure 2). When you get to the last word (tax) in 
the first line, press Return. Click on A3 and type the sec- 
ond line, and so on. Click on A7 and type the worksheet 

title; be sure to include your filing status. Now click with- 
in the row 7 header to select the title. Pull down the 
Format menu and choose Bold. Be sure to save your work- 
sheet (Command-S, or Save on the File menu) every 15 
minutes or so to avoid losing your work to brownouts or 
system bombs. 

If you ran into problems experimenting with column 
widths in AppleWorks Classic for last month's tem- 
plate, here's how to duplicate the widths shown here in 
Figure 2. Start by placing the cursor on Al. Press OA-L 
(Layout); select Columns (or type C) and press Return. 
Select Column width (or type C). Press OA-Right Arrow 
14 times to widen A to 23 spaces, and press Return. 
Repeat for B, pressing OA-Right Arrow 31 times to 
widen that column to 40 spaces. To condense the type a 
bit, press OA-0 (Printer Options), type CI (Characters per 
Inch), and then type 12. Press Escape to return to the 
spreadsheet. Now go to A2 and begin typing the 
"disclaimer" in Figure 2. When you get to the last word 
(tax) in the first line, press Return. Use the arrow keys 
to move to A3 and type the second line, and so on. 
Move to A7 and type the title; include your filing status. 
(Although boldface is an option on AW Classic's word- 
processor Printer Options menu, it's not available for the 
spreadsheet.) Save (OA-S) every 15 minutes or so to 
avoid losing your work to brownouts or system bombs. 

0 I I 
7 (WORKSHEET FOR FORM1MO:MARRIED-TAXPAYER-RUNG-JOftfTLY 

Figure 1. Printout of Form 1040 worksheet (married filing jointly) in ClarisWorks. 
Microsoft Works template is similar in format. 
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PROJECT: FORM 1040 
3 Type in cell labels. 

Â 

We studied an actual 1992 Form 1040 to determine 
categories for our 1992 worksheet: Exemptions, Income, 
Adjustments to Income, Tax Computation, Credits, Other 
Taxes, and Payments. Using Figure 1 or 2 as a guide, 
click on each appropriate cell in column A (use the 
arrow keys in AW Classic) and type in those labels. 
Type labels for line items such as Wages: Job 1 into 
appropriate cells in column B. Skip formatting for now. 

4 Add formulas to the worksheet. 

Like the Schedule A template, our Form 1040 reserves 
column C for data and formulas. D sports data-entry 
pointers, which make filling in the form on screen easier. 

In ClarisWorks, create a data-entry pointer by click- 
ing on D9 and typing the less-than sign (<) followed by 
three dashes (---). Copy the pointer (Command-C) and 
paste it (Command-V) into appropriate column D cells 
as shown in Figure 1. For now, enter a 0 (zero) into each 
data-entry cell in column C. Type the formulas shown in 
Table 1 into the appropriate cells in columns C, F, and 
G. Be sure to type an equal sign (=) before each formula. 
To add the contents of a range of cells, use the expres- 
sion SUM and two ellipsis points, or periods (like this: 
..), between the first and last cells of the range. (See the 
accompanying sidebar "Go Figure" for Ups on using the 
spreadsheet formulas referred to in this template.) 

In Microsoft Works, create a data-entry pointer by 
clicking on D9 and typing the less-than sign (<) 
followed by three dashes (---). Copy the pointer 
(Command-C) and paste it (Command-V) into appropriate 

.t 

. . GO FIGURE 
labels and formulas in the 
LOOKUP T B  section of 
Table 1. The formulas in G53 
and 654  vary depending on 
your filing status. 

Learning about spreadsheet 
formulas as you create our 
tax templates will give you 
some confidence when it's 
time to design a worksheet 
to  track investments or 
grades. Here are a few points 
to  keep in mind: 

The equal sign C = l  alerts 
ClarisWorks, Microsoft 
Works, or AWGS that you 
intend to  type a formula into 
a selected cell. In AppleWorks 
Classic, though, you need a 
plus sign (+I, unless you're 
using a built-in spreadsheet 
function requiring an @ sign. 

Formulas containing the 
SUM function [@SUM in AW 
Classic) add up the values in a 
given range of cells. Claris- 
Works, AppleWorks Classic, 
and AWGS all require two 
periods [..I between the first 
and last cells of the range; 
Microsoft Works requires a 
colon (:I instead. (Appleworks 
Classic formulas may have 
three periods instead of two.] 
* When you need to  add up 
a discontinuous series of 
numbers, use a + formula 
to  enumerate individual cell 
locations. 

Most of the formulas listed 
in Table 1 apply to all tax- 
payers. You'll need to  deter- 
mine your filing status, how- 
ever, before you can pick the 
correct formulas to  use in 
C45, C55, B53, and G54. 
The formufa in 045 calculates 
your standard deduction as 
well as the value of the 
special exemptions granted 
to  taxpayers and their 
spouses who are 65 and 
older and/or blind. As you can 
see from Table 2 - standard 
deductions for 1992 provided 
by the IPS - the value of 
your deduction depends on 
your filing status. 

The formulas constructed 
for C55 incorporate values 
included in the 1992 tax-rate 
schedules. Provided by tine 
IPS, Schedules X, Y-1, Y-2, 
and Z are shown in Table 3. 
Married taxpayers who fite 
jointly would refer to  
Schedule Y-1, for instance, 
and use the formula 
=IFfC53< =35800,0.15, 
IFtC53 < =86500,0.28,IF 
lC53>=86501,0.31,G55)1~. 
Translated into English the 
formula reads: jf the amoun& 

~f taxable income [ c m  If you're a married taxpayer 

h!hmilBuQ!L&h and you file a joint return with 

15 pement margnai tax your spouse, enter the follow- 

bracket. If vour taxable ing formula in G53: =5370 

jncome is as much as + f tC53-358OO)Ãˆ0.28I 

SSaB-500.vou'reinthe28 In English, this formula tells 

percent muinal tax bracket. the spreadsheet software to  

jf &axable income is subtract 

gr moreL we~corne j n c O m e u m  a 
- the 31 oercent marainat b a P m e n t ~  
$ax bra&& In the rare event m u  m. These 

that your particular tax situ- values come from Schedule 

ation isn't covered here. a y1 (Table 3). 

reference to G55 appears at The con- 
the end of the formula. If all tains other 
else fails, the term IBS will - in C49 and C67. 
appear in C55, alerting you to  we used the MAX in 

a problem with the formula in C49 the value Of 

that cell. your standard deduction to . ~h~ formula in ~ 5 7  esti- the amount of itemized 

mates your income tax by deductions you enter in C47. 

comparing the marginal tax C49 chooses the larger 

bracket (C551 t o  calculations automatically, whicn 
pe&rmed in a w. benefits you. The formula in 

m e  relationship between C57 c67  Prevents you flWm claim- 

and the lookup table is like ing a negative tax. 
that between a library card (Note than pu can carf'Y 
catalogue and book stacks. some tax losses forward 

The catalogue (C57) tells the future Years- A discussion of 

spreadsheet where to go such fine points of tax law is 

table1 to  find the correct for- the scope this 
mula to use. This particular P~o!^- but swe to  check 
table spans the range from with IRS publications or your 

F50 to  G55 and includes the details-) 
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LI 
21 This facs imi le  of IRS Fom 1040 helpa you projec t  t h e  inc- t a x  
31 you w i l l  owe on your 1992 income. Use foe pluuiing only; do not aubcdt 
41 t o  t h e  IPS. Although formulas used were accurate a t  prase  t i n e ,  they 
51 may be inaccurate now. check IRS publ ica t ions  foe  current information. 
61 
71 WORKSHEET FOR FORM 1040: MAHRIED TAXPAYER FILlffi JOIHTLY 

91 Exemptions 
101 
I l l  

four Exeaptlona 
E x e ~ ~ t i o n ( a l  f o r  Dependent la1 

Total E x a n o t i o ~  
121 
131 Income wages: ~ o b  1 
141 Wages: Job 2 
151 m h e r  wage*, Salaciea, Tips, e t c .  
161 Taxable Interest Incce (Sell. Bl 
171 Dividend Income (Sch. Bl 
181 StatelLocal Income Tax Refunds 
191 u i n o n y  Received 
201 Business IN- or t ~ o a a l  
21 1 Capi ta l  Gain ox (Low1 
221 Capi ta l  Gain Distribution! 
231 m h e r  Gains or ILoaaeal 
24 1 Taxable IRA Diatributiona 
251 Taxable PenaionslAnnuitiea 
261 Rents, Royalties, e tc .  
271 ram income (maat  
281 Unefflploynent Conoensation 
291 Taxable Sac. Security Benefits 
301 Other Income 
31 1 T o f l  I 
32 1 
331 Adju~tBante  t o  Income IRA Deduction 
341 Self-aooloynent Deduct ioo~ 
351 Keogh and SEP Deductions 
361 Penalty on Savings l i t h d r Ã ‘  
37 I Alinony Paid 

381 Toul u j u t M n t s  

msm CUSS IMCOK. 

-A * 
431 Tax COtuta t ion Enter 1 f o r  each "age" deduction 0 <--- 
441 Enter 1 f o r  each "blindneaa- deduction 0 <--- 
451 Your Standard Deduction 6000 
w 
471 Tota l  Itemlied Deductions froi Scb. A 0 <--- 

681 
691 Other Taw 
701 
711 
721 
731 
74 1 
751 
761 
771 781 Payenta  

791 
801 
81 1 
82 I 
831 
84 1 
851 
861 
871 
881 

The Bet ter  Deduction t o  C h i *  

Tota l  Value of tour Qeootions 4600 

YOUR TAXABLE IHCCKE 0 

[lour HarginM Tax Bracket} .15 

YOUR ESTIIUTED DKXMB TAX 0 

Additional Taxes IF-om 4970, 49721 0 <--- 
Total  Tax 0 

Ccodit for ChildIDependent Care 0 <--- 
Credi t  f o r  ElderlyIDliabled 0 <--- 
Foreign TAX Credi t  0 <--- 
Other Credi ts  0 <--- 

Total c r e d i t s  0 
Tax 0 

~ e l f - ~ l l o y n e n t  Tax 0 <--- 
Altai-native Minima Tax 0 <--- 
tecapture Taxes 0 <--- 
Socia l  Sec./Htd. Tax on Unreported Tipa 0 <--- 
TAX on IRA or Ret icewnt  Plan 0 <--- 
Adnace Earned 1nco-e Credit P a y e n t a  0 <--- 

Total Other Taxes 0 
Tax 0 

redecal 1- Tax Withheld 0 <--- 
1992 Estimated Tax Payraenta 0 <--- 
Earned I- Credit 0 <--- 
AKxmt paid  with F o r  4868 0 <--- 
Excess Sac. Sec./Htd., RRTA Tax Withheld 0 <--- 
Other P a y e a t s  0 <--- 

Total  P a W n t s  0 

Figure 2. Printout of Form 1040 worksheet [married filing jointly) in AppleWorks Classic. 
AppleWorks GS template is similar in format to  Figure 1, but uses Figure 2 "disclaimer" [top). 

column D cells as shown in Figure 1. For now, enter a 0 
(zero) into each data-entry cell in column C. Type the 
formulas shown in Table 1 into the appropriate cells in 
columns C, F, and G. Use an equal sign (=) to signify a 
formula expression. To add up the values in a range of 
cells, use the expression SUM and a colon (:) between 
the boundary cells of the range. (See the accompanying 
sidebar "Go Figure" for tips on using the spreadsheet 
formulas referred to in this template.) 

In AppleWorks GS, create a data-entry pointer by 
clicking on D9 and typing the less-than sign (<) and 
three dashes (---). Copy the pointer (Command-C) and 
paste it (Command-V) into appropriate column D cells 
as shown in Figure 2. For now, enter a 0 (zero) into each 
data-entry cell in column C. Type the formulas shown in 
Table 1 into the appropriate cells in columns C, F, and 
G. AppleWorks GS also uses an equal sign (=) to denote 
a formula. To add the contents of a range of cells, use 
SUM and two periods (..). (See the accompanying side- 
bar "Go Figure" for tips on using the spreadsheet for- 
mulas referred to in this template.) 

In AppleWorks Classic, go to D9 and create a data- 
entry pointer by typing quotation marks (to signify a 
label), followed by the less-than sign (<) and three dash- 
es (---). Copy the pointer (press OA-C, choose Within 
worksheet, and press Return) and paste it (move to the 
new area and press Return) into appropriate column D 
cells as shown in Figure 2. For now, enter a 0 (zero) into 

each data-entry cell in column C. Type the formulas 
shown in Table 1 into the appropriate cells in columns 
C, F, and G. Put a plus sign (+) in front of each formula, 
except those that begin with a built-in spreadsheet func- 
tion. For example, to add up the values in a range of 
cells, use the expression @SUM and either two or three 
periods (your choice) to denote the boundaries of the 
range. (Similarly, note that the logical function IF is 
expressed as @IF in AppleWorks Classic; LOOKUP 
and MAX become @LOOKUP and @MAX. See the 
accompanying sidebar "Go Figure" for tips on using the 
spreadsheet formulas referred to in this template.) 

5. Format the cell labels. 

As you can see from Figures 1 and 2, we've right justi- 
fled selected labels in column B. We've centered other 
labels -ADJUSTED GROSS INCOME, YOUR TAXABLE 
INCOME, Y O U R  ESTIMATED INCOME TAX,  and 
AMOUNT (OWED) or REFUNDED - and used upper- 
case letters to make them stand out. 

In ClarisWorks, go back to cell B 1 1. To right-justify 
the label Total Exemptions, click on the cell, pull down 
the Format menu, and choose Alignment and then Right. 
Do the same for the labels in B31, B38, B60, B66, B67, 
B75, B76, and B84. Now make the major category labels 

Continued on page 57 
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Spec~a~s of tne ~ o n t n !  
LCIlle Emulation board .............................. $99 . 
Applied Eng . Datalink 1200 modem ............. 49 . 
llgs RGB monitor (genuine Apple) ............. 229 . 
llgs 3.5 floppy ............................................. 169 . 
llgs 5.25 unidisk ......................................... 169 . 
Apple Mono monitor (latest version) ............ 69 . 
llgs power supply (genuine Apple) ............... 89 . 
llgs case ....................................................... 29 . 
Apple personal modem 1200 ....................... 49 . 
3.5 Unidisk ................................................. 149 . 
llc monochrome monitor .............................. 79 . 
Imagewriter I .............................................. 149 . 
11+ replacement keyboard ............................ 29 . 
11+, lie Disk II controller ................................ 45 . 
llgs 256k memory expansion board ............. 49 . 
lie 64k180 col board ..................................... .3 5. 
Apple lie mouse and card ............................ 95 . 
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PROJECT: FORM 1040 
Continued from page 55 

in B40, B53, B57, and B86 boldface: Pull down the 
Format menu and choose Style and then Bold from the 
cascading menu. You can add bullets (dots) by pressing 
Option-8. (Bullets are among the dozens of "hidden" 
characters provided by fonts such as Geneva that boast 
an extended character set.) Now position the text within 
each of those four cells: Pull down the Format menu, and 
choose Alignment and then Center. 

In Microsoft Works, go to cell B 1 1. To right-justify 
the label Total Exemptions, pull down the Format menu, 
choose Format Cells, and click on the Right radio button. 
Do the same for the labels in B31, B38, B60, B66, B67, 
B75, B76, and B84. Now make the major category labels 
in B40, B53, B57, and B86 boldface: Choose Bold from 
the the Style menu in the toolbox. You can add bullets 
(dots) by pressing Option-8. (Bullets are among the 
dozens of "hidden" characters provided by fonts such as 
Geneva with extended character sets.) Position the text 
within each of those four cells: Pull down the Format menu, 
choose Format Cells, and click on the Center radio button. 

If you're using AppleWorks GS, return to cell B 1 1. To 
right-justify the label Total Exemptions, select the cell, 
pull down the Format menu, and choose Align Rfgf i t .  Do 
the same for the labels in B31, B38, B60, B66, B67, 
B75, B76, and B84. Now make the major category labels 
in B40, B53, B57, and B86 boldface: Pull down the 
Format menu and choose Bold. You can add bullets 
(dots) by pressing Option-8. (Bullets are among the 
dozens of "hidden" characters provided by fonts such as 
Geneva that boast an extended character set. These 
characters are available if Translation in the general 
Control Panel is set to Standard.) Now position the text 
within each of those four cells: Select it, pull down the 
Format menu, and choose the Align Center option. 

For AppleWorks Classic, go to cell Bl l .  To right- 
justify the label Total Exempturns, press OA-L and select 
Entry. At the Layout? prompt, choose Label format, then 
Right justify. Do the same for the labels in B31, B38, 
B60, B66, B67, B75, B76, and B84. For the major cate- 
gory labels in B40, B53, B57, and B86, add asterisks to 
make them stand out. Now position the text within each 
of those four cells: Press OA-L (Layout) and select Entry; 
at the Layout? prompt, choose Labelformat, then Center. 

6 Bound off dollar amounts. 

Because the IRS wants you to round off dollar figures 
on your actual return, do so on your planning worksheet 
for appropriate cells in columns C and G. (Rounding 
helps cut down on screen clutter, too.) For cells C55, 
F52, F53, and F54, we'll round off in percentage format. 

In ClarisWorks, click on each appropriate cell, pull 
down the Format menu and choose Number. Click on the 
Fixed radio button, and set Precision to 0 (zero). Click on 
OK. For cells C55, F52, F53, and F54, set Precision to 2. 

In Microsoft Works, click on each appropriate cell, 
pull down the Format menu, and choose Format cells. 
Select any monetary format and type 0 (zero) decimal 
places. For cells C55, F52, F53, and F54, type 2. 

In AppleWorks GS, click on each appropriate cell, 
pull down the Format menu, choose Decimal places, and 
type 0 (zero). Pull down the Format menu again, and 
select Fixed. For cells C55, F52, F53, and F54, use a 
value of 2 for Decimal places. 

In AppleWorks Classic, move to each appropriate 
cell, and press OA-L (Layout). Select Entry. Now choose 
Value format, then Fixed. At the Set decimal places prompt, 
type 0 (zero). For cells C55, F52, F53, and F54, type 2. 

7. Troubleshoot your template. 

Type sample values into each data-entry cell. For 
example, type 1 into every cell from C13 through 30. If 
C31 reads 18, you can be reasonably certain that the 
SUM formula in C31 is working properly. Test other 
sections of your worksheet by entering hypothetical 

The  Fine Print 1 I 
If you're unsure of your filing status, refer to the instruc- 

tions accompanying the tax forms you received in the mail 
when the government sent you its New Year's gift. Or contact 
the IRS toll-free at (800) 829-3676 (1-800-TAX-FORM) for 
the publications and forms you need. Many public libraries, 
banks, and post offices also stock selected IRS forms and I 
instructions. 

Here's another resource: Your local bookseller probably 
carries handbooks touting "taxes made easy." Sounds like an 
oxymoron, but the professional tax advisers who write these 

I 
books do seem to enjoy sharing money-saving tips that can 
help you pay the smallest amount of tax you legally owe. Best 
of all, most tax gurus write in a narrative, plain-English style 
that's easy to understand. Give the folks at the IRS credit for 
trying to make their publications more user-friendly, but the 
circuitous sentences and double negatives that pepper some 
of their official documents can be confusing. 

Before preparing the tax template outlined here, we cozied 
up with The Price Waterhouse Personal Tax Adviser: 
1992-1998 Edition (Pocket Books, ISBN 0-671-79327-6, 
$5.99). At press time we checked with an IRS spokesman to 
be sure the tax tables we used were accurate. If you're going 
to use this template to get a head start on next year's taxes, 
though, remember that Congress and the IRS can change the 
rules in '93 right up until the lighted ball drops in Times 
Square. Always check current IRS publications for changes 
that may affect the validity of your spreadsheet results. 
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PROJECT: FORM 1040 

FILING STATUS STANDARD DEDUCTION ADDITIONAL AMOUNT ADDITIONAL AMOUNT 
65 OR OLDER OR BLIND 65 OR OLDER AND BLIND 

Married Filing Jointly or 

Qualifying Widow/Wid 
$6000 $700/$1400 both spouses $1 400/$2800 both spouses 

Head of Househok 

Single 

Married Filing Separat~ 

$900 $1 800 

$900 $1 800 

$70C I00 both spouses $1 400/$2800 both spouses 

Table 2. If you don't itemize your deductions, you may take the 1 9 9 2  standard deduction listed here. Note that  if you can 
be claimed as a dependent on another person's 1 9 9 2  return, your standard deduction is the greater of either $600 or 
vour earned income. UD to the standard deduction amount. Source: IPS. 

numbers. Use a handheld calculator and the IRS values 
provided in Tables 2 and 3 to check the results of the 
worksheet's more-complex operations. 

In ClarisWorks, you can read (and edit) any individ- 
ual formula in the data-entry box at the top of the 
screen. To display all formulas in their respective cells, 
pull down the Options menu and choose Display. Click on 
the Formulas check box in the dialog that appears. 

In Microsoft Works, check the data-entry box at the 
top of the screen to see an individual formula. To see 
them all, choose Show Formulas from the Options menu. 

AppleWorks GS also displays a data-entry box at the 
top of the screen for viewing individual formulas. To 
display all formulas in their respective cells, pull down 
the Options menu and choose View Formulas. 

In AppleWorks Classic, you can check an individual 
formula by moving the pointer to a formula-containing 
cell and reading the display line at the bottom of the 
screen. To display all formulas in the worksheet, press 
OA-Z; press OA-Z again to display values. 

8 An ounce of prevention can protect 
your formulas from alteration. 

When the spreadsheet meets your standards for both 
function and design, protect the cells containing formulas 
so that you won't inadvertently mess them up later on. 

In ClarisWorks, select the cell and press Command- 
H. Don't forget to save your spreadsheet: Pull down the 
File menu and choose Save, or just press Command-S. 

If you're using Microsoft Works, select the cell, pull 
down the Format menu, and choose Protect Cel l .  
Remember to save (File menu), or press Command-S. 

In AppleWorks GS, select the cell and press 
Command-*, or select Protect from the Data menu. Now 
pull down the File menu and choose Save, or press 
Command-S. 

For AppleWorks Classic, move the pointer to the cell 
you want to protect. Press OA-L (Layout), then choose 
Entry and Protection. At the Allow? prompt, press Return 
to choose Nothing. Then press OA-S to save. 

9 Print your worksheet 
1 and check it over. 

Whatever Works you prefer, printing the Form 1040 
worksheet is easy. Just follow the steps outlined here. 

In ClarisWorks, pull down the Options menu, choose 
Print Range, and enter the range: Al..D88. Pull down 
the File menu and select Print (or press Command-P). 

In Microsoft Works, pull down the File menu and 
choose Print Preview. If the worksheet looks okay, click 
on the Print button. 

For AppleWorks GS, drag the mouse to select the 
block of cells A1 to D88, then press OA-P to print. 

If you're using AppleWorks Classic, press OA-P and 
select Block. Highlight the block of cells A1 through D88 
and press Return. 

1 0 Customize and update 
your worksheet. 

Barring any drastic revamping of the tax laws, you can 
edit this template's formulas easily to accommodate 
changes in tax-rate schedules (Table 3) from one year to 
the next. (For 1993, for instance, marginal brackets 
could change if the schedules are adjusted again for 
inflation - or if Congress reads President Clinton's 
lips. During last fall's campaign, for example, Clinton 
alluded to raising the top marginal tax bracket to 36 
percent.) After incorporating any such changes in the 
tax code, be sure to save each revised worksheet with a 
new name so that you don't overwrite the original 1992 
template. Feel free to erase the original after you trouble- 
shoot the new version. 

In ClarisWorks, to edit the formula in G53 - or any 
worksheet cell, for that matter - click on the 
formula-containing cell. In the data-entry area at the 
top of the worksheet, drag the mouse to select the part 
of the formula you need to change. Type the new value 
provided by the IRS, and save your edited worksheet 
with a new filename (Save as under the File menu). 

In Microsoft Works, click on the formula-containing 
cell you need to edit. In the data-entry box at the top of 
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the screen, drag the mouse to select the portion of the 
formula you want to change. Type the new value 
provided by the IRS; choose Save as from the File menu 
and type in a new filename. 

If you're using AppleWorks GS, click on the formula- 
containing cell you want to edit. In the data-entry area 
at the top of your worksheet, drag the mouse to select 
the portion of the formula you need to alter. Type the 
new value provided by the IRS. Pull down the File menu 
and choose Save as; type in a new filename. 

To edit a formula in AppleWorks Classic, go to the 
formula-containg cell you want to edit and press OA-U; 
you'll see the formula and a blinking cursor at the 
bottom of the screen. Delete the portion of the formula 
that's changed; type in the new value provided by the 
IRS. Now press OA-N; press OA-Y to erase the old file- 
name, and enter a new one to save your revisions. 

Creating Schedule A and Form 1040 tax-planning 
worksheets takes no more than a few hours, but these 
projects can save you lots of time when you prepare your 
actual income-tax return. You can use the Apple 
versions merely to double-check the math on your pen- 
and-paper tax return, or  to test hypothetical tax 
scenarios. If you're eligible to deduct an IRA contribu- 
tion, for example, the Apple worksheet can calculate 
your tax savings quickly. 

Updating your worksheets from year to year with new 
values provided in IRS tables breathes new life into 
these templates - it's worth the small amount of time 
involved. Not only will it be easier to prepare your tax 
return in 1994 and beyond, but you can use your revised 
worksheets throughout a given tax year to forecast the 
impact of accelerating (or delaying) income, beefing up 
deductible expenses, and taking advantage of available 
tax credits. 

TAX IS 

Maybe preparing a tax return on your computer is a 
lot like playing baseball after all - you can reduce 
errors, of the mathematical kind at least. (Of course, you 
might strike out and owe the IRS more money than you 
thought.) But one thing's for sure: As each new tax 
season begins, you can almost hear Yogi Berra say, 
"It's dbja vu all over again." Q 

For a reprint of part 1 of 
"Tax Form Reform," 
send a self-addressed, 
stamped envelope to 
Editorial Department, 
inCider/A + , 
80 Elm Street, 
Peterborough, NH 
03458. 

Appleworks Classic 3.0, Microsoft Works 3.0 1 $249 Microsoft Corporation 
ipleworks GS 1.1, $299 1 Microsoft Way 
arisworks 1.0 v3, $249 Redmond, WA 

Claris Corporation 98052-6399 
5201 Patrick Henry Drive (8001 426-9400 
P.O. Box 581 68 end-user sales and service 
Santa Clara, CA 95052 (2061 635-71 60 
(4081 727-8227 product support 
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LASER 128 289 414 488 
LASER 128EX 359 484 558 

TaxCalc-92 Tax Preo Softwa re... 29 

discount music-MIDI products 
Apple 11, GS, Mac, IBM, Amiga, /\tar/, Cd-4 

BE; NO-slot Cl0&.,.36 
KraB Joystick .......... 25 ' 

Repair Zoom 2400 Mdem ....... 79 
Center Mouse wlcard for lie ........... 89 
Education ........... Dealer Laser 128 Expansion Box 55 

Laser PC-4 for: IBM ... 199 Mac ... 219 
PC4 Widoe IT for AooleWorks 3.0 ..................... 35 

I 
100% Fabric Dust Covers 

Uke plastic or vinyl) . willnot yellow 
Cause Condensation! Machine 

...................... I Safeakin ~ e ~ b ~ ~ r o t e c t o r f o r  Laser 128 20 
Laser 5.25 Drive ... 99 UDC ... 60 Laser 3.5 Drive ... 139 
Goldstar Amber Cormi te  Monitor ............................... 125 
RGB 14" color + green + tilt & swivel for Laser .............. 210 
Magnavox RGB/Composile Color: lie, IIc ... 288 llgs ... 298 
Goldstar 14' Super VGA Color: Mac LC or Peiforma. ,335 
lie Printer Card wlcabte: ParalleL.45 Super Serial..62 
ImagaWriter I Compatible Printer ... 195 Wide carriage ... 325 

RAM Chips: llgs 1 meg ... 45 ~aser & A ~ I ~  256K ^ 
WIN LOTTERIES NOW! 

. .nd your Earls and Viscounts. If you've got 
I royal ancestors, we have the noble software 
that can help you trace them down. Family , 

Roots and your Apple, IBM or Macintosh of- 
fer individual and group sheets, charts, 
name indices, search and text capab- 

Put up ilities. Adapts to most 
disk drives, printers, and LOTTO PICKERm for Apple II is a must purchase if you are 

SERIOUS about winning larger jackpots and generating 
a frequent smaller winnings on a routine basis! LOT- 
TO PICKER works by uncovering hidden biases in your lot- 
lay game and exploiting them in order to provide you with 
q u a  plays to make. Your card will be loaded with num- 
bos(hat have proven to be statistically significant for your 
kXtefy game. Works for all lotteries worldwide (including 
da@ number games). $29.95 (+$4.55 sh). NY residents 

screens. Includes a com- \̂ our prehensive manual. 
We have other genealog- 

dukes! Write ical software or call today too. for 
Apple //c, gs, Macs & MOM 
While all the others come and go, we kee d o i i  what 
we do best we've been refurbishiiig& used 
computers for ten years. Our uality contrS^epart- 
ment assures you the best m&e available for th 

more information and a 
free brochure. I 

money-or your money-back-fflflmxted 

call 
1 -800-821-3221 

Quinsept, Inc. 1 please add applicable sales tax. 

SATISFACTION GUARANTEED! 
- - 

P.O~BOX 216 
Lexin on, MA 02173 
Telephone: (617) 641-2930 
(800) 637-7668 

Order 1-800-484-1062 s-code 0644 

ffij~~~a GE RIDGE SERVICES, INC. 
848 Rensselaer Ave. 

7 &tedIsland. N.Y. 10309 

PO Box 4059 I Looan, UT 84323-4059 
Fax: (801) 755-331 1 

American Express, Visa 
and Mastdard accepted. 
*Trademarksfor AppleComputw Inc., 

International BusinessMachines. 1 
FOR INFORMATION CALL 1-718-317-1961 - in Reader Service Card. 

. Complete Instructioiia 

10 Year Shelf Life 

I Best Value 
In Apple I1 Series Public 

Domain & Shareware 
Thousands of satisfied owners Fantastic Savings 

have found that our replacement 
battery kit is the best way to 
replace a dead soldered clock 
battery on early models (ROM $14.95 ea. 
1.0) Apple IIGs and MAC 11. 10 Kits for$120 

Largest selection available anywhere,over 1200 
BOOTable and MENU-Operated Program Disks, (on oh 
Entertainment -Business .Education .Utilities .Print 

Shop Graphics .Appleworks .Earnone. 
Telecommunications .Variety .HAM Radio .novelty. 

GS. Specific .PRODOS. Specific .... and More .... ! 
Programs for Apple I I t ,  Uc, net, He, IIgs & Macs 

with ne Simulator Cad. Most are available in 5.25 and 3.5 
Format. Low as $1 A Disk .MC & VISA Accepted. 

Next-Day Shipping is available -Special offers for 'new' 
customers. Send $2.00 for Christella's Descriptive Catalog 

and Demo Disk ...... Be Pleasantly Surprised 
............................. 

*GAMES * KIDS 
I 

*FONTS * *CLIP ART 
HOME AND BUSINESS 
Receive 313.5" or 515.25" disks. 

Pav a service charae of $2.95 Der 

- A Great Reward . Die-cut, Removable . Large 3 inches of Fun 

Call: (91 3) 362-9898 FAX: 362-5798 1 
Nite Owl Productions 
5734 Lamar Street 

I 
Mission, KS 66202 

Software Of The Month Club@ 
619-931-81 11 Ext 51 1 
Qw > 

Christella Enterprise 
P.O. Box 82205 

Rochester, Michigan 48307-9998 1 iction Guaranteed Since 1983 
Circle 4 7  on Reader Service Card. 1 Circle 7 1  on Reader Service Card. Circle 2 3  on Reader Service Card. 
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SUPER DEALS ON MACS & APP.-- 
BUY SELL 'TRADE USED NEW 

1 ' Request FREE catalog or send 
$2 for demo disk and catalog (refund- 
able). Categories include 
Education, Utilities, Games, 
Business, Print Shop 
Graphics, Shareware, Eamor 
and more. Buy as low as 80@ per disk 
A $20 order gets 4 free disks of your 
choice and a $30 order gets an even 
bigger surprise! 

For all repairs. 
Additional charge for parts and 

shipping. Maximum price 
guote guaranteed. 
Apple I1 + , He, IIc 

ONE YEAR WARRANTY 

Apple llc/llc+/lle Systems from $249.99 
Apple llgs Color System $874.99 
Apple Hi-Speed SCSI Cards $104.00 
MAC+/Mac SE 1/20 $425/$649 
MAC Ii/llcx/llx/llfx from $1249 
MAC SE/30/Portable $1499/CALL 
MAC ClassicILC $795/$895 
MAC Classic IllLC Il/IISl LOWEST 
MAC 1ICI 51120 (NEW) $2999 
MAC Powerbooks CALL 
MAC Quadra 700/900/950 LOWEST 
MAXTOR 120 Meg Hard drive $329.99 
Imagewriter 1/11 from $199.99 
Apple Talk Connectors (Mini-Din 8) $9.99 
All Peripherals (Apple & MAC) LOWEST 
Radius, RasterOps, AE, Outbound CALL 

Also open evenings & weekends 

M.P.-COMPUTER MICRO SYSTEMS 
655 W. Evelyn Avenue #2 *MounWn View, CA 94041 

Call for more information! 
We buy dead Apple, Mac, and PCs 

Hours: 12.00-5:00 PM E T  
6.30-10.00 PM E T  
MON-SAT 

Anninius Pubs. and Prods. Inc. 
8519 Orchard Avenue 

Merchantville, NJ 08109 
(609) 662-3420 

( 

In business since 1986 
Purchase Orders Welcome 
Next Day Shipping 

Caloke Industries (Dept. SK) 
PO Box 18477 

REI~~ow~, MO 64133 

3ible Software 1 - 
GENEALOGICAL RECREATION 
FAST - FUN - EASY TO USI' 

1040Works: Now in its 8th year! 
1040Works is a series of professionally 

eloped AppleWwks and ClarisWorks 
plates that compute your 1992 Feder- 

al Income taxes. IWWodcs is accurate, 

ind any verse in the Bible, 
;arch for any word or phrase. 
asily find the exact verse you 
eed for your study. Build per- 
)rial condcordances to the Bible. 
Ie also offer a topical index and 

Greek transliterator. For 
roDos, Macintosh & MSDOS. 
all for a FREE brochure. 

Let FAMILY TREE automatically 
link together your family's 
history into an easy to operate 
(and fun to use) data file. 
Print a wide variety of charts, 
namelists, ahnentafels and @ 4 
group sheets to your printer or 
Appleworks fdes. It even shows 1 
family relationships! Imports data 
from AppleWorks or LDS-PAF data files. I 
Apple enhanced lie, 11c or IIGS. 
Truly aBESTBUY at this low, prepublicati 
price of only $49'"+2W S&H (CA add ta 
With my 90 day satisfaction guarantee, y 
cannot lose! Specify 3.5 or 5.25 disk and se 
check or monev order to the author: 

(800) 423-1228 
Bible Research Systems 1 2013 Wells Branch Pkwy #304 

Austin, Texas 78728 
R o b e r t  M .  Merrill 

6 1 8 0  V i a  R e a l  A-25 
fast, and easy to use. The templates help 

c a r p i n t e r i a , ~ ~ 9 3 0 1 3 - 2 8 6 . 5  ~ouprepareandprint23fonnsand (512) 25 1-7541 
Circh 87 on Ruder Servica Card. 

- schedule indudkg 1040, A, B, C, D, El F, 
R, SE, 2106, m9. mo, 2441, 3903,4562, 
6251,8283,8581 8582-01, 8606,8615, 
8814, and 8829. 

Order 1040Wodcs if you have a 128K 
Apple I1 system. Order 1040Works-X if 
you have 256K of RAM and AppleWorks 
2.0 or latec If you have a Macintosh, 

seconds, CROSS-WORKS copies files either way between your 
pie 11 and IBM PC, and translates the file formats. Word Processor 

older IMOWorks for ClarisWorks. 
s maintain underlining, margins, centering, etc. Spreadsheets 
refer data and formulas! Transfers ASCII text files too. Includes 

Includes step-by-step instructions. Satis- 
hMTMl19,200 baud cable to connectlle (with Super Serial Card), faction guaranteed or your money back. 
, W k  6 llgs to PC, XT, AT, PSI2 & compatibles. Also supports 
darn transfers. Both 5% and 3% inch disks included. Visa/MC accepted. $32.95 t $3.50 slh. 
Look no further. SoftSpoken's CROSS-WORKS carries the bigges 
isportation business.. . Rft iw: ****" - Incider JUW, 

National AppleWorks Users Group 
W-WORKSTM $99.95 + Shipping & Hand. 

BOX 87453 8 Canton, MI 48187 
>ay momy-back guarantee! School P.0.s welcome. 

(919) 870-5694 for free information. 
(313) 454-1115; Fax: (313) 454-1965 

Circl~ on Reader Service l Circle 55 on Reader Service Card. 
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Black Color . -~ 

ipple lmagewtiler I,  I1 $2.19 $2.95 
Imagewriter 11-4 Color $4.69 
Imagewriter 11- Heal transfer (Black and 4C) $4.50 $9.95 
Imagewriter LQ - (Black and 4C) $8.95 $13.95 
@piescribe $7.95 
Panasonic 1124 $3.50 
C'dizen GSX 140 (Black & 4C) $3.95 $11.95 
Epson MWFWRXlW $3.50 $4.M 
Star NX1 030 $3.25 $3.95 
Star NXlOW 4C $5.95 

Hundreds more. 
For Orders of less than 6, please add 75e each. 

Colors (BLUE, RED, GgEEN, PURPLE) 
CUSTOM COLORS AVAILABLE - PREMIUM IS ALL WE SELL1 - MONEY BACK GUARANTEE - 

Shippingklandling $4.75 per order (over $75 we pay SH). 
APOIFPO add N.75toALL orders AK, HI, P.R., Canada add 

15% W (minimum $6) NY residenls pleas4 add sales tax. 
Wml, hos~ital and .wki. NET30 PO'S welcome. 

A quality SOL. - -  of your external 
SCSI hard disks, tape backups, and 
combo units. Apple, Mac, I B M  
compatible. 

An exclusive manufacturer of all. ~ 
FIRST CLASS PERIPHERAL 1 
SIDERS. Also provide service, I 
repair, and upgrade on existing 1 
models. 

See our AD in the upcoming lssut 

n City, N V  89706 
les: 800-982-3232 

h Spt: 702-687-2800 
PLEASE M E N T I O N  THIS AD 

Megaboard Hard Drive 
Controller I 

The onlv ST506 hard drive interface card for the 
Apple ll.'lnstall ProDOS, DOS 3.3, CPM and UCSD 
Pascal, Standard ST506 interface works with low- 
cost PC hard drives up to 64 Megabytes. Freely 
adjustable partitions for each operating system. 
Each operating system is bootable and user can 
switch between operating systems in a keystroke. 
Fits in slots 1-7, Comes complete with card, soft- 
ware, manual and connector cable. Free technical 
support & 6 months warranty. 
Megaboard, software cable, manual ......... $195.00 
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Face facts: A Mac looks like a TV, but the show's as 

dull as a test pattern. There's gotta be a better way. 

dmit it - you expect your computer to entertain you. 
You unconsciously want it to work like a TV Apple's naked 
euphemism - "Apple Desktop Interface" - has gone 
,unchallenged long enough. Apple stresses again and again 

that "an interface is not merely a visual display." Methinks the 
company doth protest too much: The Macintosh interface, in 
so many words, is a visual display. Aspects of the Apple interface - 
"pictorial icons," "see and point," and "what you see is what you get" 

By PAUL STAT1 % SENIOR EDITOR 

- share a common theme: They assume 
you're sitting there staring at the tube. 

The heaviest part of your computer hard- 
ware looks a lot like a T V  screen - because 
it is a television tube. I once watched To 
Have and Have Not on a green mono- 
chrome Apple IIc monitor. It looked great. 
If that screen could talk, it would fondly 
remember Bacall and Bogart as the most- 
interesting pixels it ever played. 

Trouble is, watching TV is almost always 
a waste of time; working at a Mac almost 
never is. But now there's a utility that 
admits honestly it's a waste of time. Video- 
Beep, from SoundSource, is a unique 
"personal multimedia" program that plays 
QuickTime movies in response to system 
events: whenever you insert or eject a disk; 
at startup, restart, or shutdown; and so on. 

SoundSource, the people who brought 
the oficial, legal Star Trek sounds to your 
system beeps, have also canned some clips 
from the film Star Wars in QuickTime. 
Combine VideoBeep with Star Wacs Viiual- 
Clips, as they're known, and -you get the 
picture. (The combo product, Star Wars 
QuickTime Movies, is priced at $89.95.) 

Let me get my three complaints about 
VideoBeepNisualClips out of the way: 

It's Star Wars. I didn't like the movie well 
enough to see the sequel. I don't want that 
riaiculous little robot bothering me every 
time I start up my Mac. 

It's more than my Mac LC can handle. 
The minimum requirements are a 68020 

Mac with a hard disk, System 6.0.7 or later, 
QuickTime, a 256-color monitor, 4 mega- 
bytes of RAM, and 5 or 10 free megs on my 
hard drive. By that logic, I could argue 
that the minimum requirements for drain- 
ing the Pacific Ocean are a tea cup and 
saucer. A more-realistic requirement for 
VideoBeep is a Macintosh Quadra. Period. 

It doesn't work perfectly. I assigned a 
dancing-skeleton clip (which I stole from 
KidPix Companion) to the Empty Trash 
command, because I like the idea of danc- 
ing on a dead file's grave. The movie 
played, but the Trmh icon still bulged full. 

The folks at Soun&ource promise clips 
from The Wizard of Oz, Lawnmower Man, 
Total Recall, and Terminator 11. Their 
ofices (2985 h t  Hillcrest Drive, Suite A, 
WestlakeVdage, CA 91362,800-8774778, 
805-494-9%) aren't fir born Hollywood, 
and they say they're negotiating with all 
the studios. I'm still not happy, so I decked 
out my system messages with jokes from 
Warner New Media's QuickTime movie 
Funny. That's the beauty of it: QuickTime 
isn't one movie, it's a distribution system. 
It's great because you can use any movie 
clip you have with VideoBeep. 

Don't dismiss the idea that something 
so hivial might become something serious. 
Talking Moose's animated cartoon char- 
acters (see "Totally Rad Mac," June 1992, 
p. 34) never got the credit they deserved 
for inspiring Apple to include Balloun Help 
in System 7 .  But Balloon Help has gone 
over like a lead balloon. Perhaps that's 
because there's got to be a better way to 
show how to use a Mac than with words. 
But imagine adding VideoBeep: You could 
see the whole process of using menus and 
selecting applications. 

Macs will be presentiig TV faces to us for 
some time to come. Even the "Knowledge 
Navigator" sported a TV screen. Let's get 
the test pattern off the screen and face 
reality: People expect something sharp on 
TV. SoundSource is on to something. Right 
now it's just something to do with all the 
QuickTime movies you've been collecting. 
But someday you'll be able to connect 
video clips intelligently with whatever else 
you're doing on screen. Ci 
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Twice as fast as the other SCSI card 
under GWOS. Fm to eight times 
faster under PmDOSl Supports ALL 
media and has tape backu 
software WII into the ROM wit[ 
FULL utility program. 
m- 

c- 
Ttm NEW CV-Rmn comes with 4 
Mm &mdy h t a k d  and is user 
expambbk to 8 Mbs utillzin 
smtm 1x4 m. FUIIY D M ~  
wmpaWe, unlike other common 

cads, C.V. Technologies' 
=-Ram can expand beyond 4 
~ t o 8 ~ l ~ m e m o r y  is as 

in two chi sand S y j *  a14 M ~ S  and 
~ a s ~ t o 5 , 6 , 7 o r 8 M b s  
of totally D M  compatible, memory 
h lhose memory ~ntenslve 

EzY- lib the GWOS Finder. 
Rank&? W r  GSOS 6.0 

Point-tepoint 
GS Desk Accessories 
Beaglewrite 

Leamin to prcgram Bundle C $99 
~alking fmls  $25 
ORCAiDisassembler $20 

~W~ 
MouseWite $74 
Macmrnate $25 

BRODERBUND 
The New Print Shop 3.5' $27 
Where iniime Is Carmen 

Sacdiego?Apple I1 5.25' $24 
Print Shop Companion GS $27 
Where in the Wortd is Carmen 

Sandiego?Apple I1 5.25' $21 
Dazzle Draw $37 
Where in Euro is Carmen 

Sacdlego? g p l e  I1 $24 
McGw at the Fun Fair Macintosh $21 
VCR Companion Film Libraty $14 
Science Tmlk'd-Master Mcdule $42 
The Playrwm Macintosh $27 
Where in the Wort8 is Camen 

using or any frills such as 
k m b a d & a a m a x k c a n  eat up 
swend m@y@s m a hurry. Don t 

memory card. 
%-like a lot now, 
but tammw's appiiitions may I Mb Aux. slot lle 

to tun out of ram-then 
you do? If your memory sr 

cani ts not expandable, you'll be 
sludd If y w  have CV-Ram, you just 

awlher megab e and keep 
on annpulhgl X e  CV-Ram is 

b & d  by a 1 Year Parts & Labor 

Gumanbe. Ded ned to fit your - & ie most repuh,,le 

mark&42V. Technologies! 

II PRODUCI'IVE 3Wt TrueQpeTM Fonts 
Includes Hypercard IIGS w~th Reference Stack, Shrlnktt GS & 
FREE AOL Software & log time ONLY $48111 

CWRm8WU7S Uhdbnt hmdk b i n t b ~  & Font Packao~ ONLY $85 

You asked for it! SALVATION SUPREME $8995 

Now, we've got it! 
Apple Computer's ProTERM 3.0, by insync $75.95 

Hi-Speed SCSI "Best Apple I1 Software '90 & '91" 

$75.95 WestCode &T&Eis $41.95 
S 0 F T W A R E HARDPRESSED $41.95 



More than doubles the speed incider's 
of your Apple JIGS, Editors' Choice 
No switches or jumpers to 

5 * k & l e w i t h d s t a n ~ n ~ ~ u &  
Fully Compatible with all standard software and bacduwe. Rqbdable to 6 m  with 2 m  GS 
32K Cache Option increases Transwarp GS speed up to 20%. 

~ , h  1 - A A -  Datalink 2400 
Internal modem for 

Apple a+, IIe and IIGs. 

300,1200,2400 bps Hayes campatible modem. 
Fits in any slot except three, no serial card necemq, 
Comes with cammdcations sohare and @la. . 

Retail h j b  the &&link 2W bps moakn~ ............................ $219 

3210 Beltline 
CaUApplid hgineerjng Sales today andfake A t a g e  of these incredible pri&! Dallas, 75234 


